
 

 

 

 

Learn Excel 2016 Advanced 

 

 

 



 

 

Table of Contents 

Chapter 1 – Introduction to Excel 2016 Advanced Course 

 Prerequisites of the Course and Version of Excel ...................................................6 

 Course Structure.....................................................................................................10 

Chapter 2 – Functions 

 Functions – Part 1 ..................................................................................................12 

 Function – Part 2 ....................................................................................................18 

 AutoSum ................................................................................................................22 

Chapter 3 – Date and Time Functions 

 How Date and Time Work .....................................................................................24 

 Basic Date and Time Functions .............................................................................28 

 Complex Date and Time Functions .......................................................................32 

Chapter 4 – Text Functions 

 Using Text Functions – Part 1 ...............................................................................37 

 Using Text Functions – Part 2 ...............................................................................42 

Chapter 5 – Logical Functions 

 Using Logical Functions ........................................................................................47 

 Exercise 01 .............................................................................................................51 

Chapter 6 – Lookup Functions 



 

 

 HLOOKUP Function .............................................................................................52 

 VLOOKUP Function .............................................................................................57 

 Exercise 02 .............................................................................................................60 

Chapter 7 – Financial Functions 

 Financial Functions and Terminology ...................................................................63 

 Personal Financial Functions .................................................................................67 

 Professional Financial Functions ...........................................................................71 

 Depreciation ...........................................................................................................74 

 Exercise 03 .............................................................................................................76 

Chapter 8 – Statistical Functions 

 Statistical Functions for Description – Part 1 ........................................................77 

 Statistical Functions for Description – Part 2 ........................................................82 

 Statistical Functions for Forecasting – Part 1 ........................................................88 

 Statistical Functions for Forecasting – Part 2 ........................................................92 

 Exercise 04 .............................................................................................................97 

 One Click Forecasting............................................................................................98 

 Statistical Functions for Inference .......................................................................102 

Chapter 9 – Connecting to External Data 

 Connecting to Other Workbooks .........................................................................107 



 

 

 Connecting to Access Databases .........................................................................113 

 Connecting to Web Data Sources ........................................................................118 

 Get and Transform ...............................................................................................122 

 Exercise 05 ...........................................................................................................128 

Chapter 10 – Tables 

 Introduction to Tables ..........................................................................................131 

 Working with Tables............................................................................................136 

 Table References ..................................................................................................140 

 Table Styles ..........................................................................................................143 

 Exercise 06 ...........................................................................................................145 

Chapter 11 – Pivot Tables 

 Introduction to Pivot Tables.................................................................................146 

 Working with Pivot Tables ..................................................................................149 

 Filters and Slicers .................................................................................................153 

 Pivot Charts ..........................................................................................................157 

 Exercise 07 ...........................................................................................................160 

Chapter 12 – Data Analysis 

 What If Analysis ..................................................................................................161 

 Scenario Manager ................................................................................................165 



 

 

 Goal Seek .............................................................................................................168 

 Solver ...................................................................................................................170 

 Exercise 08 ...........................................................................................................173 

Chapter 13 – Graphs and Charts 

 Area Charts ..........................................................................................................174 

 Surface Charts ......................................................................................................176 

 Radar Charts.........................................................................................................178 

 Bubble Charts.......................................................................................................180 

 Sparklines .............................................................................................................182 

 Stock Charts .........................................................................................................185 

 Exercise 09 ...........................................................................................................188 

Chapter 14 – Excel Web App 

 Introduction to Excel Web App ...........................................................................190 

 Using the Excel Web App....................................................................................193 

Chapter 15 – Course Conclusion 

 Closing Message ..................................................................................................196 



Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

Chapter 1 – Introduction to Excel 2016 Advanced Course 

Video: Prerequisites of the Course and Version of Excel 

Toby: Hello. You are very welcome to our course on Microsoft Excel 2016 Advanced. My name 

is Toby and I’m your instructor on this course. I’ve been using Excel for quite a few years and 

I’ve used quite a few different versions of Excel. I’m actually now a Microsoft certified 

professional with a specialism in Microsoft Excel. I’ve been involved in the development of 

some pretty big systems using Excel. Excel is used widely in industry and business and finance 

but a lot of people use it at home as well. The chances are some elements of your domestic 

finances or perhaps the economics of running your house involve an Excel spreadsheet. And it is 

true to say that Microsoft Excel is the most widely used spreadsheet software in the world.  

Now in this first section I need to cover a little bit of housekeeping. And the first thing I need to 

be very clear about is that this is not a beginner course. This is an advanced course. If you are a 

beginner to Excel then I will refer you to our beginner’s course which I’ll take a look at in just a 

moment. 

If you’ve used a much, much earlier version of Excel, say before 2007, but you’re a pretty 

advanced user then you still should probably go through at least some of the elements of our 

basic course to get up to speed on things like the Ribbon and some of the more recent 

developments in Microsoft Excel. 

If you are an accomplished user at 2007 or certainly with Excel 2010 or Excel 2013 then you’ve 

probably got a good enough grounding to cover this advanced course. I’m not going to repeat a 

lot of basic material but I will often do a little quick summary of what I’m expecting you to 

know. And if I do do a quick summary at the beginning of a section and you think, “I didn’t 

know that” you can always go back to the basic course and maybe just learn that particular topic 

that you’re not really very familiar with so far. 

Another very important aspect of this is that throughout the life of Excel many of the basic 

aspects of it haven’t really changed very much. Now the Ribbon was introduced in 2007 but a lot 

of the basic aspects of what Excel as a spreadsheet software product does haven’t really changed 
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much since the very beginning. However, many things have been added and in areas such as 

Charts and Graphs if you’re only familiar with a much older version you’ll probably be quite 

astonished by the possibilities that you get in Excel 2016. There are so many things that you can 

do.  

So take a few minutes now to look at the Excel 2016 beginner’s course and make sure that you 

are familiar with all of those topics. If there are any gaps I suggest you just spend the required 

amount of time to work your way through those and then you should be fully ready for the 

advanced course. 

The next thing to talk to you about is the version of Excel that the course is based on. This course 

is almost totally using the installed version of Excel 2016, the desktop product, not the web app. 

Now later on in the course I’m going to spend a little bit of time looking at the web app but that 

will be a very specific section of the course. For most of the course, over 90% of the course, 

we’ll be using the desktop installed application. 

Now, unfortunately with Excel 2016 we get a complication and that is that with Excel 2016 the 

definition of what is actually in the product changes on pretty a month by month basis because 

Microsoft’s approach now is to release updates to the product. And depending on how you have 

your updates setup you may get in effect a new version of Excel 2016 every month. Now what 

this usually comprises is a small number of new features and probably a number of bug fixes as 

well. But it does mean that in preparing a course like this I’m pretty much trying to hit a moving 

target because by the time I finish recording this whole course even the version that I’m 

recording it on will probably have changed from what you’re going to see in the early part of the 

course. Now obviously I’m going to keep track of that and make sure that I don’t tell you 

anything that’s going to confuse you or me or both of us. But be aware that by the time you 

follow this course there may well be things in Excel 2016 that aren’t in it now. 

Now in the light of that I suggest you familiarize yourself with this page or its equivalent, What’s 

New in Excel 2016 for Windows, because it has a month by month list of how the product has 

been updated. Now you see we have a version here, September 2015, then there’s a gap, January, 

two months, March, April, May, June, July. I have no idea whether there’s going to be a release 
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every month but you do need to keep an eye on this. And if I open the July list then you’ll see a 

list of updates.  

Now that note, although I’m not going to fully explain it here, is an important one. First of all, if 

you get Excel via an Office 365 subscription then you will be able to get these monthly regular 

updates. But that’s not the same as saying you have to get them because you can choose the basis 

on which you get updates. So you can, for instance, be something called an Office Insider or you 

can actually delay the installation of updates. Now for the purposes of this course I don’t think 

we need to get too hung up on this but I would like you to be aware of the fact that Excel 2016 is 

changing all the time and therefore if you do come across a feature, maybe an advanced feature 

that’s not in the course, it may well be that it’s been introduced since I recorded the course. 

Having said that, if you take things like Charts and Graphs there are so many I can only cover a 

certain number of them anyway. 

The next point I need to make is that this course will be pretty much exclusively using keyboard 

and mouse. I probably won’t use touch mode at all. Now of course touch mode on Excel works 

pretty well now. And if you have a touch device then you may want to work through the course 

using touch. It’s entirely up to you. The instructions for enabling touch mode in Excel 2016 are 

basically the same as they are for Excel 2013. There is a page on Office.com explaining it for 

2013. At the time of recording this there isn’t one for 2016. But as the instructions are the same 

use the 2013 ones. 

The last point I need to make here is that although I’m actually based in the UK I am going to be 

using U.S. locale primarily throughout the course and this will include not only using U.S. 

dollars as the currency but also adopting things like U.S. date format and the U.S. spell checker. 

If you want to work along with me as closely as possible then you may want to adopt that 

approach as well. However, if you would prefer to use your own locale, your own currency, your 

own date/time, etcetera then you should be able to adapt all of the workbooks that I’m providing 

you with so that you can work with them using your own settings. Now as this is an advanced 

course I’m going to assume that you know where in the Excel options you need to set these 

things up. But for example, if I click on the Language options you’ll see here that I generally 
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work with two languages, English United States and English United Kingdom. And for the 

purposes of this course English United States is going to be my default language throughout. 

So that’s by way of an introduction to the course. I am of course assuming now that you have 

Excel 2016 installed and ready to use. But in the next section I just need to run through with you 

the course material that’s supplied with the course and just explain that in the light of the 

structure of the course. That’s what we’re going to do next. I’ll see you then. 
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Video: Course Structure 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section I’m going to talk about the structure of the course and give you some important 

information about how best to follow the course. 

Now first of all the course really ideally should be covered in sequence and I’ve prepared the 

course on that basis. However, this is an advanced course and if you do need to cover a topic 

later on in the course straightaway there really shouldn’t be any reason that you can’t do that. 

I’ve tried to make the parts of the course as standalone as possible and each of them should have 

limited reference to earlier parts of the course. And of course where there is a reference it should 

be pretty straightforward for you to go back to that earlier section if you need to.  

The course is arranged into chapters and each chapter comprises one or more sections. Each 

section consists of a single video and typically a single video is 15 minutes or less in length. 

Now one or two of them are very slightly longer than that but I try not to go too much beyond 15 

minutes. 

Now apart from the videos themselves there is a folder containing the course files and this has 

most of the files that I use during the course. So that if you want to work along with me or try a 

variation of what I’ve done, for example, then you have access to those files here. Some of the 

very small, simple workbooks are not included. But where a workbook has any significant 

amount of content I tried to make sure that it’s included in this course files folder. I suggest that 

you make sure you know where your copy of the course files folder is, probably take a backup 

copy because particularly if you’re working along with me you may break something at some 

stage and want to go back to the original. 

There’s also a folder containing the exercise files. Now in most cases this folder includes the 

starter point for each exercise as well as my sample answer or answers for the exercise as well. 

So again, it’s important to make sure you know where these are and also particularly if you’re 

going to work within that folder I suggest you keep a backup copy of the folder as well. 
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Now for a couple of important general points. In Excel, as I’m sure you know by now, there are 

often many ways of doing things. And in order to keep the length of the course not too long I’ll 

generally show you one or two ways of doing things but I do appreciate that there are often 

alternative ways and alternative ways that you may well prefer. So I do suggest that you 

experiment with all the different ways of doing things in Excel and find the things that most suit 

you.  

Now there are one or two things that I generally avoid on the course and one of them in 

particular you may be quite surprised by and that is that I generally do not use keyboard 

shortcuts. Now there will be a few instances where I do and when I do I will generally tell you 

that that’s what I’m doing. But the main reason that I don’t use keyboard shortcuts is because 

you won’t see me doing that on the screen. And generally speaking I like to click something on 

the screen so you can see me clicking it. I’ll often outline or highlight in some way what I’m 

doing so that you can see what I’m doing. But again I do appreciate that in many situations you 

would probably use a keyboard shortcut rather than click something on the screen. 

And one other very important point, the case studies that we’re going to use on this course and 

there are quite a few of them, are very often in quite specialized areas, such as in statistics and in 

finance. Now some of these areas may be areas that you’re not at all familiar with and you may 

be a little concerned that I’m going to talk about aspects of these that you really don’t understand 

or have had no former contact with. Where this might happen as far as possible I will try to 

explain all of the things that you need to know about a particular area of activity in order to 

understand what’s going on. So if, for example, you really don’t know much about finance or 

statistics then I’ll explain the key points that you need to know in each situation and hopefully 

that will make sense of the approach that we take to that particular case study. 

So that’s it. That’s the outline to the course structure and a few important points to bear in mind 

while we’re working through it. I think it’s time to get started. And we’re going to start with a 

look at some general aspects of the use of functions. That’s in the next section. I’ll see you then. 
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Chapter 2 – Functions 

Video: Functions – Part 1 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to start to look at Functions and we’re going to spend quite a bit of 

time looking at functions and they’re very much going to be the basis of many of the other things 

that we cover later in the course.  

Functions have been one of the main strengths of Excel very much since it started really. And in 

Excel 2016 the number of available Functions has passed the 400 mark and I can assure you that 

we’re not going through all of those on this course, but we are going to look at quite a few of 

them. And really the sheer number of Functions is one of the problems with using them in that 

even if you’ve got an idea of the function you need you may not know what it’s called and you 

may have trouble finding it.  

So in this first section I’m going to cover a few of the basics of Functions which I’m sure you’ll 

be familiar with but I’m going to try to extend those into areas that you may not have seen or 

used before. And I’m also going to talk a little bit about how to find the function that you need 

and how to identify not only what it does but how to use it. 

Now the first thing I’m going to point out is that there is a pretty good Help topic on Functions in 

Excel 2016 and this is a good reference point to find out about Functions. 

Here is that Help topic, Excel Functions by Category. Many of the categories agree with those 

that I use in this section of the course. Let’s go into a particular category. Let’s say go into 

Logical Functions. Within the list of Logical Functions some of the Functions have a little year 

number under them. That actually corresponds to a version of Excel and it shows you when that 

particular function was introduced, which implies that the function was not available in any 

versions of Excel prior to the one that is listed. So for example, the IFS function, the IFS 

function was introduced in Excel 2016. 
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If you drill down into a function you get a lot of useful information. There is usually a brief 

description of what the function does. There will then be some technical details that usually 

include information about the arguments, which ones are required and optional, information 

about data types and so on. And then generally one or more examples of the use of the function. 

Depending on the complexity and importance of the function you may have more examples, 

more explanations and so on. You also get questions such as common problems that you might 

get with this function and typical sort of errors that you get, and explanations of how those errors 

might have occurred.  

So you have a reasonable amount of information about all of the functions which can be very 

useful. But let me go back again to that first page because there are a couple of very important 

things to note here. I just pointed out about the version markers. But below there there is a note 

about differences in calculated results between what you will see on a Windows PC, 32 bit or 64 

bit, and what you might see on a Windows RT device, using A-R-M, ARM architecture. If 

you’re only using a Windows PC that’s fine. But if you are sometimes or all of the time using an 

ARM-type device it’s important to be aware of some of the differences that occur when using 

functions. There’s a link here to a section that tells you about those differences. 

Something that isn’t mentioned here but which is also important is that some of the Functions in 

Excel in recent versions have been improved or enhanced and in some cases give what is usually 

more accurate results than they used to. Most of the time you probably won’t even notice this but 

if you have legacy systems based on Excel, maybe old macros that use Excel Functions, it’s 

possible that the results may change from version to version when a more accurate version of a 

function is introduced. This will normally only affect accuracy of numbers to a very, very high 

level of precision. But in some applications of course that can be important.  

Now there are some other useful links towards the bottom of this page. An overview of formulas, 

how to avoid broken formulas, how to use error checking and so on, one or two of which we’ll 

come back to later in the course. But there is also a link here to the alphabetical list of Excel 

Functions. 
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And there they are. If you want some really interesting bedtime reading there’s a nice long list of 

all of the Excel Functions in the version so far. 

And a couple of other things that are well worth bearing in mind are that you can actually get 

Functions from third parties. So you can buy or in some cases get free third party Excel 

Functions. And of course you can write your own Functions. Both of these are outside the scope 

of this course but well worth bearing in mind if you need a particular function and Excel 2016 

doesn’t have that function. 

What I’m going to do now is a very quick demonstration of the use of a simple function and I’m 

going to point out some of the key features that I’m going to assume you are already familiar 

with and possibly a couple of things that you’re not so familiar with. 

So let’s start with a very straightforward job. Let’s add up these four numbers. If I want to total 

some numbers as I do here I can enter a formula anywhere on the sheet. On this occasion I’m 

going to write it directly underneath the list of four numbers. I start a formula with an equal sign 

and I’m going to use the SUM function. So I hit the letter S and straightaway IntelliSense takes 

me to all of the Functions that begin with the letter S. Now a U. There are about ten Functions 

that begin S-U. And of course the one that I want on this occasion is SUM. Now in order to 

select that if I double click not only do I get the rest of the name of the function but I get the first 

parenthesis and then within the parentheses I’m going to need to enter arguments. In the list of 

arguments, as you can see here, bold arguments are mandatory, so I must have at least one 

number in here. And then the non-bold arguments indicated also here by square brackets are 

optional arguments. And as you can see in the standard definition of the SUM function the 

arguments are separated by commas. Whatever the function, even if it has no arguments, you 

will need to use parentheses.  

In those arguments I don’t have to put cell references. I could put actual constants. So for 

instance, I could put SUM(6,). Notice now that having entered the comma what Excel 2016 is 

telling me is that the next argument become mandatory. Eight, comma, and so it continues. Let’s 

put a ten in there and then close the parentheses. When I’ve finished entering the argument I can 

either hit the Enter key or I can of course use the standard enter tick mark on the Formula Bar 
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there. On this occasion I’m going to hit the Enter key and there I have my total of 24. Excel here 

is set up so that when I hit the Enter key the cursor moves down to the cell below the one that 

I’ve just entered, in this case a formula into. Let me go back to here. And now you can see the 

formula with the use of the SUM function. 

If instead of using constants for the arguments I want to use cell references and let’s suppose that 

I’m now going to add the values in D2, D3, D4, and D5. I can list those cell references instead of 

the constants. So click within the formula and within the arguments for function, enter that and I 

can see my total here is 75. So listing the cell references is one possibility. The other possibility 

of course is to specify a range. So instead of listing all of those cells separated by commas I can 

indicate a range using a colon between the start cell in the range and the end cell in the range. So 

that cell says SUM(D2:D5).  

I’m not restricted to accessing and using values on this worksheet. I have a second worksheet in 

this little temporary workbook. So if instead of that I want to add up cells from a range on 

another worksheet I’ve still got my SUM function there although now the arguments are empty. 

If I go to Sheet 2 and select that range you can now see that the range has appeared in the 

arguments of my SUM function. If I enter that you will see now that what I have as the argument 

in my SUM function is SUM(Sheet2!), well I normally say a bang. It’s (Sheet2!E3:I3). So that is 

using a range on a different sheet.  

And of course there’s nothing to stop me adding the values in the cell range D2 to D5 on this 

sheet to the values in the cell range E3 to I3 on Sheet 2, giving me a grand total so far of 143. 

Now partly because of the flexibility within the use of formulae in Excel there are certain rules 

you need to stick to such as the fact that you don’t have spaces between function names and 

parentheses. So I’ve got a formula here with a SUM function that’s working perfectly well. But 

if I click in there and put a space between the function name and the brackets, tick that, I get an 

error. It’s the sort of error that Excel is quite familiar with. So it says “We found a typo in your 

formula and tried to correct it.” It shows the correction that Excel has tried to make. It is the 

correct correction in that it has removed the space there so click on Yes and that’s fixed again.  
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And as I mentioned just now even if a function has no arguments you still need to put the 

parentheses. So let’s suppose I want to put the value of PI in the cell F6. I’m going to do it using 

a formula =PI. Note the screen tip there for PI. Returns the value of Pi. The value is shown there 

in the screen tip accurate to fifteen digits. If I tick that I actually get that familiar error message. 

Note the little marker in the corner there to indicate an error. The formula contains unrecognized 

text. And that gives you a link through. Invalid name error. So it knows there’s a problem with a 

name here. Help on this error, show the calculation steps if it’s managed to do any so far, ignore 

the error, edit in the formula bar, and error checking options. Let’s say Edit in formula bar. I 

know that what I need there are the empty parentheses. Now click on tick and I have that value 

which is Pi to the accuracy specified by the formatting of that cell.  

The other point to bear in mind of course is that you can nest functions. So if I wanted to add to 

that sum the value of Pi as well I could put a third argument in there, SUM, and within that I 

could put PI with of course its parentheses. Click on tick and y total in D6 is now that. And again 

you can see that it is shown to the accuracy specified by the format for that cell. 

One other feature which you probably have noticed before and may even use already is the use 

of color coding to make it easier to identify arguments on a worksheet. In this particular case that 

won’t be particularly helpful but later on in some of the case studies this color coding can really, 

really make life a lot easier. If I just start to type in here those cell references again one at a time 

separated by commas. So the first one is D2. As I type D2 you see that the cell D2 gets both a 

colored border and a shaded background. And the coloring corresponds to the coloring of D2 in 

the list of arguments. So if I now put D3 as the next argument you can see the red color both for 

the argument D3 in the list of arguments in the formula bar there and the red shading and outline 

for D3 on the worksheet. And then of course that continues with further cells that I specify in the 

list of arguments. So that can also be a very useful feature and it’s one that we can take 

advantage of later on in the course. 

And now just two or three points to finish off this section. One of them is that if you have any 

doubts or uncertainties about the use of formulas in Excel I refer you to this Help page. And if 

you have used Functions before you may well have used some of these older Functions that are 

now referred to as Compatibility Functions. These have been replaced by more modern versions 
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but are still available in Excel to support various legacy systems, old macros and so on. If you 

need the functionality provided by these make sure that you use the modern version of each of 

these and not the originals that are listed here. 

And the third and final point I’d like to make is that I pointed out to you earlier on in the course 

that it seems that in these regular updates to Excel 2016 they are going to be an opportunity for 

new Functions or replacement Functions to be introduced. So keep an eye out for those. 

In the next section we’re going to continue looking at Functions in general and we’re going to 

look at some of the more sophisticated facilities, such as the use of the Function Arguments 

Dialog. Please join me for that. 
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Video: Functions – Part 2 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to continue looking at Functions in general and I want to look first at 

tools to help you find the function or functions that you need.  

Now let’s take a particular example, let’s suppose that I’m working on this new worksheet here 

and I know that I need a standard deviation function. That’s a statistical function. Well if you 

look at the Formulas tab you will see the Function Library group there and some of the most 

commonly used categories of function. So you have Financial, Logical, Text, etcetera. Note also 

a category there of Recently Used. And if you do tend to use a fairly restricted set of functions 

that’s a really good feature because it makes it more likely that the function you want you’ve 

used recently and you can merely locate it here.  

If you look at the other end of the group there is a More Functions button and this gives you 

access to the other categories, one of which is Statistical. And the fly out list there lists all of the 

available statistical functions. Now note that with each one if I just hover over it I’ll get a screen 

tip with a description for that function. And underneath the screen tip there is a link to Help. 

Now unfortunately this link to Help is not quite as good as it used to be because it basically only 

takes you to a general Excel Functions Help area. And what you would need to do for the 

particular function that you were looking at just now is to type in the name of the function and 

then you would indeed get the help on that function. But it isn’t contextual as I believe it used to 

be. 

So what you might do knowing that you need a statistical function is to scroll down there and try 

and find the standard deviation or function that you need. But if you didn’t find it and that will 

often be because you don’t know its name and you don’t particularly want to look at the screen 

tip for every one of those functions there is another option and that is to click on Insert Function 

and that brings up the Insert Function dialog.  
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Now, note that the Insert Function dialog here has this particular field which is the category field 

preselected at Statistical because I was looking at the statistical functions when I invoked this. 

Let me just Cancel it again.  

There are a couple of other ways of invoking this dialog. One of them is that it’s the left most 

command on the Formulas tab. And another way you can invoke it is with this little FX button 

here on the Formula bar. 

So once I’ve invoked the Insert Function dialog I have access to the same list of functions, the 

statistical functions, that we were looking at just now. Now there are a couple of important 

differences with using this dialog. Note that as I click on each of these functions I will see the 

equivalent of the screen tip information there. If I click on Help on this function it does however 

take me to the actual help on that specific function, which I think is a big advantage of using that 

dialog. 

And the other big advantage is that if you don’t know the name of the function that you want you 

can use the Search facility. So I click in that first field. I know I need standard deviation. Let’s 

just try typing in Standard Deviation. In fact Standard will probably do it but let’s try Standard 

Deviation. Click on Go. And here we have a list of functions that in some way involve standard 

deviation.  

Now the very first one is STDEV. That’s the old standard deviation function. And as you can see 

there from the text underneath the list, this function is available for compatibility with Excel 

2007 and earlier. And then we have the current standard deviation functions. This is one for 

calculating the standard deviation of a sample. This is one for calculating the standard deviation 

of a population. And then we have various other functions related to standard deviation, some of 

which are compatibility functions and some of which are not. But as you can see, the big 

advantage here is that search facility. 

So what I’m going to do here is to calculate the standard deviation of the numbers in cells A1 to 

A7 and I’m going to put the answer there. So I’m going to use the Insert Function dialog and I do 

know the function that I want to use on this occasion. Now note that when I click on OK what I 

see is this Function Arguments dialog. And this is a particularly useful dialog. Not only because 
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it will remind you about the arguments that you need for a particular function and give you more 

information about what the function does but it can also help you to enter the arguments for the 

function. It’s a non-modal dialog and therefore you can not only type arguments in or type in cell 

references but you can actually make selections on a worksheet to form the arguments for the 

function. Now in this case the cursor is flashing within the Function Arguments dialog in the 

number one field. And I could type in there the first number that is part of the sample that I’m 

going to calculate the standard deviation of. I could put the next number in number two and so 

on. Now in fact I can also put things like lists of numbers, ranges and so on into those arguments. 

Note the little prompt on the right there that tells me that it’s a number that’s expected. But if as 

in this case the numbers that I want the standard deviation of are adjacent, quite conveniently. 

Then I can also select the range of numbers just by clicking from A1, dragging down to A7. And 

you can see that my first argument is A1:A7. It’s a range. If I wanted to add a second range I 

could either put that in as number two or I could just put a comma after A1:A7 in number one 

and put an additional range in there as well. So it’s very flexible and very helpful in terms of 

quickly populating the arguments for the function. 

Now the Function Arguments dialog gives me a preview of the formula result and I’ll just click 

on OK. And there is my standard deviation. 

And there’s one other feature that can be very useful and that’s a feature called Formula 

AutoComplete. Now in order for this to work you need to make sure that one of your options is 

set correctly. The option you need is on the Formulas page. It’s in the Working with Formulas 

section, second option down, Formula AutoComplete. And as the little information panel there 

says, Show a list of relevant functions and define names when building cell formulas. This 

functionality can be enabled or disabled by using the keyboard shortcut Alt plus down arrow 

when in Formula Editing mode. Now the reason for giving you that straightforward shortcut is 

that this function can be both helpful and a little bit annoying as well.  

So let’s suppose that I’m going to put a formula into D4 that involves one of the amortization 

functions and I know that it’s AM-something then I can type equal to start the formula and then 

as soon as I type A I get a list of the functions that begin with an A. By the way, when you get 

these little screen tips for this one you can actually move these little screen tips out of the way if 
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they’re obscuring part of what you need to see on the worksheet. And in fact it’s the dropdown, 

for example, and the screen tip, etcetera that some people find rather annoying with the Formula 

AutoComplete function. But let’s say I know it’s AM, oh yes it’s one of those two. And let’s 

suppose I decide it’s probably the first one. So I’m going to double click on that. And when I’ve 

done that not only do I get a list of the arguments for that function but the function name itself 

here has a link to the Help on that function. So I can not only check that it is the one that I want 

but there will normally be a full explanation of the arguments and often an example. I could 

actually copy and paste some data here and actually try this out. 

So it’s a very useful way of confirming that you’ve got the right function. And then depending 

on the arguments as you start to type in the values or select the values, so say there the first value 

I want is cost. Let’s assume it was $2,500, comma. Not only does the next argument in the list 

get highlighted but if it’s possible what the Formula AutoComplete will do will offer me options 

or recognize what I’m typing in that particular argument. Now in the case of date it won’t be able 

to guess what date I meant. But if I was say going to put a name in here it will be able to react to 

what I was typing to help me to identify the name that I wanted to include. But other than that I 

carry on entering my arguments. Note as usual that optional arguments are in square brackets. So 

the last argument there is optional. 

And that’s it. That’s formula AutoComplete. 

Now in this couple of sections I’ve either introduced you to or recapped for you some of the key 

general features for using Functions in Excel 2016. In the next section I’m going to look at the 

AutoSum functions because they also have some important and rather unusual features as well 

that it’s well worth knowing about. And then in subsequent sections of the course as we use 

some of these functions you’ll some of the features I’ve been talking about in action. But that’s it 

for this section. I’ll see you in the next one. 
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Video: AutoSum 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

We’ve been looking at Functions for the last couple of sections and in this section I’d like to look 

at the AutoSum Functions which you’ve probably used before but you may not be aware of some 

aspects of their use that can make them a very quick and efficient way of dealing with 

straightforward requirements. 

Let me show you the sort of thing that I mean. Let’s suppose that I wanted to add the numbers 

there in column B. Now you might be tempted to select the numbers in column B and then insert 

the AutoSum function as part of the formula in B6. But in fact you don’t need to select the 

numbers first. If you just click below the column of numbers and then go up to the Ribbon, either 

the Home tab or the Formulas tab, both of them have an AutoSum button on them. I’m on the 

Home tab, click on AutoSum and a formula is placed in B6. And what Excel 2016 has done is to 

work out what it believes is the range of numbers that I’m trying to sum. If I’m happy with that 

all I need to do is to click on Enter and there is my total. 

Now of course if instead of doing that I selected those four cells first, note that I haven’t selected 

B6 in this case and clicked on AutoSum. That still gives me the same result. Let me Undo that. 

Note that if I select B2 right down to B6, click on AutoSum it achieves the same effect as well. 

And once again let me Undo that. And another point to bear in mind is if I select say B2 to B5 

the Quick Analysis tool also has a Totals tab. And if I wanted to put the sum in using that rather 

than the AutoSum button I get the same result and of course the formula is exactly the same as 

well. 

Now let me Undo that and this time what I’m going to do is to select the sales from B6 to C6 and 

click on AutoSum. And in this case of course it can sum both of those columns. It puts the 

formula in B6 for column B and the equivalent formula in C6 for column C. 

Now of course this doesn’t only work for columns. If I wanted to deal with rows, let me click in 

G2. Click on AutoSum and I get the sum from B2 to F2. So it works on rows as well. 
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Let me just cancel that and delete the contents of cell F5. What would happen if I clicked the 

AutoSum button while cell F5 is selected? And the answer is it gives the sum from F2 to F4. 

Where AutoSum has an option of dealing with a column or a row it always gives precedence to 

columns. So that’s an important point to remember as well. 

So you might be interested to see what happens if I select B2 to F5 and click on AutoSum. Note 

it’s the column totals that I get. And what if I select B2 to G6? I get all of the totals. And the 150 

at the bottom right here of course is the sum from B6 to F6. 

Now another important point here is that Excel 2016 is pretty good at identifying entities that 

aren’t part of what you’re trying to do. So for instance, if in B1 I had a header, say these were 

supposed to be some sort of month figures, let’s put a set of headers in. If I wanted to sum B2 to 

B5 without making a selection that’s no problem. Excel realizes that B1 is not part of this. And 

in fact even if I select B1, so I’m selecting B1 to B5, it can cope with that as well perfectly well. 

And the other point I’d like to make here is that so far I’ve been dealing with sum functions but 

of course the same is true if instead of doing the sum of those numbers I want, for instance, a 

Count of those numbers. So as you can see there the count is four. Or in the next column let me 

select C1 to C5 and let me go for the Max. And of course the max number there is eight. 

And another point to remember here is that if in a specific situation or in fact if in general you 

find yourself say using the Max function a lot then you always have the option of adding that to 

the Quick Access Toolbar and there’s a very easy of doing that. If I click on the AutoSum button 

up there on the Home tab and right click on Max and say Add to Quick Access Toolbar it 

appears on the Quick Access Toolbar with that fairly neutral sort of icon there. Note when I 

hover over it it gives me a screen tip of Max. And anywhere that I want to use the function it 

then just becomes very, very easy to use it. 

So that’s it. That’s some general points about the AutoSum family of functions. Now in the 

balance of the course, as I’ve said already, we’ll be doing a lot of work with Functions and we’ll 

be using quite a few of these general points as well.  

That’s the end of this section. I’ll see you in the next one. 
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Chapter 3 – Date and Time Functions 

Video: How Date and Time Works 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to start to look in some detail at dates and times and at Date and Time 

Functions in Excel 2016. 

Now of course the use of dates and times is absolutely fundamental in Excel and yet for many 

people there are aspects of the use of dates and times that are completely baffling and cause them 

all sorts of problems. So what I’m going to do starting in this section is to explain in some detail 

how dates and times work and then to look at some of the main functions that you’re going to 

need to be able to be pretty familiar with in order to handle any kind of Excel application that 

requires the use of dates and times. 

Now before we begin let’s start with one of the things that I think is at the root of many people’s 

problems with dates and times and that is that ideally you will have the Date and Time settings 

on your device set correctly before you even start to use dates and times in Excel. Now I don’t 

mean by that that you’ve got the right date and time set but I meant that you’ve got the format 

set. And although there are some relatively minor differences in how these default settings are 

handled in the versions of Windows on which Excel 2016 will run, fundamentally the approach 

is the same. You need to start by going to Control Panel and you need to look at Region. Click 

on Region and you get this little dialog. As I pointed out to you earlier in the course my default 

language is set to English United States. And in this dropdown here my selection Match 

Windows Display Language means that my regional settings generally will match English 

United States. Or the dropdown here where I could choose a different language to determine 

these settings.  

So for example, if I went for English United Kingdom my short date format would be day, 

month, year. Whereas if I say match Windows Display Language it is of course month, day, 

year. Now you’re probably familiar with what the little D’s and big M’s and so on mean but I’ll 

come back to those in just a moment. 
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But the important thing to realize is that these are my default settings. And whilst I’m working 

on Excel if I don’t change anything else, if I just insert dates and so on these determine how they 

will appear, same is true of time as well. Now it may be that in a particular workbook I need 

some different settings. It may be that even in individual cells I need different settings and that’s 

fine. I’m sure you know how to change the date or time format in a cell. But if you find that you 

always have to change the short date format and you think, “Why can’t it be the way I want it to 

be?” You almost certainly need to change it in your default settings here. Changing the short date 

format, for example, is really easy. You can change to one of the standard ones just by clicking 

there and choosing one of those standard short date formats. Similarly, there are alternatives for 

long date formats, etcetera. 

So there are the defaults and very importantly down here we have additional settings. And this 

gives us settings for time and date. Now starting with the date ones, there’s an example, short 

date and long date. There are my date formats. Not only can I choose from that list of standard 

defaults but I can actually click in here and edit this if I want to to any combination of the 

appropriate symbols. And immediately below that there is an explanation of what the notation 

means. So D or DD is the day number, DDD or DDDD is the day of the week. Note you have the 

short form and the long form. M is the month, Y is the year. Single M will give you a numeric 

month, long string of M’s will give you the words for the month. 

And also importantly under there there is a standard cutoff year which determines which century 

is assumed if you enter a two digit year. So if I set a year number of 67 it will be assumed that 

it’s 1967. Now again you can change that cutoff year if you want to. And also there you can 

change the first day of the week. Mine is currently set to Sunday. 

Note the Reset button at the bottom. Now you have a similar set of options for time and an 

explanation of what those abbreviations symbols, what the notation means. The first thing you 

need to do when you’re dealing with dates and times is to make sure that you know how these 

are set and to make sure that you’re happy with how they’re set. 

And the second thing is if when you’re working on Excel you’re constantly annoyed by the fact 

that you never seem to get the right defaults. This is the starting point for setting these defaults. 
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Now following on from that explanation you might like to take a look at this page on 

Office.com, Format a date the way you want. And this covers Excel 2016, 2013 and 2010. And 

apart from referring you back to Control Panel at regular points it basically explains how to set 

date formats, how to set custom date formats and so on. I’m not really covering these formats on 

this course because I’m assuming that you’re already familiar with these. But if you do have any 

uncertainty about the formatting and the symbols and so on then this is a very good page to look 

at. 

So let’s start doing some things with dates and times. Let me just choose a cell here and put a 

date in. So that is June the 11th 1978. Note that although I only entered the two digit year it 

becomes 19 because of that cutoff date that I mentioned a little bit earlier on.  

Let’s go back into that cell now and what I’m going to do is to change the cell format. And I’m 

going to change it to Number format with no decimal places. And it becomes 28,652. Now this is 

the next thing that tends to confuse people. A date in Excel 2016 on a PC is the number of days 

since the 1st of January 1900. Now there have been a couple of minor errors in the way this has 

been setup right from the very beginning and I’m not really going to go into those now and there 

are also some well-known inconsistencies such as the fact that dates on a Mac are stored with a 

starting point in 1904 instead of 1900, although Macs can deal with Excel spreadsheets fine and 

vice versa. 

But let’s just take it at the moment as a clean case that this is the number of days since the 1st of 

January 1900 to the date I just entered. Now when you look at a date on an Excel worksheet what 

you’re looking at is a representation on a whole number. And in fact times are stored as fractions 

of a day. So midday on that date would be 28,652.5. 6 a.m. would be 28,652.25. 

One of the things that Excel is pretty good at is recognizing dates and times. If I start with this 

particular cell here, H6, let me just check the format of that cell. It’s currently at the default 

General setting, no specific number format. Let me just make this column a little bit wider. Let’s 

suppose that I put in here now 10 August. So just type that in as text. You’ll see that Excel has 

looked at that and decided it’s probably a date. So it will have changed the format of the cells. 

It’s changed it to Custom Format and chosen that short date format, D-MMM. But if I change the 
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format of that cell to Number I’ll see that it’s correctly stored it as a date. That’s the number of 

days in question since the 1st of January 1900.  

What about time? Supposing I put in a time like 10:30 a.m. Let’s see what it does with that. Now 

you see it’s treated that as 10:30 a.m. And if I look at the cell format for that, again Custom, but 

it’s chosen his time format, H:MM, with an a.m./p.m. marker. 

What about putting those two things together? Again it’s realized it’s a date and time. If I change 

it to Number format, let’s give it quite a few decimal places. It’s actually 42,592.458333 as a 

fraction of a day. However, if I tried to put that in a sentence then Excel will not recognize a date 

or time or combination as part of a sentence. 

So it’s important to understand how dates and times are stored. And it’s important to understand 

that Excel will do quite a lot of work in recognizing dates and times but that the formatting apart 

from the default formatting that Excel will use is largely down to you and it’s important to 

understand how to use those formatting codes, etcetera, in order to display dates and times in the 

way that you want to. 

So it’s important to understand how dates and times are stored and to understand both default 

formatting and how to change that default formatting for specific cases. But it’s also important to 

understand the various functions that you can use with dates and times. For instance, a function 

you might use to tell you a date 60 days from today or perhaps you might find what time it was 

two-and-a-half hours ago. And some of those date and time functions are what I’m going to look 

at in the next section. So please join me for that. 

  

http://www.simonsezit.com/


Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

Video: Basic Date and Time Functions 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to look at some of the most important aspects of using Date and Time 

Functions in Excel 2016. We’re not going to look in detail at formatting. I’m going to assume 

you’re pretty familiar with date and time formatting, although there will be various examples 

coming up throughout the course. But I want to talk about actual date and time processing first. 

We’ve looked at storage in the preceding section. And as a first step in this I want to look at one 

of the examples we’re going to be developing as we go through the course and that is the 

creation of a company invoice in Excel. 

Now let’s suppose that I put an invoice date on my invoice and in fact there are two dates 

associated with the invoice. There’s the invoice date and the due date.  

Now first of all one way that we could populate the invoice date field will be to use the Today 

function. And the Today function gives the date today. Note, Function Arguments, it doesn’t 

need any argument. So that’s all I need, click on OK there and I have today’s dates. Obviously I 

could change that format if I wanted to. 

Now the due date would be potentially a date a certain number of days beyond that date. And 

one way of doing this would be say well the due date is say always 30 days after the invoice 

date. How do you find a date 30 days after the invoice date? Well remember the invoice date will 

be stored as a number of days. So in fact all I really need to do is put in here =C2+30 and that 

will give me a date 30 days beyond the invoice date, which in this case will be September the 

10th.  

As we work through the balance of the course we’re going to continue to develop this invoice. 

But there’s still quite a few points to make here about dates and times and the first of them is that 

if I click in C2 the definition of the date there is that it is today. And of course if I close this 

workbook and open it tomorrow the date in there would be tomorrow’s date because it’s always 

going to show the current date. Now if in fact what you wanted was to put there a static date 

which may well be the case with something like an invoice then the way that you put in a static 
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date is not to use a function but to either type the date in as a fixed date or you can use the 

keyboard shortcut Control-Semicolon and that puts in as a static value the current date.  

Now in the case of something like an invoice it’s quite possible that on some occasions you 

might want to have a fixed date. You might also have a fixed date say if in an Excel workbook 

you were recording the dates of some holidays, something like that.  

Now apart from the Today function which gives you the current date there is also the Now 

function. And the Now function gives you the date and time now. Note the usual string of hashes 

because this cell is not wide enough. That’s better. So that’s the current date and time. But there 

is also a keyboard shortcut that you can use for the current time and that is Control-Shift-

Semicolon which gives you the current time. Again, E2 is dynamic, F2 is static. 

So having looked at Today and Now let’s look at another important function. Let’s suppose that 

you’re importing a load of data from another system and what you have is several dates such as 

this one in C6 but they are text dates. You’ve got them in an Excel workbook but they’re text. 

How do you make them into dates? i.e., so that you can store them as regular dates in Excel 

2016? The Function that you use for that is the Date Value Function. So I’m going up to Date 

and Time. I’m going for Date Value and I’m going to select C6, click on OK and of course I 

have 41,860.  

Note that although I’m using U.S. locale I’ve typed in a date which is in a non-U.S. locale, 

intended to be a UK locale. That doesn’t generally cause Excel 2016 a problem. It can figure that 

out for itself. And if I now applied Date Formatting to D6 what I get of course is August the 9th 

2014.  

The next set of Date and Time Functions that I’d like to look at is a set of six functions that can 

separate out for me the year number, the month number, the day number, down to the second 

number of any given date and time. I’m going to use the Date and Time in E2 and just bear in 

mind for a moment that a minute or two has passed since E2 was last updated. So it’s actually 

slightly out of date at the moment. But if in F4 I use the Year function and then when the 

Function Arguments dialog comes up I choose E2 a couple of things happen. First of all there 

would effectively be a refresh on E2. But also at whatever point that happens the year number 
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will be shown in F4. Now of course in the time it takes me to do this the year number won’t be 

changed. It’ll still be 2016. So let’s click on OK and there it is, 2016. Let me do the same with 

the month number. I’ll do the next couple. Now when it comes to minute a small amount of time 

has passed since E2 was last refreshed. It’s currently 18:15 according to that. E2 is now the 

argument for the minute function. Click on OK. E2 gets updated to show 18:16. And of course 

the number that appears in F8 is 16 as well. And then the final one of these six functions is the 

second function. 

So those six functions can be used to isolate year number, month number, day number, hour 

number, minute number, second number.  

And one very useful thing to be aware of here is that if you look at the value in E2 currently 

showing today’s date and the time of 18:25 which is provided by the Now function but in fact 

that time has passed. Any change to the cell values anywhere on the sheet will cause that value to 

be updated. So the Now function, and in fact the Today function which is also used on this sheet, 

their values will always be updated when I make any change to data in the sheet. 

Now look at the values in F8 and F9, so that’s minutes and seconds for the date and time in E2. 

Even if I just say type a one in E6, just hit the down arrow. You see that the minutes and seconds 

are updated. Of course everything is updated but only those two values changed in the time it 

took me to do that.  

Now I’ve already shown you how to get a date from a text date. There is another way that you 

can build dates as well. And in fact you can use a similar approach for times. And that is to use 

the Date function. Now what the Date function does is to build a date from three constituent 

parts. Now I’m going to put a use of date in here in D8. And what I’m going to do first of all is to 

invoke the Date function. So from Date and Time, Date. I’m going to put in a year number. I’m 

going to choose 2017. I’m going to choose a month number. I’m going to make that 11 and a 

date of say the 16th. So that should be November the 16th 2017. Click on OK and it is.  

Now I don’t have to use constant values for those three arguments. I could in fact use values 

from other cells on the worksheet. So for instance, instead of 2017 I could say the year from D2. 

http://www.simonsezit.com/


Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

I could say from D2 and in fact the day from D2 and you should not be surprised to see the date I 

finish up with is the same as the date in D2. 

And in fact this is an alternative approach. For example, to adding 30 days to the date in D2. So 

all I would need to do there within the Date function third argument is to put +30. And that gives 

me the same result as I would expect, September the 10th.  

Now one of the advantages that this approach has is that I can apply the same principle not just 

to days but I could, for example, add three months. So what would a date three months beyond 

the date in D2 be? D2 has got August the 11th. Yes, it would be November the 11th. 

Now let me change the date in D2. It’s currently August the 11th. Let me make it August the 31st. 

Watch what happens. In adding three months to that date Excel is not fooled because it adds 

three months to August the 31st. It gets November the 31st. Of course there’s no such date so it 

makes it December the 1st. 

That’s a pretty good function to use sometimes as well. 

So we’ve looked at several very important Date and Time functions in this section. There are two 

or three others that I need to go through with you and we’re going to cover those in the next 

section. But I’ve saved this particular workbook in the course files folder as Date Functions 01 in 

case you want to go in and play around with it a little bit yourself. I know there’s not an awful lot 

in it but some people find it useful even to get quite basic workbooks like this so that you can 

actually manipulate the values yourself.  

I’ll see you in the next section. 
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Video: Complex Date and Time Functions 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In the preceding section we looked at some of the basic functions associated with working with 

dates and times. And in this section we’re going to look at two or three of the more advanced, 

more complex functions that I’m sure you’re also likely to find useful.  

Before we do that though I did mention that when it comes to building dates from individual 

components there is an equivalent set of facilities for times. So just as a way of demonstrating 

this let me just run through a quick example or two here. 

Now the first thing to note is that in cell B2 I have the current date and time. And if all I wanted 

to do was to add twelve hours to that all I would need to do is to write =B2+ and then twelve 

hours of course will be 0.5 days. So 0.5 and I have a time twelve hours after now. Note that 

whenever I update something on the sheet the value of Now is updated as well.  

But supposing that I wanted to add a much more unusual amount, say 3 hours and 23 minutes. 

Well ideally what you want to do is to add 3 hours and 23 minutes to the date and time in B2. 

And the easiest way to do that is to say =B2+. Well there is a function Time which is the 

equivalent of Date and I can actually build a time from the number of hours which is three, the 

number of minutes which is 23, and the number of seconds which is zero. So I’m adding 3 hours 

and 23 minutes to the date and time in B2. And of course what I get is the same date but a time 

of 15:06.  

So as you can see for times we have pretty much the equivalent functions that we have for 

building dates, manipulating dates, etcetera. 

Now so far we’ve been looking at dates with no regard for which days are working days and 

which are not working days. And sometimes working days are very important. So for instance, 

you may give somebody 30 working days to pay rather than just 30 calendar days. Now there is a 

function in Excel 2016 which is the Workday function and the Workday function can calculate 

the number of work days from a given date either in the future or in the past. And it has an added 

very useful facility where it can take into account holidays as well.  
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In the first instance I’m going to demonstrate it without the use of holidays.  

So I’m going to click in D4 and I’m going to use B4 as my starting date and I’m going to look 

for a date which is 30 working days beyond August the 12th. So the function I need is Workday. 

The starting date is B4. So that’s simple enough. The number of days is going to be 30. And if I 

had holidays defined I could take them into account now. I’m not going to do that first. What I’m 

going to do is just demonstrate what the date is 30 working days from today. It’s currently 

Friday, August the 12th. That gets me to 42636. Let me format that as a date. And that gives me 

September 23rd. And of course you can check if you like to make sure that that’s correct. 

Now let’s look at this holiday feature. If you have a number of public holidays, work holidays, 

etcetera, then you can define those as a list of dates and Excel 2016 will take those into account. 

Now on this occasion I’m going to put in a few assorted holiday dates, vacation dates. So one of 

the holidays where I live is what’s called the August Bank holiday. And then I’ve also included 

Labor Day for good measure. So let me go back to my formula in D4 and in Workday there is 

now a third argument which will be in this case a range showing the range of holidays. And the 

range here is actually F4 to F5. Now both of those public holidays are within the range of 30 

working days from B4 so that should put my end date back by two working days, which of 

course it does because it now becomes September 27th. It’s actually moved it into the following 

week. So it’s gone back four calendar days, allowing for a weekend. 

Now the other thing about the Workday function is that you can have a negative value for the 

number of days. And if I change this to a negative value it would give me a date 30 working days 

before August the 12th. 

We’re going to look now at something else that you may need to do from time to time and that is 

to find the difference between two dates. Now that sounds as though it’s probably quite a 

straightforward thing to do but there are a couple of interesting complications to be aware of 

because although there appear to be some functions provided for this purpose the way that they 

work and the results that they produce may not quite be what you want.  

So let’s start by finding the difference between the date in B7 which is July the 29th 2016 and the 

date in D7 which is April the 16th 2017. And we’re going to find how many years between those 
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two dates and put that in G7. Now one way of doing this is to just use the Year function. Tick 

that and the answer is one year. Now you may look at that and say, “But that’s not a whole year. 

That’s going from July in one year to April in the next year.” And in this case what Excel is 

doing is literally looking at the year number for one year and the year number for the other year 

and taking the difference between them. It’s not looking at, for example, how many totally 

elapsed years there are between those two dates. 

Now there is an alternative approach and that is to use a function called Date Diff. And this 

function, as the name implies, is designed to find the difference between two dates. Now for 

some strange reason if you go to Insert Function, Date and Time category is selected here, you 

won’t see Date Diff in the list. I have no idea why that is. I think it’s always been like that. But 

the Date Diff function definitely exists and definitely does what it’s supposed to do. So there’s 

the Date Diff function. The first argument is the start date. So that’s B7. The next argument is the 

end date. So that’s D7. And the third argument specifies the units in which you would like the 

answer. So do you want years, months, days? Well this occasion I want the number of years 

between those two. So there it is. There’s my Date Diff function, tick it and it says there are zero 

years. 

Now when you look at Microsoft.com and any help on Date Diff it tends to describe the 

difference between these two results as finding the difference by years is rounding up and 

finding the difference using Date Diff as rounding down. Now I think that’s probably not quite 

the right way of looking at it. I think it’s much more valuable to be aware of what you’re actually 

doing with these two. And in the case of Date Diff you’re really saying how many whole years 

are there between those two dates? And the answer is there are no whole years between those 

two dates. Whereas if you use the year minus year approach what you’re saying is take the year 

of each date and what’s the difference between them? Are they in the same year, if you like? 

And in this case you’re saying no, one is a year after the other one. But it doesn’t imply that 

there’s a whole year between those two dates. Only if you like that they’re in different years and 

one year is a year later than the other. 

One other thing to be wary of in relation to these two approaches to finding the differences 

between dates is that if I reverse the dates, so in the case of the year minus year I change it to 
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year B7 minus year D7 I get the answer minus-1 as I’m sure you’d expect. Whereas if I reverse 

the dates in the Date Diff function. Now of course bearing in mind that the difference there is 

zero anyway. What happens there is I get an error message. You must have the later date as the 

second argument and the earlier date as the first argument. Obviously it doesn’t matter if they’re 

the same. But if you use the Date Diff function and the start date is later than the end date you 

will get an error. 

Let’s now turn our attention to the number of months between those dates. And first of all in G8 

I’m going to use the Month function. So it’s month D7 minus month B7. The answer I get is 

minus-3. Now this demonstrates the fact that it is only the month number. It’s not taking into the 

account the year or the days. It’s just saying that in D7 the month number is four and B7 the 

month number is seven. Four minus seven is minus-3. Sometimes that will be useful, sometimes 

it would not be useful. 

One thing you could do here is you wanted to calculate the number of months between those two 

dates, making allowance for the number of years involved is to come up with this more complex 

formula. 

Now in this more complex formula what I’ve said is we should subtract the year number for B7 

from the year number for D7 and multiply that by twelve to convert it to a number of months and 

then add the difference in months between the two dates. Let’s try that. And we come up with the 

answer nine.  

Now on this occasion that answer is not quite right and that is because in the case of D7, D7 date 

is earlier in the month than the B7 date. So in fact the number of elapsed months between those 

two dates is only eight, not nine. The reason we have a problem here then is we haven’t taken 

into account the day numbers in the month. And we could come up with an even more complex 

formula where we take into account the day numbers. But I’m going to come back to that later in 

the course when we look at Logical functions because it’s a useful little exercise involving 

Logical functions. 
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If on the other hand we go to H8 and use Date Diff again and this time specify that we want the 

difference in months between those two dates the answer we get is correctly eight for the number 

of whole months. 

Now following on from that the next question might be, what’s the number of days between 

those two dates? And in H9 I’ve already put in the Date Diff function for the number of days, 

261 days between those two dates.  

Now if you think about what to put in G9 you may be thinking now if you’re going to use the 

Day function and you’ve got to work out not only how many months between but which months 

they were because some months have got 29 days and some have got 30 and some have got 31. 

But of course the answer to the number of days difference between those two dates is very much 

simpler than that because remember that dates are stored as days. So all you have to type in there 

is it’s D7 minus B7 and make sure that the result G9 is formatted as a number and there we are. 

That’s 261. 

Now the Date Diff function does a pretty good job but there may well be occasions when you 

want to do something which is a little bit outside the scope of what Date Diff can do and it is 

very useful to be able to manipulate functions like Year and Month and Day. 

Now we have covered quite a few of these Date and Time functions, not quite all of them. So I’ll 

leave you to read up on some of the ones that we haven’t covered. Some useful ones include the 

Days function. Note that was introduced in 2013. That’s well worth a look. And by way of a 

little additional investigation yourself take a look at the Network Days function and the related 

Network Days.intl function that return the number of whole workdays between two dates 

because you may well find them pretty useful as well. So as an additional little exercise you 

might try to setup a calculation of the net number of working days between B7 and D7 on the 

worksheet in the Data Functions 02 workbook. 

Now as we go through the balance of the course we will be referring to dates, times and the 

associated functions every now and then. But now it’s time to turn our attention to Text 

functions. That’s what we’re going to start looking at in the next section. I’ll see you then. 
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Chapter 4 – Text Functions 

Video: Using Text Functions – Part 1 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to start to look at Text functions. But instead of going through the 

Text functions one at a time and demonstrating what each of them does I’m going to turn 

everything on the head this time and do a very specific exercise using a range of Text functions. 

I’m going to assume that you have used basic Text functions. So for example, I’m going to 

assume that you’re familiar with the use of Concatenation either using the ampersand symbol or 

the Concat function. But some of the functions that I’m going to be using in this section will be 

some of the ones that you may well not have used before.  

Now the basis of the exercise that I’m going to do is that I’ve been given a long list of employee 

details and for each employee I’ve got five pieces of information. And in a text file I’ve got 

about 20 employees information just as a sort of test sample. And I’m going to see if I can use 

Excel Text functions to basically tidy this data up and to reveal the structure in the data. 

I’ve opened the data here in Notepad. And if you look at the very first row in Notepad there is an 

employee name which is Juarez, Jose. There is a number, 41297. I believe that is the start date 

for the employee. And in fact if you look at the next row, Abraham, Johnny, you’ll see there’s a 

date there, March 30th 2013. So it’s probably a start date. And carrying on with Jose’s details, the 

next figure is Jose’s salary, then what I believe is the department that Jose works in, the Admin 

department, and then finally Jose’s job title.  

Now those five pieces of information are separated by semicolons and what I want to do is to use 

Text functions to split that data up for each employee. And I want to finish up with the data for 

this test sample neatly structured in a workbook. 

Now one thing that is an obvious possibility is that you could just say well why mess around 

with Text functions? Why not just type it all in using this Notepad file? As I said before, this is 

basically a sample of about 20 people. Now let’s assume I’ve got thousands of people and what I 
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want to do is to put together a set of formulae and functions that will work as well as possible for 

the thousands of employees for whom I have this data. 

So the first thing I’m going to do is to close this text file and open up in Excel.  

Now when I open this text file in Excel one of the things that it does is to offer me the Text 

Import Wizard. And using the Text Import Wizard I could say for example this is a delimited 

file. So the semicolons are used as delimiters and I could get Excel to split the data up into the 

five constituent fields. Now under normal circumstances that may well be what I would do but 

on this occasion I’m really trying to demonstrate some of the more sophisticated Text functions. 

So I’m not going to do that on this occasion. What I’m going to do is to stick with the default 

setting there of delimited, click on Next and I’m just going to stick with the default of tab 

delimiters. Now with tab delimiters as you can see it’s going to treat the contents of each row as 

a single field within the row. So in fact it’s not going to split up each row at all for me. Now I 

realize of course under normal circumstances you’d declare that semicolon is the delimiter and 

get Excel to start the work for you. But on this occasion I really want to show you how to use 

some more of these Text functions. So let’s click on Next. There’s my preview. Just click on 

Finish. And what I finish up with is a new worksheet and all of the data is in column A. 

Now that Row 1 is empty and that ultimately I will put the headings, the field names in effect for 

the data into Row 1. 

Now in the early stages of working on this file what I’m going to do is to make one or two really 

quite deliberate mistakes.  

Now before we really get started on this if you’re not very familiar with Text functions take a 

moment to look at the Excel 2016 Help. And in the Text functions category you’ll see a list of 

the functions which of course includes the ones that we’re going to use. And there are three 

functions to look at at the beginning. There is the Lower function that converts text to lowercase, 

the Upper function which converts text to uppercase and the Proper function which capitalizes 

the first letter in each word of a text value. 
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Now it’s the Proper function that I’m going to demonstrate first here. And what I’m going to do 

in column B is to use the Proper function. I’m going to say the value in B equals Proper with a 

value in column A. Let’s try one of those out. And what that does as you can see is to convert the 

text in column A into proper case. This won’t always be successful but Excel is actually pretty 

good at it. So as you can see here JUAREZ, JOSE has become Juarez, Jose but with a capital J 

on the family name and the given name. And the department has been changed to Admin, the job 

title Intern each with the word capitalized.  

Now assuming I’m happy with that what I’m now going to do is to fill that down. So select to the 

bottom and use the Control-D shortcut and that formula has been filled down in column B.  

Now I’m going to make the first of those mistakes. And the first mistake I’m going to make is to 

say, “Oh that’s much better. Let’s get rid of column A.” So I’m going to delete column A and of 

course the consequence is that column B as was, that’s now column A, doesn’t work anymore 

because the arguments in the functions that were in column B no longer exist. So one thing to 

bear in mind is that where you are doing an operation like this make sure that you do not remove 

any data that you need. 

Now of course there is an alternative to this. If what I really wanted to do was to get rid of the 

old versions of this data as I go one thing I could do instead is having done the conversions to 

proper case in column B, if I copy the content there to the clipboard, right click and do a Paste 

Values. Now of course if I delete A and B, delete both columns, then what’s left is still fine 

because I’ve pasted the values in there. And you may think, “Oh that’s a much better way of 

doing it, isn’t it?” because I’ve now got my proper case but I haven’t got a load of old redundant 

columns. 

The problem now is that if this is something you’re doing as a one off that’s fine but if what 

you’re trying to do is to work out a set of formulae and functions which you can use not on about 

20 people but on 2,000 people and you’re experimenting on a group of 20 you can’t really lose 

the intermediate steps. What we really need to do here is to keep the columns as we work our 

way through all of the data. And normally what I do in this situation is to hide the columns that I 

don’t need as I go. Now very often people write VBA code and so on to do this sort of thing. But 
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on this occasion I’m going to stick with my original intention and say that we’re using this as a 

test run and we’re going to keep all our work in as we go. So let me undo those deletions. I don’t 

actually need column C. And what I’m going to do is to hide column A. So what I have now in 

the new column B is the original data but in proper case. 

Now the next part of the job is going to be to start to split up the information about each 

employee. And the first thing I’m going to do is to separate the name from the rest of the 

information. The key to this separation is to locate the first semicolon character in the data in 

column B. And to find a particular character in a text string we use the Find Function. So in C2 

I’m going to put a formula =Find, it’s the Find function that I want. And there are three 

arguments. The third argument is the start number, the start position for the find. If I omit that 

the find will start right at the beginning of the text string that I refer to. The text I’m going to be 

looking for is a semicolon character, which I’ve put in double quotes. That’s the first argument. 

The second argument is the within text, the text that I’m looking within and the text I’m looking 

within is B2. So what I’m looking for is a semicolon in B2. And what I should get in C2 is the 

location of that semicolon. And what I’m told there is that it’s the 14th character in the text string 

in B2. You can easily check that of course. 

The other thing I’m going to need to know is the total number of characters in B2. So I need to 

know the length of the string in B2. And the Text function I use for that is the Len function. So 

=LEN. And it’s just the text string I want the length of, which is B2. So the length of B2. 

Now what I want to do is to get the two separate parts of B2 into separate fields. I’m going to put 

the name in E2 and everything else in F2. So in E2 what I want is the string of characters up to 

the first semicolon. And to do that I look for the left part, Left is a function which operates on 

text and gives you the left most characters in a string. And I want Left and Its. The text I want 

the left most characters of and the number of characters. The text string I want to take the 

characters from is B2. And the number I want is not 14 in this case because that would include 

the semicolon. It’s actually going to be 13. So that’s the value in C2-1. And subtracting one 

means that I’ll eliminate or remove the semicolon itself. Tick that and I get Juarez, Jose but 

without the semicolon.  
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Now you may be able to guess what goes in F2 because there is also a Right function. So again 

what text string am I looking at? I’m looking at B2. And how many characters do I want from 

the right of the text string in B2? Well it’s the length of the whole string which is D2 minus the 

position of the semicolon, the first semicolon, which is C2. So it’s the right part of text string B2 

and the number of characters I want is D2-C2. Let’s see what I get and that’s the balance of that 

string. And of course if I fill that down, so don’t forget the fill down option on the Home tab. 

Down and there we are. And if I look through all of those I should see that that seems to have 

worked successfully in all cases. 

Now once you’ve completed that step you may look at what’s in column F and say okay well I 

can work on column F now and separate out the first field in column F in a similar kind of way. 

And in fact that’s one of the things we’re going to do in the next section. But I’ve got a couple of 

other things to explain right at the start of the next section about what we’ve done so far and 

about a couple of alternatives that you need to be aware of. 

So the final thing I’m going to do in this section is to save my work here as an Excel workbook. 

In fact when you’re working on this kind of conversion not only is it a good idea to frequently 

save your work but you might even do things like take a copy of the worksheet, in this case the 

only worksheet, when you start, keep it within the workbook and then if everything goes horribly 

wrong you can go back to your starting point.  

Another important factor here, of course, is whether or not you’re deleting columns as you go. 

Now in this case because we’re not deleting the columns as we go it’s always possible to 

backtrack quite a long way anyway if we need to. But don’t forget keeping backups, particularly 

if you’re talking about long and complex operations. But I’m going to save this as a workbook 

now and I’ll see you in the next section. 
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Video: Using Text Functions – Part 2 

Toby: Welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to continue looking at Text functions and I want to start by reviewing 

one or two aspects of what we did in the preceding section. 

We’ve started to split up the employee data that we had into five fields. The first field is here in 

column E and the balance of the information about each employee is in column F. Now in a 

moment I am going to split what’s in column F further and finish up in a situation where we 

actually do have five fields per employee. But before we do I’d like to review an aspect of what 

we’ve been doing so far. And in order to do that I’m going to look at E2. 

Now in E2 we have a formula, =LEFT(B2,C2-1). And B2 is the text string, Juarez, Jose etcetera, 

all the information. And C2 is the value 14. C2-1 is 13. Now if I click on C2 I can see that it is 

actually itself a formula. It’s Find and it’s Find semicolon in the string B2. 

Now if I take that Find, if I copy that to the clipboard from the entry bar and now let me select 

E2, what I can do is to replace C2 with the function that I just copied to the clipboard. So what 

I’ve done is to replace C2 with Find semicolon in B2. So what I’ve done there is to eliminate any 

reference to column C from column E. Now I realize I’ve only done it in the case of row 2 but I 

could of course fill that down to cover the other rows as well. Let’s just check it’s correct. Of 

course it is. 

Note also that within that formula, =LEFT(B2,) and then Find which is embedded within there I 

have two references to B2. Now what is B2? B2 is proper A2. What I could do, let me copy 

proper A2 to the clipboard. Now I’m going to go into E2 and wherever I’ve got B2 I’m going to 

put proper A2.  

Now if I continued to do this and if I did the same to the formulae in column F I could eventually 

get to the point where I have no references to columns B, C or D. And I could in fact find the 

columns B, C and D are completely unnecessary because what I’ve done there is to create 

formulae with nested functions and each function within its arguments may have references to 

other functions with arguments and so on. So I could finish up in a situation where ultimately 
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each of my five columns with the individual fields in is really just a formula which only refers to 

what’s in column A. So I would find that all of those other columns that I’ve introduced for the 

purposes of developing this system step-by-step I could finish up in a situation where I can just 

do the whole thing with those five formulae and no other sort of intermediate columns.  

Now it’s very much a matter of personal preference which way you like to do things. Certainly 

when I’m showing people how to do these things for the first time I always break it down into 

these steps and I very often leave the columns there, columns such as B and C and D, although I 

may hide them as well. But if you can understand the use of formulae and functions and if long 

formulae such as the one as you can see there in E2 don’t cause you a problem, you can look at 

that and you can work out what it’s doing, then clearly not having these intermediate columns 

can be an advantage. You only have if you like the five columns with the answers in. If you find 

all of this quite confusing, and bear in mind that when we get to column F we’ve got yet more 

things to do to split these up and change formats and so on, if you find it’s all quite confusing it’s 

probably best to stick with the approach I’m using here of building the whole thing up column by 

column. But as I say, it is a matter of personal preference and for the moment I’m going to stick 

with this approach of using these intermediate working columns throughout and just hiding them. 

So I’ve put E2 back to the way that it was. So the formula in there is LEFT(B2,C2-1) and what 

I’m now going to do is to develop column by column a breakdown into the four remaining fields 

of the contents of column F. Now I really don’t think there’s a lot of point in you watching while 

I do this. In fact what will be a very good idea here is I’m going to save this version of Text 

Functions 01 and if you want to try doing the next bit yourself, this isn’t one of the exercises but 

you might like to try this anyway. We’ll then pick up immediately after this with Text Functions 

02. And in Text Functions 02 you’ll see the breakdown that I’ve done. 

So we’re now looking at Text Functions 02 and what I’ve done here is to continue to split up the 

information about each of the employees and I’ve put headers on the five columns that have the 

five pieces of information about each employee. So I’ve got Name in column E, Start Date in I, 

Salary in M, Department in Q, Position and R. You may well have used a different approach to 

splitting these up. You may of course have made some really quite complex formulae with 

functions embedded within functions and so on. Perhaps even the position at the end there in my 
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column R instead of being a formula like the one that I’ve got RIGHT(N2,P2-O2), you may have 

that all done in terms of column A. And if that works you’ve done a pretty good job really. 

So what I’m going to do now is to hide the working columns, bring up column A, and talk about 

some of the other issues with the work that we’ve done here. 

Now if you consider our starting point you may think we’ve made pretty good progress here 

because we’ve split up each of those pieces of information into five columns. It all looks fine. 

But in fact there are still quite a few things that need attention. And the first thing to note is that 

in the case of start date and salary both of those are coming through as text. You can normally 

tell that by the fact that they’re left justified in the cell.  

So starting with start date it’s clear that Excel 2016 hasn’t realized that it’s a date field that we’re 

dealing with and hasn’t realized that these are numbers. Now there are various ways of dealing 

with this. One of them if I click in the formula there is =LEFT. If I want to convert text to a 

number I can use the Value function. And if I click on that and say =VALUE and keep my 

LEFT(F2,G2-1) embedded in there and tick it, it becomes a number. And I can then fill that 

down to all of them and then I can format that particular column as a date column. So let me 

select the whole column and there we are. That looks much better.  

Now it looks as though the contents of the salary column are also text so let’s turn those text 

values into numbers. Now in order to format that as a currency, and I’m going to use U.S. 

dollars, I can do it pretty much the same way that I did the start date column by selecting the 

whole column and formatting the cells. There is an alternative here. There is a dollar function 

that you can use. Again it’s one worth looking up. But if I said here Dollar, it has two arguments. 

The value you want to turn into a dollar amount. This needs to be a number. And then the second 

argument is the number of decimal places. So if I say comma zero at the end, with zero decimal 

places, it will turn it into a dollar amount. But note that when I do that I finish up with a dollar 

amount as a text value. So what I’m going to do is to actually undo that one and I’m going to fill 

down the value function and I’m going to format the column as currency with zero decimal 

places. Okay. 
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Now something that you may already have noticed is that the names of these employees in many 

cases have additional trailing spaces after them. For instance, if you look at cell A2, Juarez, Jose, 

if you remember the position of the semicolon character is position 14 in the string, which 

implies there are 13 characters before it. But if you add up the characters in Juarez, comma, 

space, Jose that only comes to 12. The 13th character is the space that you can see between the E 

in Jose and the semicolon character. Now generally speaking trailing leading spaces, double 

spaces, etcetera in many situations can cause a problem but there is an Excel function, the Trim 

function that trims leading and trailing spaces and removes multiple spaces. So where there is 

supposed to be a space within a string reduces it to single space. And you could apply that here, 

for example, in cell E2. Pretty straightforward. We’ll change it from LEFT(B2,C2-1) to TRIM. 

Now of course there won’t be any visible effect on what you can see in column E but those 

trailing spaces will all have been removed once I fill the use of this function down. Again, it’s an 

important one to bear in mind if trailing or leading spaces or multiple spaces are likely to cause 

you a problem. 

And I’d like to look at one more Text function in this section. If you look at the Department 

column, department names include Mktg for Marketing, R&D for Research and Development. 

Let’s suppose that some of the data that you’re processing has abbreviations such as Mktg that 

you’d like to make into Marketing.  

Now one way that you can do this is to use the Substitute function. Now I’m going to 

demonstrate the Substitution function here. It’s not necessarily a particularly good way of doing 

this here for reasons that will become apparent in just a moment. Q2, the formula is the left most 

O2-1 characters of the string N2. Let’s introduce the Substitute function. 

Now notice what it says there about the Substitute function. Replaces existing text with new text 

in a text string. So what we’re going to look at here is the text, the old text and the new text. And 

then as an option we can specify which instance of that old text we want to replace. Now the text 

I’m replacing in is LEFT(N2,O2-1) so that’s fine. Then what I’ve got is the old text. Well I’m 

looking for Mktg. You may think it rather strange that I’m looking for that in the name of Jose’s 

department but you’ll see what I’m doing in just a moment I hope. And I want to replace it with. 

Now of course in this particular case that has no effect whatsoever. But if I fill down, just keep 
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an eye on row 8. You see that in the one instance where it found Mktg it did the substitution. 

Now of course that’s absolutely fine but it only did one substitution of marketing. And if I 

wanted to do a substitution for R&D as well I’d actually have to use the Substitute function twice 

within each formula in column Q and that’s really starting to get rather messy and there is a 

much better way of doing that that we’re going to look at later on in the course. But be aware of 

the Substitute function because that can be very useful as well. 

Now the example that I’ve just shown you where I’ve replaced Mktg by Marketing you would 

probably not do that that way if you only had one instance of something you’d more or less treat 

it as correcting an error. So for instance something like in row 7 the name of Terryy Boateng 

which is clearly misspelt with two Y’s at the end of Terry. That’s an error. You wouldn’t set up a 

Substitute to replace all instance of Terry with two Y’s with Terry with one Y. So you will 

sometimes need to make decisions about what to automate and what to not automate and to do 

manually.  

There are one or two other Text functions that we’re going to come across later on in the course. 

We’ll cover those. I suggest you do go through the Help on Text functions. That’s it for this 

section. Please join me in the next one. 
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Chapter 5 – Logical Functions 

Video: Using Logical Functions 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to look at Logical functions. You’ve probably used the If function 

before, although I’m going to demonstrate that in just a moment just in case you haven’t. You 

may also be familiar with what I’ll call the Boolean Logical functions. So And, Or, and 

Exclusive Or and Not, for example. And there are one or two newer functions introduced, such 

as the IFS function and the Switch function that have just been introduced in Excel 2016.  

The Logical functions although they’re quite a small group in number can be very important and 

are particularly important as your Excel workbooks start to get more complex. And the key 

important point about the use of Logical functions is that they enable you to evaluate values of 

cells, what to do in a given situation, etcetera on the basis of circumstances that might vary. So 

rather than always doing a particular thing you might, for instance, compare a few values on a 

worksheet and put a value in another cell on the basis of those values. Perhaps whether one value 

is bigger than another. And in its most basic form we will use the If function for this purpose. 

And it’s the If function that I’m going to demonstrate first. 

Now as a very straightforward example of the use of the If function all I’m going to do is to put a 

word in the cell C3 that says whether John’s birthday is earlier than Jane’s birthday or later than 

Jane’s birthday. 

So it’s pretty straightforward. All I need to do is to put in there equals for formula and then I put 

in If, check whether a condition is met and return one value if true and another value if false. So I 

have basically three arguments. The first argument is the logical test itself. And the test I’m 

going to do is, is B3 less than D3? So that’s my test. If B3 is less than D3 that means that John’s 

birthday is earlier than Jane’s birthday. So I’m going to put in there the word Earlier. And 

otherwise I’m going to put in there Later. So if B3 is less than D3 put the word Earlier. If it’s not 

put the word Later. Well currently it’s later. Now if I changed Jane’s birthday from 1990 to 1992 
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obviously the word that’s displayed becomes Earlier. So that’s the If function. That’s pretty 

straightforward. 

Now that’s very, very simple case but even that has some problems. What would happen, for 

example, if their birthdays were the same? Now in the past what would have happened is that 

you would have constructed a more complex If statement. So for example, going back to cell C3 

here we might first of all say If B3=D3 then put the Same or leave C3 empty. And then if it’s not 

true we would put in the If statement we have now. So we’d say in the case that they’re not the 

same, if B3 is less than D3 put earlier, otherwise put later. But in Excel 2016 we now have the 

option of using an IFS statement. And the way that the IFS statement works, let me just put that 

in, is that you put in the test that you’re going to do. So we put in our first condition. That is 

B3=D3. And then we specify the value that we’re going to put into C3 if that’s true. So the value 

I’m going to put in there is Twins with a question mark. Then I put in my second condition and if 

that’s the case it’s going to be earlier. And then I’m going to put in my third condition. So there 

we are. That should start with Earlier of course. If I put Jane’s birthday back to 1990, tick again, 

I get Later. And of course make them the same and I get Twins. 

Now as you can see there in C3 we have an IFS statement with three alternative conditions, 

Equal, Less than, Greater than. That covers all of the possibilities or almost all of the possibilities 

anyway. You can have up to 127 pairs of conditions and values there. It probably starts to 

become pretty unwieldy once you got more than a few and can become rather time consuming to 

test. But you certainly can put many conditions in there. 

But it’s still really not quite right because what if I hadn’t entered John’s or Jane’s birthday. Let 

me delete John’s birthday. It says Earlier but so far I haven’t put John’s birthday in so that’s not 

really a very good answer. So what I also need to check is that I have values in both John’s and 

Jane’s birthdays.  

Now the formatting of the cells B3 and D3 should make sure that the values can only be date 

values. But I still need to check that I have a value in each of those. So what I’m going to do 

now, I’m going to stick with my IFS statement but I’m going to imbed it in an If statement itself.  
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Now what I’m going to do here is to say that I’m only going to apply that IFS function if there 

are valid dates in both B3 and D3. So I’m looking at B3 and D3 both containing numbers greater 

than zero. So I’m going to apply an If and the condition I’m going to test is that both B3 and D3 

contain numbers greater than zero. Now in order to check that two conditions exist I’m going to 

use the And function and I’m going to check that B3 is greater than zero and that D3 is greater 

than zero. If both of those conditions are true I’m going to apply my IFS. If they’re not both true 

I’m just going to put a space character in C3. So let’s try that out first. We get Twins. Let me 

delete John’s birthday and see what happens. Now I have a space. Let me put John’s birthday 

back in, a different date perhaps. And similarly I can test deleting Jane’s birthday and again I get 

a space there as well. So that new formula seems to work pretty well. 

Let’s now look at one of the other new logical functions. This is the Switch function. It’s quite 

similar to IFS in some ways. The main difference is that we’re only looking at the value of one 

thing. And in order to demonstrate the use of the Switch function we’re going to look at values in 

the Q column on our imported employee data.  

Now I’m going to work on cell S2 and I’m going to say that the formula is =SWITCH. And the 

value I’m going to test is the value in Q2. Now what I do is test that against a number of values. 

And the first value I’m going to look for is the value Admin. And if I see the value Admin what 

I’m going to put in S2 is Administration. The next value I’m going to look for is Mktg. 

Hopefully by now you can see where I’m going with this. If I find that value I’m going to put 

Marketing. And the next value I’m going to look for is R&D. And if I see R&D I’m going to put 

Research and Development. 

Now right at the end having identified the three cases where in effect I want to change the 

department to the full name of the department what’ll I put as my default? What if I don’t find 

any of those? Well if I don’t find any of those the value I’m going to put is just Q2, so whatever 

is in Q2. Let me tick that. Let’s go back there. Let’s do a fill down. And there you can see where 

we had Admin we’ve got Administration, Mktg is Marketing, etcetera. 

So that is a better, although still not the best way, of doing that substitution of those department 

names. 
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So there we are. We’ve looked at a couple of the basic Logical functions, If and And. And I’ve 

looked at particularly the two new Logical functions, the IFS and the Switch. And in the coming 

sections of the course we’re going to be using Logical functions quite a bit. And the first way in 

which we’re going to use them is in Exercise 01 which is coming up in the next section. So 

please join me for that. 
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Video: Exercise 01 

Toby: Welcome back to our course on Excel 2016 Advanced. 

It’s time now for Exercise 01. And in Exercise 01 I want you to set up a very straightforward 

John’s birthday, Jane’s birthday pair here. I’d like you to make a few improvements to the 

version that you saw during the previous section though. 

One of the improvements is that I want you to be specific about missing birthdays. So in this 

case I’ve got neither birthday in there. It says, Please enter John’s birthday. So let me put John’s 

birthday in there. Okay and when I tick that it says okay now I need Jane’s birthday. Put that in 

as well. I’ve got both now. I’ve got the question are they twins? Let me change John’s birthday. 

Now it says John’s birthday is 373 days later than Jane’s birthday. And obviously if I made 

Jane’s birthday later it would be able to cope with that as well. So it’s actually telling me how 

much older they are than each other in days. 

Now that’s basically it for Exercise 01. But I would like to go back to a point that I made earlier 

in the course when we were talking about differences in years, months and days. And I made the 

point that sometimes when you’re doing those calculations you need to address issues like 

whether a particular date is earlier or later in the month than another date. While using the 

Logical functions you can perform this kind of test. So you can look at a date and look at the day 

number in the month, look at a different date, look at the day number in the month and work out 

pretty much to any level of accuracy or detail what the difference in years, months, days, etcetera 

between dates is. So it’s using these Logical functions that you can address those issues with date 

calculations.  

That’s it for this section. Please join me in the next one. 
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Chapter 6 – Lookup Functions 

Video: HLOOKUP Function 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to take a look at LOOKUP and Reference functions. And in particular 

we’re going to start looking at LOOKUP functions. And as the name implies what we do with a 

LOOKUP function is looking up a value in some kind of index or a list and using the returned or 

identified value.  

Now I’m going to demonstrate first a very, very simple LOOKUP function which is the Choose 

function. It’s really quite limited in what you can do but it’s a very easy function to use and you 

may well come across situations where it does the job for you. 

So by way of a very straightforward example of this let’s suppose that I have some responses to 

some survey types of question. And people give a numeric response in the range one to five. And 

each of those numbers corresponds to a phrase. And in a particular situation I want to not only 

show the response as a number but also the phrase that it’s equivalent to.  

Now the way that I can do that in this case, I’m going to put the phases in column D is to use the 

Choose function. Now I can either start typing =CHOOSE or I can go to LOOKUP and 

Reference and there is the Choose function. And first of all, first argument, is the index number. 

So this is the number that we are going to look at and use as the basis for our choice. Now for D3 

the number I’m going to be looking at is the number in C3. 

The next argument is the value I’m going to put into D3 if the value in C3 is one. It always starts 

at one. So I’m going to say that one corresponds to strongly agree. Now I put in the next value. A 

value of two corresponds to agree. A value of three. Now I can have up to 254 values there. So at 

the moment I put in five values, which means in this case that I can accommodate numerical 

values in C3 from one to five.  

Now all the time that there is nothing there then I’m going to get an error message, in this case 

#VALUE!. I’ll come back to that in just a moment. Let me now put a number in there, 2. That’s 
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agree, 4. Now as you can see that’s pretty straightforward. Now Choose always works with 

positive integer values starting at one on a continuous scale. If in fact in the response there I put 

something like 3.6 what Excel 2016 does is to round that down and it will give me the equivalent 

of if I’d put three in there. I need that to be a little bit wider. So that’s neither agree nor disagree. 

And if it comes out below one, so let’s suppose I put 0.8 in there I’ll get an error. And if I put a 

value of six in there of course I’ll also get an error. 

So that’s basically how the Choose function works. But it also presents us with another issue. If 

I’m setting up something like this is there some way that I can avoid getting error values like that 

one? 

Now there are a couple of really good ways that you can deal with situations like this one where, 

for example, you want to put a formula into several cells but you know that until some other cells 

have values in them the formula is actually going to return an error. So for instance here you 

could actually test to see if the response was in the range one to five. And if it isn’t you could 

actually prompt the user to enter a value there. But a very straightforward way of dealing with 

this is to use the IFERROR function. Now with the IFERROR function what I do is in this case I 

evaluate my formula using Choose and if there is no error I will get the value that Choose is 

going to deliver to me. But if I get an error what I do is the second argument in the IFERROR 

function. Note there the screen tip value IFERROR I can say what I’d like to appear in this case 

in D3 if there’s an error. Now I might want to put a message in there such as Response must be 

in the range one to five. Or if I’m anticipating that I’m going to fill D3 down to D12 with this 

formula and therefore I’d get that message everywhere I might just choose at this stage to just 

leave the D column entry empty. So I could say I’m just going to put a space in there if there’s an 

error. So I click on tick and now what I get is nothing. Let’s fill the formula down. I don’t get 

anything anywhere. Let’s put a three in there. Let’s put a one in there. Let’s put a zero in there, 

etcetera.  

Now as I say you may want to combine this with a more complex arrangement whereby you say 

well if in fact there’s a response in the cell in column C that it’s not in the range one to five then 

I actually want to say to the user You must enter a value in the range one to five. But as you can 
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see you can build this up to be as complex as you need it to be. But the IFERROR function is 

useful and the Choose function certainly can be as well. 

So just to quickly run over that again. Looking at D4, note the use of the Choose function there. 

My index value is the value in C4 and the Choose function will return values for an index value 

of one, two, three, four, up to the number of alternative values I specify. And in the Choose 

function there I specified five potential values which must be one to five. They must go in 

sequence like that up to a maximum of 254. Having said that an index value of 1 in C4 means 

that the value in D4 is strongly agree. An index value of two would make it agree, an index value 

of three of course made it neither agree nor disagree.  

Now the five options there are all text values but in fact I could have put numbers in there, I 

could have put cell references, I could have put functions, formulas, names. So there are many, 

many possibilities of what you can put in this case into D4. But it’s important to remember those 

limitations. 

Now we’re next going to look at one of the most popular LOOKUP functions and actually 

there’s a pair, HLOOKUP and VLOOKUP. And in this section we’re going to have a very quick 

look at a simple example of HLOOKUP. The H there stands for Horizontal Lookup. And then in 

the next section we’re going to look at a more complex example of VLOOKUP or Vertical 

Lookup.  

So what we have here are some class scores in a quiz and I have scores for around 20 students, 

19 in fact. And what I want to do is to determine which quartile each student’s score puts them 

in. Now the lowest score there for Parker, Hector in row 12 is a 43. We’ve got some very high 

scores as well. We’ve got a 98 and so on.  

So what I’m going to do first of all is to use a straightforward statistical function to calculate the 

quartiles. Now let me just explain what quartiles are. If you have a set of results like this think of 

slicing them up into four even bits. So 19 students, let’s call it 20 roughly. You’re going to say 

what range of scores covers the first five, then the next five, then the next five, and then the next 

five. So you’re really dividing the class up into four quarters.  
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Now the first thing that I need to do here is to evaluate the quartiles. These are the values which 

divide my results into four even sets. Now if you have not used Quartile functions before let me 

just demonstrate something I mentioned earlier on in the course. You know you need a statistical 

function. You’re not really quite sure what statistical function it is. So you might start to type in 

Quartile, see maybe somewhere in that lot is quartile. Look, there’s a whole set of them.  

The first two, Quartile and Quartile.INC are effectively the same. Quartile is the original Quartile 

function and Quartile.INC replaces it because there is a distinction between Quartile.INC and 

Quartile.EXC. Now I’m not going to go into that distinction here. It is an important distinction 

and it’s to do with the use to which a quartile is being put. But for the purposes of demonstrating 

Lookup functions we’re going to stick quite comfortably with Quartile.INC. So we’re going to 

use that function.  

And we have two arguments. First of all which array of numbers are we going to find the quartile 

of? So the array of scores there which is B2 to B20. And I want the first quartile. So this will be 

the score below which the first quarter of students would be positioned. So this is if you like the 

weakest quarter in the class. Click on OK and I find that score is 72.5. 

Now what I need to be able to do is to evaluate the other quartiles. And I’m going to arrange 

them horizontally. Now if I select the three cells to the right and then use the Control-R keyboard 

shortcut you notice that I get errors. And the reason I get errors of course is because if I look at 

the formula in G2 I am now looking at the scores in C2 to C20 which is definitely wrong. So of 

course when I specify the array from which the quartile scores are going to be calculated I need 

to use absolute references. So let me undo that, go back to this formula and change it to $B$20. 

Okay. Now I can right fill. Of course I’ll get the first quartile in all of those cells. All then I’ve 

got to do is go in and edit those to get the second and subsequent quartiles. And very importantly 

at the beginning of my set of scores is the score of zero. Now the function we’re going to use in 

order to decide which quartile each score is in is the HLOOKUP function. And the way that the 

HLOOKUP function will work is that I will tell it where this list is and for each student’s score, 

so let’s start with John Beale, 82. It will read along that list horizontally. 82 are bigger than zero. 

82 yeah bigger than that. Yep bigger than 76. No, I’m not bigger than 87. And therefore the score 

of 76 in this case denotes the start of the third quartile. The score of 72.5 denotes the start of the 
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second quartile and a zero will denote the start of the first quartile. Now that just leaves the last 

score, 98. Now that’s the highest score and the highest score is going to be in the fourth quartile 

as well. 

So basically as HLOOKUP works its way along there it waits until it gets to a score that’s too 

big, in this case for John that would be 87 and says okay well John must be in the category that 

begins with a score of 76 and that’s the third quartile. That’s the quartile that starts at the median. 

So we’re all set to work out these quartiles. We’re going to use the HLOOKUP function. The 

first argument is the value we’re going to look up. Well the quartile C2 is going to be based on 

the score in B2. So the lookup value is B2. The table array that we’re going to look in is E2 to I3. 

Now we’re going to need to be a little bit careful there because we know that we’re going to 

need to absolutely reference that. The row, which row gives us the value we want? Well it’s the 

second row, the second row contains the quartile numbers. And then we have a logical value 

range lookup. Now if range lookup is set to true that means we’re looking for values in ranges. 

So for quartile one it’ll be in the range zero to 72.5. If we wanted to match the values exactly, so 

if we were looking for exactly 72.5, 76, etcetera we would set range lookup to false. But we want 

it to be true. We’re looking at scores within ranges so that’s true. Click on OK. And it correctly 

says that John Beale is in quartile three. Let’s do a fill down now and see where we get to with 

the other scores. I’m just going to center those and I think they all look correct.  

I suggest you check those yourself. I’ll see you in the next section. 
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Video: VLOOKUP Function 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to continue looking at Lookup functions and we’re going to in 

particular look at the VLOOKUP function. The principle in which this function works is pretty 

much the same as HLOOKUP except that instead of expecting a horizontal list of values to 

lookup it looks for a vertical list of values to lookup.  

Now one of the reasons that I’m devoting a section to this function is that I’m also going to start 

to make the Lookup functionality here considerably more complex. And the way that we’re 

going to use the VLOOKUP function here is to do some more work on developing an invoicing 

system.  

At the moment in Lookup_Functions_3 here I’ve got a few headings on a sheet and apart from 

the date at the top here which is today’s date and those headings there’s not much on it. But the 

general principle is that I’m going to put together a system whereby I can take an order from a 

client, list the details of the order and prepare an invoice.  

Now basically in the body of the order, in this part here, I’m going to specify the number of an 

item that the client wants. So the quantity goes in there. A part number and then a description 

associated with that part number. There will then be a unit price, discount where applicable, a 

discounted price and a total price and then a grand total for the order down in cell H12 at the 

moment. 

Now the first thing you may say is well where are all of these things coming from? Where do we 

get these prices from? Well on the second sheet in this workbook I have a catalogue. It’s a 

relatively small catalogue but it will demonstrate what I need to demonstrate perfectly well. And 

it’s a catalogue of parts. They’re actually plumbing, bathroom fitting parts. And each part has a 

part number in column A, a description in column B and a dollar price, undiscounted, in column 

C.  

So basically what we need to do is when we put a part number in column C on the first sheet the 

first thing we’re going to do is look up the description. Now if somebody puts a part number in 
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there that doesn’t correspond to an item in the catalogue we’ll want to put a relevant message in 

there. And we’re going to need to deal with various other complications as we go along, but let’s 

start with that basic functionality first. 

Now the first thing I’m going to do is to give the parts catalogue, in fact all of the parts catalogue 

except the header row, although the header row wouldn’t really cause me a problem, and name. 

So I’m selecting all of that. Click on Formulas. I’m going to define a name. And the name I’m 

going to give this is Parts Catalogue. Note the scope of the name is Workbook. So I can 

reference it on a different worksheet. So it’s the whole workbook which is fine. Click on OK. 

Now let me go back to Sheet 1 and let me implement my first VLOOKUP. What I actually want 

to do is to in the description show the description for the part that’s specified in column C. So 

I’m going to do that using VLOOKUP. The arguments start with the lookup value which will be 

C7. The table array will of course be the name, Parts Catalogue. And which column in that table 

array is the one that contains the description. So that’s the second column.  

Range lookup. Now you should remember me talking about range lookup from the preceding 

section. Here if you are looking for values in a range, say between two part numbers, you would 

set this to true. But that’s not what we want at all here. What we need here is an exact match. 

When we specify a part number in column C we must look for exactly that part number in the 

catalogue. So in this case the range lookup value is false. Click on OK and of course we get an 

error message there. In fact we get an N/A error message.  

Now because I haven’t got a part number in C7 at the moment I’m going to get that N/A 

message. I can overcome that using a similar approach to the one we used in the preceding 

section for cases where we get an error message because there is an IFNA function. So what I’m 

going to do is embed that VLOOKUP in an IFNA function. The first argument is the value to 

assign if the value is not N/A. And the value if it is N/A, I’m just going to set to be an empty 

string, not even a space but an empty string. Let’s try that.  

Okay let’s try now. Let me just take a quick look at the catalogue, choose a number, 19232. Let’s 

try that. Okay that’s pretty good. It’s found that okay.  
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Now of course one problem you can see there is that I need to wrap the text. So what I think I 

might do is wrap the text throughout column B at the moment, see if it causes me any problems. 

Okay. That looks fine. 

Now I’d like to do one more thing to this just to make it a little bit more helpful and informative. 

First of all let me fill down that formula as far as D11. And let me say in C9 put a part number 

that doesn’t exist in the database. Now you notice how in this case what has happened is 

different from the situation where the part number is just left blank. I’ll actually show the text 

there Not Found. And if you look at the version of the formula that I have here I’ve still got the 

IFNA and the VLOOKUP. And of course if the VLOOKUP works and the part number is found 

then the description is shown. But if it doesn’t in the second argument for the IFNA I’ll put an If 

statement. And in the If statement I’ve said if you trim the part number, in this case C9, and it’s 

blank then that means that the user hasn’t entered a part number and therefore the fact that the 

Lookup didn’t work doesn’t matter because the user hadn’t specified a part number. So in D9 

just put a blank. That’s the double-double quotes. But if when I trim C9 there’s something there 

but I still don’t find a description, so the VLOOKUP still doesn’t work, then I’ve got a situation 

where the part number is not found and in that case the message I’m going to put in D9 is Not 

Found. 

So that draws a distinction between the case where the user has entered a value in the relevant 

cell in column C and where they haven’t entered a value. Because when they haven’t entered a 

value then we haven’t got a missing part number. Whereas if they had put a value in there and 

the VLOOKUP doesn’t work then it means that that part number is not in the catalogue.  

So that’s quite an important change to make, quite a helpful change to make. 

So armed with VLOOKUP and a couple of the other things that I’ve explained recently I think 

we can do quite a bit more work on this invoice. But in fact to be more specific I think you can 

do quite a bit more work on this invoice and you’re going to do quite a bit more in Exercise 02 

which is coming next. I’ll see you then. 
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Video: Exercise 02 

Toby: Welcome back to our course on Excel 2016 Advanced.  

It’s time now for Exercise 02. And with Exercise 02 I’m going to set you quite a few more things 

to do to this invoice that we’re developing. 

The starting point is the Exercise 02 file and my answer will be in Exercise 02 Answer. There are 

several steps to this exercise so I’m going to work through it in front of you without actually 

showing you exactly how I’m doing each step because that’s going to be for you to figure out. 

So the point at which we left this was that we’d setup VLOOKUP to determine descriptions for 

entered part numbers and we’d put in some handling for situations where there was a missing 

part number or in situations where the part number is not entered in column C. Now ultimately 

we may want to make the number of line items in this invoice variable but at the moment I’m 

happy to leave it at five line items, provided we don’t get any spurious content in rows where a 

valid part number is not entered. 

Now the first thing I want you to do is to pick up the unit price from the catalogue. 

And having picked up the unit price make sure that the quantity column, column B, allows just 

numeric column numbers. So in this case the customer’s ordering three door handles. But then I 

want you to apply a discount. And the rule for the discount is that the discount is generally zero 

unless the item being ordered has door handle in the description. So we’re doing a special I 

thought on door handles at the moment. We’ve got 10% discount with door handles.  

So this is the next step for me. I’ve now got two line items in the order. The first line item, part 

number 19232, is in fact for some door handles. And as you can see the discount of 10% is 

shown in column F. And the discounted price is shown in column G. Whereas the second line 

item, 48133, these are not door handles so there is no discount. The discounted price is the same 

as the unit price. I’ve then multiplied the quantity by the discounted price for the total price. And 

then I’ve got a grand total at the bottom there, $88.47. And I’ve also put in cell B12 the total 

number of items in the order. 
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So in Exercise 02 this is what you’re headed for. But there are some features which are not 

immediately apparent and I want to talk about those next.  

In rows 10 and 11, that’s the fourth and fifth line items, note that there is nothing shown at all. 

But in fact the required formulae are in the various columns. So all of this is set up in such a way 

that those cells are empty all the time there is no valid part displayed. Note that in row nine, that 

is the third line item because we have a part that doesn’t exist in the catalogue we don’t get a 

price or a discount, etcetera. So one of the tricky things about these formulae is that you need to 

set them up in such a way that these cells are left blank when there is no valid value to show. 

You don’t want an error message or an N/A or anything like that or lots of zeros that aren’t 

relevant. So that’s one of the tricky things to do. 

And another tricky thing to do is this. Let me put in another part number here. I’m going to put in 

75664. Now note that is not a door handle so there’s 0% discount. I get the unit price. Okay I get 

the discounted price. Okay. The total price is zero because I haven’t put a quantity in yet. Let’s 

suppose I want four of those. That’s fine. Now let me put in one other part number, 51609. We’ll 

have two of those. Now note, 10% discount because this part is a door handle. Note that in this 

case the H on Handle is lowercase. So still the way that I’ve done detects the fact that this is a 

door handle part. And if you’ve been using the Find function you may want to look at an 

alternative for that or you may want to think a bit more laterally about what you would need to 

do, for example, to a description to look for door handle in it whether or not it had capital letters 

and indeed whether or not it was door handle or door handles. So a little bit more sort of detailed 

thinking there to do and quite often when you’re setting up relatively complex workbooks in 

Excel some of these details take quite a little bit of head scratching to sort out. 

And perhaps the only other thing that I should say is that if you come up with a solution which is 

pretty much completely different to mine but works and does all the things that I’ve talked about 

it’s equally valid to mine. There isn’t one right way of doing this and loads and loads of wrong 

ways. You’re just looking for a way that works to the level that I’ve described here. Now to be 

fair there are one or two ways in which what I’ve done wouldn’t quite work in an ideal way and 

I’d probably have a little bit more work to do on it to sort out any little remaining glitches. But 

don’t look to match what I’ve done in terms of how I’ve done it. Just find something that works. 
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That’s it for this section. I’ll see you in the next one. 
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Chapter 7 – Financial Functions 

Video: Financial Functions and Terminology 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. In this section 

we’re going to start to look at Financial functions.  

There are a very large number of Financial functions in Excel. Some of them are used for 

personal finance, some for professional finance used in commerce and industry and some can be 

used in either. There are some aspects of using Financial functions that take a little bit of getting 

used to. And so in this section I’m going to demonstrate and explain one of the most commonly 

used Financial functions and in doing that I’ll talk about some of the terminology and other 

issues that you need to be aware of when you’re working with Financial functions.  

The first function I’m going to work through is the PMT function, the Payment function. And 

basically we generally use the PMT function to work out the payments on a loan. Now it’s a little 

bit more powerful than that and there are quite a few options and bells and whistles and so on 

that are associated with the Payment function. And again I’m going to use this section as an 

opportunity to explain these. 

One of the first things that takes a bit of getting used to is some of the terminology. So what I’ve 

set up here on this very simple sheet to begin with is a set of five things in cells B2 to B6, Rate, 

Nper, PV, FV, and Type. I’m going to explain what all of those are. And then subject to what 

I’m going to explain about those five values we are going to be able to calculate a payment. 

Now one other term that you will see from time to time when you’re working with Excel 

Financial functions is the terms Amortization. And many people don’t really know what this 

means. Amortization in a general sense is spreading something out. So in the case of payments 

on a loan it’s effectively the schedule for repaying the loan. It can also be used elsewhere in 

finance for things like how you spread out over a period of time the depreciation on an asset, that 

sort of thing. But don’t let the term Amortization confuse you. It just means your schedule of 

payments in the case of a loan, how you spread those out over time. 
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Now what I’m going to do first is to click in cell C8 here and I’m going to introduce you to the 

Payment function. So it’s PMT, open brackets, and you can see that there are actually five 

arguments and those five arguments correspond to the five terms that are in cells B2 to B6. And 

in order to explain each of those let’s bring up the useful Function Arguments dialog.  

The first term is Rate. And this is the interest rate per period for the loan. One very important 

thing to bear in mind with Excel and the payment function is that it doesn’t always have to work 

in years or any other specific unit. If you’re actually working out monthly payments you need to 

put in here the monthly interest rate. Look at the example there. Use 6% divided by 4 for 

quarterly payments at 6% APR. So that’s how you can enter an interest rate for a period other 

than an annual period if you’ve in fact got an annual interest rate to work with.  

Next we have Nper. This is the total number of payments for the loan. So on a five year loan 

with monthly payments that’s 60.  

PV, the present value. Now in this case the explanation there is probably a little bit confusing if 

you’re thinking of a loan. The total amount that a series of future payments is worth now. So in 

the case of a loan this would be the principle amount, the capital amount of the loan. So if we 

were borrowing $5,000 we’d put 5,000 in there.  

And if the intention is to pay off a loan completely the future value, the value you’d want to 

finish up with, FV, is normally zero. Now it may be that what you really want to do is to reduce 

the amount that you owe somebody. You’re not going down to zero. In this case you’d put a non-

zero value in here. But more of that later. 

And then the fifth item, Type, very important. This is a logical value. It’s a one or a zero. If it’s a 

one you’re making payments at the beginning of the period. If it’s a zero you’re going to make 

the payments at the end of the period. The significance there of course is that if you make a 

payment at the beginning of the period then you’re not going to incur interest on the amount of 

that payment through that period, whereas if you wait until the end of the period you will be 

accruing interest on the amount that you haven’t paid until the end of the period. 
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So let’s work through an example of this. Let’s suppose that I want to borrow $5,000. And I’m 

going to completely pay off the loan so the future value will be zero. And I’m going to make 

payments at the start of each period. The payments are going to be monthly payments over a 

period of five years. So there’s going to be 60 payments. And with a 5% annual rate of interest 

let’s now work out what the payments are. So the rate is C2/12 to give me a monthly rate. The 

number of periods is C3, the present value is C4, the future value C5, the type C6. Let’s see what 

we come up with. So I have a monthly payment of $93.96. Note the red, the negative amount 

there. That indicates that this is money going out. So the $5,000 is black. It’s positive. It’s money 

coming in. the $93.96 is negative. It’s money going out. So that’s a very straightforward example 

of the use of the PMT function. 

Now let’s just look at one or two changes to some of these arguments. What do you think would 

happen if I’d changed the type from one to zero? So instead of making payments at the start of 

the month I make them at the end of the month. Would that increase or decrease the payment? 

Well based on the fact that there will be interest to pay on the monthly payment amount which 

I’d be hanging onto for the month, if I changed that to zero $93.96 should go up. And in fact it 

becomes $94.36. So that’s 40₵ a month extra if I make the payments later on in the month, at the 

end of the month.  

And what about looking at that figure of $94.36 and thinking well I really can’t afford that much 

every month? What about trying it over ten years? Let’s try 120 months. Let’s see what that 

does. Well that reduces the payments to just over $50, $53.03 per month. So with this 

arrangement it’s very easy to adjust each of those arguments and see the consequences in terms 

of how much I’d need to pay each month for this loan. 

Now I want to show you one other thing in relation to this which is one of those things that does 

tend to confuse people quite a bit.  

What if my intention is not to pay off this loan but to finish up with a reduced loan? So I want to 

reduce it from say $5,000 to $1,000. I’m currently planning to pay $53.00 a month to completely 

pay off the loan of $5,000. What if I didn’t want to completely pay it off? I wanted to reduce it 

from $5,000 to $1,000? Now what I’m going to do here for Future Value, FV is to change that 
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from zero to $1,000 in the mistaken belief that that means that I still owe $1,000. But the 

mysterious thing, you may look at that and say, “Well that’s a bit strange”, is that the payment 

has gone up to almost $60. So why has it gone up? Well the reason that it’s gone up is because 

the future value, if I still owe $1,000 is not $1,000. It’s minus-$1,000. The value to me is minus-

$1,000 because I still owe $1,000. The PV, a plus, is money I’ve been given if you like or money 

that I borrowed anyway. So that’s a plus. That’s coming in. But that $1,000 in FV is still an out 

value. It’s a value that I still owe. So I would need to put that as minus-$1,000. What I’ve got 

here for my $59.47 a month payment is an initial amount of $5,000 that I was provided with at 

the beginning of the loan period which I am now paying off and at the end of it I finish up with 

$1,000 in my pocket. So I’ve sort of borrowed $6,000 if you like because I finish up with a plus 

amount of $1,000. I’m in credit by $1,000. What I really want to show here if I intend to finish 

up still owing $1,000 is minus-$1,000 and then my payments go down to $46.59 per month. That 

is a very important point. And if you’re not used to accounting terminology and an accounting 

approach that can be something that’s quite confusing. So it’s one to be very careful of. 

So having looked at the Payment function we’re going to move on in subsequent sections to look 

at other financial functions.  

I just want to mention something about Excel 2016. This isn’t strictly related to either the use of 

functions or in fact to an advanced course in Excel. But there were a couple of financial 

templates introduced in Excel 2016. There is a personal cash flow template and a stock analysis 

template. And both of these to some extent overlap some of the things that we’re doing in these 

sections of the course. So I do suggest that you have a look at those two templates. Now they 

largely deal with the presentation and automation of the use of these functions but they are two 

interesting new templates and I do suggest you take a look at those. 

But for now that’s the end of this section. I’ll see you in the next one. 
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Video: Personal Financial Functions 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to continue to look at Financial functions and we’re going to start 

here by looking at another personal financial function. 

The function we’re going to look at is the FV function. And it is more or less the opposite of the 

PMT function. What the FV function basically does is to work out the future value of a saving or 

investment based on payments over a period of time. But although we start in this section with 

the FV function I then like to combine it with some of the topics that we covered earlier on in the 

course to make a pretty useful retirement planner. Now you’ll see what I mean by that when we 

get to that point. Let’s start with the FV function. 

I’m going to put the future value of a saving or investment in C8 on this worksheet. So it’s =FV, 

that’s Future Value, open the brackets. You can see the arguments there. Let’s say I bring up the 

Function Arguments dialog and you should be pretty familiar with what all of these terms are. 

First of all there’s a rate. So the rate is going to be the value in C2. Now that’s the annual rate 

and I’m going to work on the principle that this is monthly savings. So I’m actually going to put 

in there C2/12 as the argument. That will give me the monthly savings rate. Nper is the total 

number of payment periods. So that’s going to be C3. The monthly payment is going to be C4. 

The PV, the Present Value, that’s going to be C5. And then the type is going to be one or zero. 

Zero if omitted. So that’s my FV function. Now of course at the moment I get a value of zero. 

Let’s put in an interest rate of 3%. Let’s say over a period of ten years. So that’s 120 months. A 

payment of $200. Don’t forget this is a payment so this is going to be minus-$200. Let’s assume 

that we’re starting with nothing and we’ll go for the default type of payment of zero, which 

means payment at the end of the period. And that gives us a future value for the saving of 

$27,948.28. 

So as far as that goes it’s fine. But what I’d like to do is to turn it into a retirement planner. If I 

were developing a retirement planner generally speaking what I’d ask somebody is what is your 

date of birth? At what age do you intend to retire? And then work out based on, for example, a 

monthly payment the value of a pension fund that had been accumulated by that retirement date.  
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Now clearly the amount, the FV value of that particular type of saving will depend on how many 

months there are between the time that the savings plan starts and that retirement date. So what 

we really need to know, what we really need Excel to 2016 to calculate for us is the number of 

periods from now to the date that somebody is going to retire. Now you could ask somebody on 

what date are you going to retire but generally speaking rather than have people try to work that 

out you can just say, what was your date of birth and what age do you intend to retire? So let’s 

add a couple of extra rows to this worksheet.  

I’ll do a little bit of formatting. And what I’m going to do is in B2 I’m going to put. I’ll do a little 

bit of formatting. And now what I really want to do is to work out how many months there are 

from let’s take it as today until the potential savers retirement date. 

So the calculation we have to do here is that given a date of birth and a retirement age we need to 

work out how many months between today and the retirement date of the potential client. 

Now first of all let’s work out what the retirement date is. I’m going to put the retirement date 

here in E2 as a temporary measure. Generally speaking when I’m developing more complex 

formulae I do tend to do them a step at a time and I often use part of the workbook as a sort of 

scratch area and then I’ll delete the scratch work afterwards. I’m going to work out the 

retirement date and store it temporarily in E2. 

Now let’s suppose then that this person’s date of birth is December 24, 1969 and they want to 

retire at the age of 55. Now the way that I add 55 years, you should remember how to do this 

from earlier in the course. Obviously this isn’t the only way of doing it. So there we are. It’s 

basically the same date as C2 but I’m adding C3 years to the year. So let’s see what that gives 

me. So that’s going to December the 24th 2024 which looks good to me.  

And now the number of months between today and that date is what’s going to go in here. Again 

you should be able to remember how to do that. That’s actually 99 months. Let me just format 

that a little bit better. We’re not going to use any decimal places. That’s 99 months. 

So what I do now to remove my temporary work is to go to E2 and take from the formula bar 

that function there which was the one I used to add C3 years to the date of birth. I’m going to 
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copy that to the clipboard. Having copied that to the clipboard I’m going to cancel that. I’m 

going to go down to Nper, number of periods, and instead of E2 as an argument in that function 

I’m going to substitute the contents of the clipboard. Let’s just make sure that still works okay 

and it does. And then we can delete or clear everything in E2.  

So I now have a working retirement planner. If somebody comes to me with a very different date 

of birth not only do I find out how many months before they retire but I get a future value for 

them based on their agreed monthly payment. 

Now I saved this particular sample as Personal_Financial_Functions_2 in the course files folder.  

One other thing to mention here and that is to do with PV. Let’s suppose that before somebody 

started saving for retirement they already had a certain amount of money in their retirement pot, 

their pension pot, and want to include it in here as a starting point. And of course remember in 

that starting point if it’s invested at the same rate of interest that will grow in value as well. So 

let’s suppose this particular saver has also already got $100,000 as a starting point for this 

pension pot. That would go in as a PV negative value. So that’s an amount going into the pension 

pot. And that would increase the future value of the pension pot to $370,000, just over. So it’s a 

good point to remember when you’re doing calculations such as this one that the amounts that 

are being paid or have been paid into a savings account are recorded as negative numbers. The 

future value which is an amount coming back in is a positive number. 

Now I just want to talk about two other personal financial functions. These were actually both 

introduced in Excel 2013 so they’re not new in Excel 2016 but I think as far as personal finance 

goes they are two very useful functions. So I’ll just point you at the Help on those. 

One of them is the RRI function. And basically with the RRI function what you do is to give the 

starting value of an investment and a future value of an investment or the current value of an 

investment, the number of periods that the investment has been in place and it returns the 

equivalent interest rate for the growth of an investment. So if you have savings and you want to 

know what the equivalent interest rate is for the period that the savings have been in force, what 

you started with and what the value of the savings is now, the RRI function will tell you what 

that equivalent interest rate is. 
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And the other very useful one in personal finance is the PDURATION function. And with this 

function you basically say I have an investment, a certain amount of money here and I would like 

it to grow to this amount of money and I can get this interest rate. How long will it take? What 

would the duration of the investment need to be? Again that’s a very useful function. And with 

both of those functions there are examples and I do strongly suggest that you actually work 

through a quick example yourself to make sure you’re familiar with both of those. They’re pretty 

simple to use. It won’t take you long. But if you do a little trial run I’m sure you’ll find they’re 

okay. 

Next we’re going to turn our attention to professional financial functions. That’s what we’re 

going to cover in the next section. I’ll see you then. 
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Video: Professional Financial Functions 

Toby: Hello again and welcome to back to our course on Excel 2016 Advanced. 

We’re now going to turn our attention to some more advanced aspects of Financial functions and 

many of the functions that come into the category of advanced are ones that are used more in a 

professional context than they are personally. Having said that, many of them also can be used 

for personal finance. And the first case that we’re going to look at relates again to loans, but in 

this case I’m going to do something which businesses often need to do which is to split the 

payments on a loan between the principle repayments and the interest repayments to understand 

what part of a monthly payment falls into each category. 

Now I’ve set up a very straightforward example here. The table of values is in B2 to C6. So I 

have a rate, a number of periods, the amount of the loan, the principle value $150,000, future 

value zero, and the monthly payment calculated using the PMT function is $1,109.53. But what I 

want to do is to determine how much of that payment is principle and how much of it is interest. 

And I’m going to use two specific Excel functions to calculate those amounts. 

Now as I’m sure you’re aware when you are paying off a loan, and this loan is being paid off 

over 180 monthly payments, each month the split of the payment between principle and interest 

varies. Generally speaking the amount of the payment which goes to paying off the principle 

increases and the amount of interest decreases. So what we need to do now is to put in a facility 

whereby we can calculate the split of the payment for each of these 180 monthly payments. So 

what I’m going to do in column E is to put the period number. So that’s going to be period one, 

period two, etcetera. I’m not going to type down there 180. I’m going to use the Fill function. It’s 

a series. It’s by columns. It’s linear. The step value is one. I’m going up in ones. The stop value 

is 180. Click on 180 and I’ll have my 180 periods there. 

The next step is to put in a column that shows principle payment. Now there is a specific 

function in Excel which calculates the principle payment in, in this case a monthly payment on a 

loan. And it’s the PPMT function. So what I’m going to do in here is put =PPMT. So the rate per 

period, remember it’s monthly payments so it’ll be the annual rate in C2/12. The period in this 

case in the first payment there which is going in cell F2. So the period number is actually E2. 
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The number of periods is in C3. The principle value, the PV or present value is in C4. And the 

future value it’s going to go down to zero. So that means that in the first period the principle 

payment will be $609.53. 

So next I’m going to calculate the interest payment. The function I use here is IPMT. This has 

the same arguments. Click on OK and my first interest payment is $500 for the first month. Now 

of course if you add those two together you get the payment which is in C8.  

Now the next step I did as a deliberate error earlier on, we really don’t need to do deliberate 

errors for this kind of thing now because as you’ll already realize although I’m going to fill down 

both of these values to see how the payments varies over time some of those arguments need to 

be made into absolutes. So let’s just bring up the Function Arguments again and check which 

ones. C2, for example, is always going to be C2. As the use of this formula goes from F2 

downwards C2 isn’t going to vary. Now of course the only thing that would tend to vary when I 

go down column F2 is the row number. So technically what I really need to do is to make the 

two part absolute. And if you’re feeling a little bit lazy or perhaps you just want to emphasize 

that you understand what’s going on you really only need to say C$2 because the column number 

is not going to vary anyway. Similarly for Nper, putting C$3 is enough because the C won’t vary 

and similarly C$4. Now if you want to avoid yourself having to think about that too hard you 

could just say for the rate $C$2/12 and for Nper $C$3. They are absolute values.  

So let me just OK that and then I’m going to make the same changes to the arguments for the 

function IPMT in G2. And now I’m just going to fill both of those down. And you notice that in 

the very last payment period the interest payment is only $3.69. Whereas the principle payment 

in the last one is$1,105.85.  

Now just as an interesting little exercise having selected those two columns what about an 

AutoSum? Now hopefully you won’t be surprised to learn that the total amount of principle paid, 

the last figure here down in F182 is $150,000. It would be a bit of a surprise if it weren’t that 

amount. But you can also see exactly how much interest has been paid over the period, 

$49,715.74. 
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Now make sure to familiarize yourself with the list of Financial functions. Many of them are 

very specialized to do with things like coupons and amortization of loans and so on. But there are 

some which you’re going to be able to use in many different situations I’m sure. And one of the 

other very popular uses for these functions is in looking at depreciation of assets. So in the next 

section I’m going to demonstrate a very straightforward depreciation function and then I’m 

going to set you Exercise 03 which is also about depreciation but where things get a little bit 

more complex. 

But that’s enough for this section. I’ll see you in the next one. 

  

http://www.simonsezit.com/


Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

Video: Depreciation 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to take a look at depreciation. And in business in particular if an 

organization buys a piece of equipment it will normally be the case that they will plan for that 

piece of equipment to have a certain life and a certain value at the end of the life. And rather than 

show the cost of the equipment at the point of purchase they will normally write-off the cost of 

the purchase over the life of the equipment.  

Now in order to demonstrate this I’m going to consider we’ve bought a piece of equipment. It’s 

cost $100,000. That’s the figure in C2. And we know that at the end of the useful life of that 

equipment we can count on a salvage value of $20,000. And we expect to write-off that 

equipment over a period of five years.  

Now when it comes to calculating the value of the equipment and in particular the depreciation 

in that value over time there are a number of different ways of calculating depreciation. And the 

simplest way of accounting for depreciation is to use the straight line method whereby basically 

what we say is the amount of depreciation over each of those five years in this case would be the 

same.  

Now of course it’s pretty straightforward mental arithmetic to work out what the depreciation per 

year would be but let’s use an Excel function to calculate that for reasons that will become 

apparent a little bit later on. 

So what I’m going to do is to first of all to calculate the depreciation per year in this equipment. 

And the function I’m going to use is the SLN function. Note there the arguments, Cost, Salvage 

and Life. Let’s use the Function Arguments dialog. The cost well that’s C2. We know that’s not 

going to vary. And the salvage value and the life. Now note one important thing here is that 

because this is straight line depreciation it’s going to be the same amount of depreciation for 

each of those five years. So if I click on OK there you won’t be surprised to see what the 

depreciation figure is. If I fill down that’s it. 
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So let’s now calculate the value at each of those five year ends. Now there’s a little bit of a 

formula challenge here. Now the first one is pretty straightforward because it’s just C2-F2. The 

next one on the other hand is, now that’s going to start to get a little bit messy, isn’t it? So really 

what we need to do for G3 is to calculate the total depreciation so far. So I’m going to replace 

F2+F3 by the sum from F2 to F3 which will be a much better idea. But then that of course would 

cause me a problem if I filled that down because the formula in G4 would be the sum from F3 to 

F4 which is definitely not right. So what I really need here is to fix the start of the range that I’m 

going to sum. So I’m going to say $F$2:F3 in G3. If I now fill that down I get the correct figure. 

And of course I can apply the same principle in G2 as well. So instead of just having F2 there 

what I’m going to have is the sum from $F$2:F2. So it’s only one number that I’m adding but 

then I can apply that, fill it all the way down and there we are. My final figure at the end of year 

five is as expected, $20,000. 

So once again now I have emphasized the use of absolute references. And one particular reason 

for doing that yet again was to prepare you for Exercise 03 which I’m going to present to you in 

the next section. And in Exercise 03 you’re going to apply a couple of different approaches to 

depreciation. So please join me for that. 
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Video: Exercise 03 

Toby: Welcome back to our course on Excel 2016 Advanced.  

It’s time now for Exercise 03 and you’re starting point for Exercise 03 is a slightly enhanced 

version of the last course file that you saw with the figures for straight line depreciation in 

columns F and G. So column F contains the depreciation, G the value at year end.  

And what I’d like you to do is to do the equivalent calculation for two other types of 

depreciation. One of them is declining balance depreciation in columns H and I. that’s not double 

declining balance. That’s declining balance depreciation. And in columns J and K sum of years 

digits depreciation. And I’d like you to avoid, if possible, any intermediate columns or values or 

anything like that. So as with the work that I did on column G in the preceding section make sure 

that all of the work in to calculate the value at year end in each case is in a single formula. 

And here is my answer to Exercise 03. 

One thing to note here in column I, declining balance depreciation. There is a very small 

rounding error there. And if you look for help on the fixed declining balance depreciation 

function you will see that there is a certain amount of rounding that’s done in the calculations 

which explains that relatively slight discrepancy. But you should come out with the same 

discrepancy that I get basically. 

That’s it, Exercise 03. Good luck with that. I’ll see you in the next section. 
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Chapter 8 – Statistical Functions 

Video: Statistical Functions for Description – Part 1 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this and the next few sections we’re going to look at the use of Statistical functions.  

Now Statistical functions are amongst the most numerous in Excel 2016 and many of them are 

used in relation to pretty complex statistics. And because this isn’t a specialized course in 

statistics I’m really going to look mainly at the most commonly used and in some senses most 

basic statistical functions. But if you do have an advanced knowledge of statistics and if you 

need to use statistical functions you’ll find that the ones that are provided in Excel 2016 are a 

pretty powerful set nowadays. I’m looking at the Excel 2016 Help page here and if I just scroll 

down the list of Statistical functions you’ll see just how many of them there are. As usual the 

ones that have been introduced in the current version are marked with 2016. And there’s a batch 

there related to forecasting.  

Now in my coverage of statistical functions I’m really going to divide the functions and their use 

into three main groups. First of all we’re going to look at the descriptive functions. These are the 

functions that you can use to describe a set of results, normally one or more samples of results, 

and where you’re looking at statistics that in some way typify those results or represent those 

results or enable you to compare, for example one sample with another sample. The second set of 

functions are the ones that are used for prediction or forecasting, and that includes these new 

functions that you can see here. And then the third set are the set that are used for statistical 

inference. And these are functions where based on a sample you want to infer something about, 

for example, the population that the sample comes from. These are often functions that are used 

in scientific research, opinion polls and so on.  

Now one point to bear in mind is that as I mentioned just now this is a very long list of functions. 

And a couple of functions here, Quartile.EXE and Quartile.INC. We saw the use of Quartile.INC 

earlier in the course. Don’t forget there is also a function Quartile. And in fact there are quite a 

few statistical functions that are still available in Excel 2016 that have been superseded by the 
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ones listed here. These are kept in Excel 2016 in order to make sure that older workbooks work 

for people. But as far as possible you should try to use the ones that are listed in the current 

Excel 2016 Help on functions. Try to avoid using the older ones because not only is there a 

possibility that the older ones will be taken away at some stage in the future but also the newer 

ones tend to be more accurate, where there is any issue of accuracy. And they tend to be better 

documented and often are easier to use. 

So let’s get started on the descriptive statistics and I’m going to use some data relating to a 

branch of an insurance company. And the data covers a period from January 2012 through to the 

end of December 2015. There’s two columns of numbers. The first column, column B, represents 

the number of enquiries made at the branch over that time. And the second column, Policy, 

shows the number of policies issued in each month.  

Now the data you see here are very typical of a situation where you have a whole mass of 

numbers. And just looking at that very long list of numbers it’s quite hard to deduce anything 

from that list of numbers. You can see that there are generally a lot more enquiries than policies. 

You can see that number of enquiries is often in the range of 400, 500, 600 and the policies 

issued is usually around about 100, 150, maybe a bit higher sometimes.  

But when we’re doing statistical analysis one of the first things we normally do is to calculate a 

few standard statistics that enable us to get a good, basic picture. So let’s look at the typical kind 

of statistics we might calculate. 

I’m going to be using the numbers in columns B and C quite a bit so I’m going to define named 

ranges for Enquiries and Policies. And having set up those names let’s calculate a few 

straightforward statistics.  

We might, for instance, look at the minimum number. Function we’ve used before. Now when 

we use the MIN function note the list of arguments there. I’ve set up a named range now and I 

know that it begins with the word Branch. So if I just start typing what happens of course is the 

IntelliSense will eventually show me my options. Branch Enquiries, Branch Policies. So it’s 

Branch Enquiries that I want, double click, close the brackets, tick to enter. And the lowest value 
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in column B is 418. And of course it’s a very straightforward job to find the minimum number of 

policies and the maximum for each as well. So I’ll do that next. 

Now of course we could do a comparison between the figures for say a couple of branches based 

on these minimum and maximum numbers. But more normally we do a comparison based on 

average measures and measures of spread.  

Now the three main average measures are the arithmetic mean, the median, and the mode. So I’m 

now going to calculate the mean number of enquiries and the mean number of policies. So mean 

number of enquiries. The function we use there is the Average function. And average is 557.646. 

Let’s format that as the nearest whole number. Now the mean number of policies. And again I’ve 

reduced that to zero decimal places. 

Now the next two main average measures are the median and the mode. And just in case you’re 

not familiar with what a median is and what a mode is. Mode is the easiest one. The mode is the 

value that occurs most frequently. So if the number of enquiries per month varies quite a bit as it 

does here, if there’s a particular number of enquiries that occurs most often, say 612 or 

something like that that will be the modal value. In the case of the median, if you imagine putting 

the numbers of enquiries into numerical order, ignore the month, just stretch them all out in 

numerical order smallest to largest the median is the middle one. It’s actually the second quartile, 

as I mentioned earlier in the course. And if you have an even number of values it’s the average of 

the middle two. Now I’m not going to go through the process here of identifying those functions. 

That’s a little extra exercise for you to do. 

So you need to look up median and mode as functions and you need to work out what those 

functions are and then you can check your answer by looking at the Policy_Sales_1 worksheet. 

So there I’ve entered the relevant text and formulae for median and mode. If you tried mode 

yourself you may be somewhat confused by the fact that there are three mode functions. There’s 

the old mode function and the you also have a pair of newer functions, Mode.SNGL, that’s 

single mode, and Mode.MULT which is for multiple modes. Because a sample of data can have 

more than one mode. There can be more than one value which occurs at the highest frequency. 

And in fact for both enquiries and policies here they are multi-modal.  
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Now let’s look at the number of policies. What I’ve used here is the function that you may well 

have used, Mode.SNGL, Mode.Single. But in fact for the number of policies there is more than 

one modal value. And in order to identify these multiple modal values you need to set up the 

formula that’s currently in F17 as an array formula. Now I’m going to assume for the moment 

that you’ve used array formulas before but I am going to run through this example fairly quickly 

just in case you’re a little bit rusty on it.  

So I’m going to clear the formula in F17 at the moment and I’m going to select say half a dozen 

or so cells. And having made that selection I’m going to enter a formula. And because I’ve 

already made a selection which covers more than one cell it will be an array formula. So I’m 

going to put =MODE and it’s the MULT version that I’m going to use. And the array that I’m 

going to look in is of course Branch Policies. Close brackets. Now what I do is to press Control, 

Shift and Enter and I’ll see that there are in fact two values, two modal values. There’s 99 and 

there’s 132. And if you check through the data in column C you’ll see that both of those occur 

three times. Note that having made that initial selection any of the cells in the selection, F17 to 

F24 that are not needed, that don’t contain one of the multiple modes just have an N/A in it 

instead. And of course we could apply the same principle to the modal number of enquiries. Let 

me put that over here. Let me just make that selection, put the relevant formula in. And in this 

case we’ll see that there are actually four modal values, 618, 553, 597, and 454. They are all 

modal values. They’re values that occur with the highest frequency. 

So having looked at some of the most important functions for calculating averages in Excel 2016 

the Average function in particular, the one that calculates the mean has a couple of variants that 

can be very useful. And one of them is Average If whereby you can apply one or more 

conditions and find the average of a set of numbers subject to a set of conditions.  

Now the enquiry and policy figures we have here cover the period January 2012 through to 

December 2015. What if I said what’s the average number of enquiries in the second half of 

2015? So what I do in this case is I say =AVGERAGEIF. Now first of all I need to specify the 

range of values that I’m going to test for a condition. Now in this case it’s the range of dates so it 

is A4 through to A51. Now we specify the criteria. In this case the single criterion we’re going to 

apply is that we’re talking about enquiries during the second half of 2015. So it’s going to be 
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from July 1st onwards. So that’s greater than or equal to July the 1st 2015. Now of course 

depending on your locale you may need to switch the day and month number there. 

And then finally which are the values we’re going to average? What will the values that we 

identify by the branch enquiries name? And let’s see what we get. We find that for the second 

half of 2015 the average number of enquiries per month is just over 461. 

And it’s worth noting that there is another arithmetic mean function, AVERAGEIFS which 

enables you to specify multiple criteria. 

Just the last thing I’d like to mention here before we move onto measures of spread in the next 

section. If you, for example, take this list of policy sales starting at C4 and select just down to the 

bottom here, when you release the mouse don’t forget the Quick Analysis option here. If you 

click on Quick Analysis you have of course a good range of options there. Formatting, Charts, 

etcetera. But if you click on Totals, Totals include Average, for example. So some of the basic 

statistics that you might be interested in can very quickly calculated by reference to the Quick 

Analysis facility there. 

So that’s it on averages for the moment. In the next section we’re going to start looking at 

measures of spread. So please join me for that. 
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Video: Statistical Functions for Description – Part 2 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In the preceding section we looked at some averages in relation to statistical samples. And in this 

section we’re going to look at measures of spread.  

Now in order to do an analysis of a statistical sample or indeed to do a comparison with another 

statistical sample it’s pretty much always necessary not only to have some kind of averages to 

give you an idea of how big or how long or how many of something are associated with that 

sample but also to have a good idea of how spread out the values are, how much variation is 

there in this sample.  

Now in statistics in general there are quite a few very useful measures of spread and we’re going 

to look at the main ones in this section and we’re going to look at alternatives for calculating 

them in Excel 2016. 

Now as part of that I’m going to need to explain one or two statistical concepts and terms. But 

I’m going to do that in a pretty straightforward kind of way, I hope. So if you’re not very 

comfortable with statistics I think you should still have a pretty good idea of what’s going on in 

this section. 

So what I’ve done already is to calculate the median number of enquiries and policies. And you 

may recall the way that we calculate the median is that we put, for example, the number of 

enquiries per month in numerical order, not in order of month, numerical order. And we looked 

for the one that’s in the middle. If there are two in the middle, so we’ve got an even size sample, 

we take the average of the middle two. Now if you did that with the contents of column B, B4 

downwards, you would find that the median is 574. But of course we used the Median function 

in Excel 2016 to do that for us.  

Now I also mentioned at that time that apart from taking that middle value we could identify the 

quartiles. And the quartiles lead us to a very good measure of spread. So what I’m going to do 

now is to calculate the quartiles for the number of enquiries and the number of policies. 
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I also mentioned earlier on that there are actually two quartile functions. Now there’s 

Quartile.INC and Quartile.EXC. And in a moment I’m going to explain the difference between 

those. I mentioned it earlier but I’m going to give you a very quick demonstration of it in this 

section. 

But for the moment let’s just calculate quartiles and let’s start with the use of the Quartile.INC 

function. 

So we’re using Branch Enquiries and the minimum value, the zeroth quartile we’ll put a zero 

here in the quartile number. Click on OK and we’ll get 418. All I need to do then for the first 

quartile is to repeat that, identify the same name for the range of enquiry values and change the 

quartile number to one and so on. So I’ll do that next and we’ll see where we get to. 

So there are the five quartile values. If we put our enquiries in sequence, the first 25%, the 

smallest 25% will be between the zero and first quartiles, between 418 and 493, etcetera.  

Now the quartiles are very commonly used in statistics and the measure of spread that we can 

derive from there is called the Interquartile range. And we calculate it as the difference between 

the first quartile and the third quartile. There is an additional measure of spread which is called 

the semi or semi-interquartile range which is half of the interquartile range. So I’m going to 

calculate the interquartile range and the semi-interquartile range and I’m also going to put in the 

quartiles for policies.  

Now of course when you open this file in the course files folder you’ll see all these formulae and 

so on, but at this point in the section you may want to try these out for yourself. 

So having completed those calculations, including the quartiles for policies, I’ve also calculated 

the interquartile range and semi-interquartile range for policy sales. And if you’ve been working 

along with this you should have come up with the same figures as the ones that I’ve got there. 

So the use of these ranges is pretty popular in statistics and I’m going to come back to those a 

little bit later in this section. Before I move on to talk about what is probably the most important 

measure of spread I want to just spend a moment talking about INC and EXC as I said I would. 
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So within the Policy_Sales_3 workbook I’ve included a worksheet IncExcDemo. And this is a 

very straightforward demo of the difference between Inc and Exc.  

The data that we’re finding the quartiles of are in B2 to I2. So the smallest number is 23. They’re 

actually in numerical order. And then in rows 4 and 5 I’ve got the quartiles calculated using 

Quartile.INC and the quartiles calculated using Quartile. EXC. The most notable thing is that if 

you use Quartile.EXC, so for example that’s the formula in cell C5, the quartile value of zero is 

actually invalid. There isn’t a zeroth quartile this way. There isn’t a fourth quartile this way. And 

in fact the remaining values and remaining quartiles are calculated in such a way that although 

the median is the same as with Quartile.INC generally speaking the first quartile and the third 

quartile will be smaller and larger respectively and therefore that will give a larger interquartile 

range.  

Now I’m not going to go into the reasons for these differences. In fact there are many, many 

other ways of calculating quartiles. It’s quite unbelievable really that people have come up with 

so many different ways because it seems like a pretty straightforward thing. But there are a 

couple of pretty good explanations of how these two methods work and if you search the work, if 

you Google Quartile.EXC, Quartile. INC there are a number of papers that discuss the difference 

between these and these in turn often lead to statistical papers that’ll explain the differences 

between them. 

Now during the balance of this course when I need to use quartiles I’m going to use 

Quartile.INC. And whenever I use them in practice in real life I tend to use Quartile.INC as well. 

But as I say, there are other methods that various people use. And if you’re really very interested 

in quartiles and how to calculate them then there are a number of papers as I say that discuss the 

various methods. I’m going to leave this particular issue here for the moment and just going to 

say that I’m going to be using Quartile.INC where I need to from now on. 

Now the quartiles, the interquartile range, etcetera are very important in descriptive statistics. But 

very often in statistics not only are we wanting to describe a sample but we want to use the 

values in the sample, the data that we can derive from the sample to perhaps predict what’s going 
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to happen in the future. Maybe to calculate some properties of the population that we’ve sampled 

from or maybe to infer something else rom that sample. 

Now in order to do that there is an even more important measure of spread which is called 

Standard Deviation. And there is also an associated measure of spread that’s the square of the 

standard deviation and that is called the Variance. Now in this section I’m going to concentrate 

on calculating Standard Deviation. 

Now just to confuse matters a little when you want to calculate Standard Deviation there are 

really two options and it’s very important to understand the difference between them. If I take a 

sample such as the number of enquiries over several months in this branch and I work out the 

standard deviation of this number of enquiries which is a measure of how much the number 

varies then I can either calculate that standard deviation as the standard deviation of the sample 

or I can calculate it in such a way that I’m trying to estimate the standard deviation of the 

population that the sample has come from.  

So let’s suppose you were working on a production line in a factory and you were measuring the 

length of objects you were making or the weight of objects you were making. If you say took ten 

objects off of the production line you might either say what’s the standard deviation? How much 

do these vary? Or you might say using the values from these ten what’s my estimate of the 

amount of variation in the underlying population? Now using the correct one of these from a 

statistical point of view is very important. And in Excel 2016 there is a function for each. 

If you want to find the standard deviation of a sample itself the function you use is STDEV.P. 

And that’s that one. And all you would need to do in this case is to specify the name of the range. 

So it’s Branch Enquiries. And that’s the standard deviation. Let’s just roll that down to a couple 

of decimal places.  

If on the other hand I want to calculate this standard deviation and use it as an estimate of 

population standard deviation I use STDEV.S. And STDEV.S will normally give a larger value 

for the standard deviation. So that’s the estimate for the population.  
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Now in statistics in different situations you may want one or other of these standard deviation 

values. Let me just calculate the same for policies. So there we are. That’s the calculation of 

standard deviation of the sample and then the calculation of the estimate of population standard 

deviation. 

Let’s now take a look at a specific example of how we may use these descriptive statistics. I now 

have two sets of sales figures. The first set, columns B and C, are for the Orlando branch. The 

second set, columns D and E, are for the Tampa branch. And in each case I have details of the 

number of enquiries and the number of policies as before. And if you quickly glance down the 

list you definitely get the idea that Orlando does quite a lot more business than Tampa but it 

would be very helpful to be able to actually put some solid figures, some solid evidence together 

about the difference in the amount of business that they do. 

So what I’m going to do is to calculate the mean over the allotted period for both branches and 

I’m going to work out a standard deviation and I’m going to work out the interquartile range. 

And here you can see the results of these various calculations. I suggest you take a look at 

Policy_Sales_5, make sure you’re familiar with the formulae that are in use here. If you really 

wanted to do an analysis of one of the branches results and in particular if you wanted to 

compare the two branches there are various statistical techniques that you could apply. But just at 

a very, very sort of superficial level if you look at the mean values for example you can see that 

generally speaking on average Orlando has about twice as many enquiries and about as twice as 

many policies issued as Tampa. Having said that whereas with Orlando the number of enquiries 

compared to Tampa is well over twice, the number of policies is less than twice as many as 

Tampa which sort of implies that Tampa although it’s a branch dealing with less enquiries and 

less policies they seem to be more successful at turning their enquiries into policies.  

The other thing to note is if you look at the level of spread in the case of the standard deviation 

of enquiries at Orlando it’s 64½ whereas with Tampa it’s 49¼ roughly. And given that for 

enquiries there are well over twice as many enquiries in Orlando there are in Tampa there seems 

to be relatively speaking more of a spread in the Tampa enquiries compared to the actual number 
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of enquiries. And the same is true of policies as well. But as I say, that’s a fairly sort of 

superficial and non-statistical analysis of these results. 

It’s also interesting to compare figures like the semi-interquartile range in each case with the 

standard deviation. Although as I mentioned earlier on in the section in terms of formal statistical 

analysis standard deviation is a measure of spread that is used more frequently than interquartile 

range or semi-interquartile range.  

So that’s it on the use of statistical functions for description. In the next section we’re going to 

look at forecasting. So please join me for that. 
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Video: Statistical Functions for Forecasting – Part 1 

Toby: Welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to look at functions for forecasting. 

Now very often when we’re talking about forecasting we’re going to be talking about looking at 

what is going to happen based on what has happened so far. But also the functions that we’re 

going to be looking at can work in a more general sense as well. And I’m going to look at that 

more general sense in this first section because I want to look at a few of the most commonly 

used function without implying that these functions are only used in relation to things that 

change with time. Having said that, quite a few of the examples that we’re going to look at will 

involve variables that change over time. 

So let’s start off in a fairly general sense. I’ve got here in columns B and C some values of two 

variables, X and Y. And if it helps you to think of the contents of column B as the months of the 

year and the contents of column C as say sales in a store of a particular object then that’s 

probably quite a good way of thinking of those two columns of figures.  

And just to give you a good idea of what I mean by forecasting the question is this. Given those 

values in X and Y what value of Y would I get if X were 13? Now you might look at the figures 

in column C and say, “Well I don’t really know.” The values of Y tend to be going up but they 

don’t go up in a sort of straight and even fashion. And what we need to do is to find a function 

which will predict, forecast, a value of Y when X is 13. Now there are many possibilities here 

and what I want to do first of all is explain what I mean by independent and dependent variables. 

And in this instance X is an independent variable and Y is a dependent variable. What we mean 

by that is that X is something that we can control or we can measure directly or we can predict 

absolutely. So I didn’t have any trouble putting 13 in B15 because X, the independent variable, 

the one that doesn’t depend on something else is clearly progressing in an even fashion. 1, 2, 3, 

4, etcetera. Whereas Y is not proceeding in an even and predictable fashion. Now there may be 

some dependence of Y on X and certainly it appears to be the case that as X get bigger Y gets 

bigger but it doesn’t necessarily mean that the increase in values of X is causing the increase in 

values of Y. 
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So let me first of all just plot a little graph of X against Y for the known values. And there we 

are. That shows you the figures for X and Y. And if I were to try to predict a value for X=13 one 

of the ways that I might do this, and this is a method that you may have seen used in statistics 

before, is to look at the existing graph and try to work out what that relationship is. So we try to 

model the relationship between Y and X. And one of the most common ways of doing this is to 

look at all the known values and to draw a straight line which basically cuts through the middle 

of that graph and use that straight line to predict a value when X=13 in this case. And that’s what 

we’re going to do in just a moment. But before we do that I’d just like to emphasize something.  

The forecasting that we’re doing here, the prediction, often called the regression that we’re 

performing here, is of one dependent variable, in this case Y, against one independent variable, 

in this case X. But in fact within Excel 2016 there are facilities for performing this regression 

using multiple variables, both multiple independent variables and multiple dependent variables. 

So we’re really only looking at the most straightforward case, although to be fair the most 

straightforward case is the case that is used by most people most often. So a straightforward 

relationship between one dependent variable and one independent variable is a very important 

situation to know how to deal with to begin with. 

So let me just delete my chart for the moment and let’s go back to my numeric values and work 

out what values to put here when X is 13. 

 Now we’re going to actually look at three different ways of doing this and each of them are 

valid and hopefully all three different ways are going to give us the same results. 

And the first way we’re going to look at it is I’m going to take you back to your high school 

mathematics, your high school math, and talk about the equation for a straight line. Now the 

equation for a straight line you may remember is Y=MX+C. And there are two functions in 

Excel 2016 that can calculate from a set of values, XY pairs, the values of M and C that best 

represent that set of XY pairs. The first of those functions is the Slope function. And this will 

give us a predicted value for M. So I’m going to calculate the value of M in E4 and I’m going to 

use the function Slope. And you notice there that it has got two arguments, known Y’s and 

known X’s. Well of course we could set up a name here but I’m just going to put in for the 
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known Y’s we’re talking about C3 to C14. And then I put in the known X’s as well. Let’s use the 

dialog. Okay. There’s my value for M. And then to find the value of C I use the Intercept 

function. And that function has the same arguments. So if I wanted now to work out a value of Y 

when X is 13 all I would need to do is to put in here =M, that’s going to be E4, times, X which is 

B15, plus C, which is E5. So my predicted value is that. Let me just reduce the number of 

decimal places. So there we are. The predicted value is 127 using that method. 

And let me just predict a little bit further on. Let’s say we’re going to predict five values. So I’m 

going to fill down here and they’re my predicted values. And if you make at least a mental note 

of those you can compare them with the values we’re going to get using the next approach. 

Now when I said that I’m going to show you three ways of doing this the second way is different 

but actually amounts to doing exactly the same thing as the first way because in Excel 2016 there 

has been for some time a Forecast function which actually performs the same linear regression, 

the same straight line fitting to the available X and Y pairs that we’ve just done by calculating M 

and C for the best fit line, Y=MX+C. But this function Forecast bundles the whole operation into 

a single function. 

Now in Excel 2016 that single function Forecast has been superseded by a more specific 

Forecast function called Forecast.Linear. but Forecast.Linear basically does what I just 

described. It forecasts values of Y based on known X and Y on the assumption that there is a 

linear relationship between X and Y and you’re using best fit against the existing X and Y pairs 

that you know. 

So in C15 what I will type is Forecast.Linear and in this case what I put is first of all the X value. 

In this case that’s B15. Then the known Y’s, then the known X’s. Okay let’s see what we get for 

C15. Well hopefully that’s no particular surprise. Let me fill down. And of course we finish up 

with the same values. 

The third option I’m going to look at is the use of the Trend function which we use an array 

function and therefore we apply an array formula. So if I want to predict values from C15 to 

C19, so that’s Y values corresponding to X=13 up to X=17. If I select the range of Y values that 

I wish to calculate and use the Trend function, the Trend function uses a set of known Y’s. So in 
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this case a set of known X’s, the new X’s. So this is all the X’s that I want to calculate. So that is 

basically B15 to B19. And then we have a value, a constant value B. Now sometimes if you’re 

fitting a line to some data is a requirement that the intercept, the C in the case of Y=MX+C is a 

zero. Now if you want it set equal to zero then you would set this final value to false. But if you 

want it calculated in the normal way as an intercept you set it to true. And then of course because 

this is an array formula in order to complete that I do Control-Shift-Enter and there’s my full set 

of values. And hopefully you’re not too surprised to see that they are the same values. 

So there are three options for doing straightforward linear regression with a single independent 

variable and a single dependent variable. 

In the next section we’re going to start to look at some more powerful functions that can not only 

do this type of prediction for us but can also tell us how strong the relationships that we are using 

as the basis of prediction are. I’ll see you then. 
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Video: Statistical Functions for Forecasting – Part 2 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to continue looking at forecasting using linear regression. But in this 

case we’re going to use the LINEST function.  

Now the LINEST function offers a number of advantages and the first of them I’m going to 

concentrate on are one, not only can it forecast values for us but it can also indicate how likely it 

is that those forecasts are going to be good forecasts. It does this be evaluating how close the 

model that it’s using is to the observed values that we’re providing it with. The second main 

advantage is that the LINEST function can be used in multivariate regression.  

In this section I’m going to demonstrate LINEST with a single independent variable and a single 

dependent variable. And then in Exercise 04 which is covered in the next section you’re going to 

do some multivariate regression, but don’t worry too much about that at the moment because 

hopefully you’ll find it more straightforward than it may sound. 

Now on the very subject of it being perhaps a little easier than it sounds, although I’m going to 

explain quite a few aspects of this as we go along I’m also going to refer you to a page in the 

Excel 2016 Help that explains what’s going on in quite a lot of detail. Now if you’re not really 

particularly interested in statistics or perhaps your math, you math is not really up to scratch you 

really don’t need to worry too much about all these details. All you really need to be able to do is 

to apply this method and the Help sets out pretty much how to apply the method. I think of it 

sometimes in terms of driving the car. You can see how fast you’re going without necessarily 

knowing exactly how a speedometer works. 

Now referring back to the preceding section the first method that I showed you there involves 

finding the slope and intercept for the best fit straight line through some pairs of values. And 

pretty much that’s what LINEST does as well. It gives you a slope and an intercept. But it can 

give you multiple slopes based on the use of multiple variables. So I could have, for example, a 

number of independent variables and there would be a slope associated with each of those. 
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Now when we actually use the LINEST function we apply it in an array formula and before I use 

it I need to know how many rows and how many columns I need to select. Now the number of 

columns will be the number of independent variables plus one. So in this case X is my 

independent variable and therefore I need two columns. The number of rows I needs, well I’ll 

need one row for the slope values and then if I want all of the additional underlying statistics, 

some of which I’ll explain later on, I need four rows for those. I am going to look at those 

statistics so I’m going to need a total of five rows. One for the slope and four for the statistics. So 

I need to select an area which has two columns and five rows. So that’ll be it. Now I’m going to 

enter the LINEST function. 

Now the first value that goes is in the known Y values. That’s C3 to C14. Next I put in the 

known X values. The third value is the one we talked about in the previous section and if we 

expect to have a non-zero intercept we set this to true. Well that’s the case here as well so that 

will still be true. And then the fourth argument indicates whether we want the additional 

regression statistics or not. Now we are going to look at those additional regression statistics so 

that’s going to be true as well. Having entered LINEST and bearing in mind that this is an array 

formula it’s Control-Shift-Enter and there are my values. 

Now the first thing to note is that E3 and F3 hold the slope and intercept. So if all I want to do is 

to predict the value of Y when X is 13, etcetera I can use one of the methods that I showed you 

in the preceding section. And once again the same values have been predicted. But what’s 

particularly helpful and useful here are the other values, the ones in the range E4 to F7. And in 

order to understand particularly the contents of E5 we’re going to look at the Help on the 

LINEST function. 

Now there are quite a few things that I want to point out about the LINEST function because it’s 

a very important function in Excel 2016. And the first thing to point out is that you can use it 

with other functions to model relationships that are not straightforward linear relationships. So as 

it says there you can include polynomial, logarithmic, exponential, and power series 

relationships. Now this has to be done in a particular way and there’s more information about 

that in this Help topic. I’m not going to cover that on this course. But you may well be in a 

situation where you have a relationship which is not a simple linear one, where there is some 
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element of it that includes one of those other types of relationship. Well LINEST can cope with 

that kind of situation as well. 

Now in the preceding section we looked at the straightforward Y=MX+C. It’s normally denoted, 

although in the Help here it’s Y=MX+B but B is the intercept. Well the situation with LINEST is 

that you can make Y dependent on many X’s. And if you do make it dependent on many X’s 

then for each X there will be a slope. So for example, in Exercise 04 I’m going to give you some 

data with two independent variables in it, two X’s, and you’ll get two slopes. But more on that a 

little bit later on. 

Now when you use the LINEST function, I’ve already talked about the syntax and you’ve seen 

one use of it already. There’s a further explanation there. And particularly it there covers an 

explanation of the multivariate situation which is going to be particularly important in Exercise 

04. 

Now there’s a list of statistical terms and many of these are ones that are familiar to statisticians 

but probably a mystery to most other people. So terms like the F statistic or the number of 

degrees of freedom. If you are a statistician or you understand these terms they are pretty well 

explained there and related to that block of numbers that I referred to back in our sheet, 

Regression_Functions_4. But the one I really want to look at here is that one in particular, r2, a 

coefficient of determination.  

And what happens with the coefficient of determination is that it compares estimated and actual 

Y values. Now the closer to one r2 is the better the correlation. And by correlation we mean in 

simple terms how well the line that we’ve fitted fits the provided data. If the provided data was 

an absolute straight line already then the coefficient of determination would have a value of one. 

If all of the values seem completely random and unrelated the coefficient of determination will 

have a value of zero or close to zero. So what you’re looking for for a good match is a value that 

is near one.  

Now with these other statistics you may or may not be interested in them. The sum of squares, 

the regression sum of squares. That’s an interesting one. Again I’ll come back to that in a 

moment, just for information because that’s I think a useful thing to know about. 
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But in terms of identifying what is what in that array of numbers this little diagram is the 

important one because it shows you what goes where. Now in our case we only had one 

independent variable. So we only had two columns. And column A in that little diagram, that’s 

our slope value in row 1. And the value in the third row in column 1 is r2. Now below this 

there’s a whole load of remarks about how all this works, how you can interpret things and so on. 

If you are interested it makes a very useful and interesting read. And then there are quite a few 

examples as well that might well be useful to you to work through those as well. But let’s look 

again at that diagram because what we’re interested in is the first column, middle row. 

Now the value we have there is 0.89. And a value of 0.89 is pretty good. That’s a relatively high 

correlation. So what we’re being told there is that that does seem to be a reasonable relationship 

between the Y values and the X values. It’s not brilliant but it’s about 90% which is pretty good. 

Now there’s one point that I said I would come back to and that is this sum or squares. I’m not 

going to explain this in great detail. There’s actually quite a bit of detail on that Help page. But 

one relatively straightforward way of thinking how this works is as follows. 

If you look at each of our X values here, 1, 2, 3, 4, along the horizontal axis and with each of 

them go up to the graph and the dotted line which is the best fit straight line, for each value of X 

you will see there is normally a slight discrepancy between the value on the blue line which is 

the observed Y value and the value on the dotted best fit line. If you work out what the 

discrepancy is between the Y values, so that’s the blue line and the dotted line, and you square 

that amount and you add all of those discrepancies up the way that the line of best fit is worked 

out is to make the sum of those squares as small as possible. So you’re basically working out 

how to fit a straight line through those points such that the sum of those squares is as small as 

possible. And that’s how that dotted line finishes up where it is.  

Now that’s a somewhat oversimplified explanation of it but it’ll give you some idea of how that 

best fit line is arrived at. And it’ll also explain how, for example, this coefficient of 

determination is calculated because it’s calculated using a formula based on that sum of squares.  

Now in fact in all of the documentation, including the Help page, you’ll see that sum of squares 

referred to as r2 in various places. Statistically it is more accurately referred to as r2 and in the 
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case of linear regression, standard linear regression with an intercept on the Y axis in this case 

and so on r2 is actually the square of the correlation coefficient. So you may have heard of a 

correlation coefficient as well. And basically you want r2 to be as close to one as possible.  

So that’s it on LINEST in this section. Exercise 04 is next. I’ll see you then. 
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Video: Exercise 04 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section I’m setting you Exercise 04. And in Exercise 04 you’re going to do some 

multivariate linear regression.  

There are two independent variables, month and rainfall. They’re in columns B and C. And in 

column D we have the dependent variable, the number of umbrellas sold in a store. 

So basically what I need you to do is to use the LINEST function to come up with a prediction 

for how many umbrellas will be sold in months 13, 14, 15, 16, and 17 dependent on the rainfall 

figures for those months that you can see in column C.  

My answer for that is in the workbook Exercise 04 Answer. As you can see I have a coefficient 

of determination there of 0.87, about 87% which is pretty good. 

One thing I didn’t mention earlier on in the course which is really quite important. When you are 

creating the array to put the array formula for LINEST into it doesn’t matter if you select an area 

that’s too big because any cells that LINEST doesn’t need or use just get N/A’s put in them. So 

although you can calculate as I explained in the course exactly what area you need, in this case 

I’ve selected F3 to H7. If you select an area that’s too big it really isn’t a problem.  

So that’s Exercise 04. With a bit of luck you’ll finish up with the same predictions as me for the 

number of umbrellas sold. I’ll see you in the next section. 
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Video: One Click Forecasting 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to look at one of the new features of Excel 2016 and this follows on 

rather nicely from our sections looking at forecasting because the new feature is what’s called 

One Click Forecasting. Now in fact it’s not really one click forecasting. It takes a few clicks but 

it is a pretty impressive, fairly straightforward facility for forecasting time-based data. And what 

I’m going to do in this section is to give you a quick run through of a straightforward example 

and also refer you to this particular page on Office.com which runs through the main features of 

this One Click Forecasting. 

So first of all let me just emphasize the point that this is intended for time-based data. And in 

theory the dates for the data, you can see in column B there in the sample that I’m going to use, 

the dates should be evenly spaced. So I’ve got January 1st, February 1st and so on. And these are 

sales figures. And for each date there, so for instance for February 1, 2015 the sales figure in 

column C is the total of the sales for the preceding month. So you can see that over time sales for 

this particular company are increasing.  

Now this is typically of the sort of the data that we were using earlier on of course for doing 

forecasting but with One Click Forecasting you can get an awful lot of information with a very 

small amount of effort. 

Now I talked just now about these dates being evenly spaced. These are spaced out month by 

month. You can actually have gaps in the data. They need to be fundamentally evenly spaced but 

you could have say a month or twos figures missing. In fact you can have up to 30% of the data 

points missing and this will still generally do a pretty good job. 

So let’s do a run through now of One Click Forecasting with that data. You note the last month 

that I’ve got there, June the 1st 2016. Let’s aim to forecast sales up to the end of August. So 

we’re looking at a sales figure on September the 1st 2016, a date that has just passed based on 

when I’m recording this.  
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So first of all let me select the data and now on the Data tab in the Forecast group there is a 

Forecast Sheet option and that brings up a dialog, the Create Forecast Worksheet dialog. Now 

you have a couple of basic choices to make here. One of them is whether you want to see a line 

graph or a column chart. And basically if you look at the column first the blue columns indicate 

the actual data and the orange columns here denote the forecast values. You can probably just 

about make out the little vertical lines for the top of each column which indicates the range in 

which the forecast values might fall. And in fact if I go back to the line graph you can see this 

sort of funnel effect here, the lower and upper thinner lines there representing the lower 

confidence bound and the upper confidence bound for the forecast sales. 

Now I said just now that I’m going to forecast up to September the 1st. So I’m going to set the 

end date for the forecast here. And then I also have a number of other options. Let’s take a look 

at those other options. Click here. 

So I’ve already set the forecast end date. I can set the forecast start date. By default it’s using the 

final date in my actual historical data. It’s well worth reading the notes on that webpage that I 

referred you to about forecast start date because there can be some advantages in starting the 

forecast for a date before the end of the historical data and then you can see how well those 

predictions match your actual measurements. And of course they should match them very well. 

Having said that, obviously if that reduces the number of historical data points that you’ve got 

then that may in turn harm the prediction. So it’s a matter of achieving a balance based on the 

amount of historical data that you have. 

The confidence interval is next. You can switch this off. If you look at the line graph while I do 

that there’s now no confidence interval. What that confidence interval means in this context is 

that 95% of predicted values will fall within that sort of funnel, that confidence band there. If 

you reduce that percentage then you would find that the band would get narrower and narrower 

and narrower. And that with a narrower band to aim at less values would fall within the predicted 

range. 

Next important option is seasonality. If you’re dealing with seasonal data then you can either tell 

Excel 2016 to detect seasonality or you can set it manually. Now what we mean by seasonality, 
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for example, is if we’re dealing with monthly data and that over the course of a year there tends 

to be a monthly pattern then we would consider our cycle in this case to be a year and the 

numbers in that cycle to be twelve. So we would manually set a value of twelve for seasonality. 

On the other hand on a yearly sales cycle if you believe that you basically follow the four 

seasons of the year you might set that value manually to four instead.  

Generally speaking when it comes to detecting seasonality you really need at least two complete 

cycles of that to work successfully. Obviously in this case we’ve only got 18 months worth of 

data so its ability to detect seasonality is going to be severely restricted. 

Finally on the left hand side of the options we have Include forecast statistics. If you check this 

box in the resulting forecast worksheet you’ll have a lot of very technically advanced statistics. 

So if you’re not a statistician and you’re not particularly keen on dealing with things like 

exponential smoothing algorithms and so on then you may want to bypass the forecast statistics. 

But if you are interested check that box and you’ll get some very interesting statistics on the 

forecast worksheet as well. 

On the right hand side of the options you’ve got the timeline range and the values range and then 

again two more important options. If you have missing points, so I mentioned you might have 

some data missing, you can either ask Excel to interpolate those values. So if you say had a 

month’s worth missing it would look at the values either side of the missing month and work out 

its best guess at what the missing month would have said or you can replace them by zeros. And 

obviously in the case of our sales replacing by zeros really would confuse things. But there are 

situations where you’re measuring over time where replacing a missing value with zero may be 

more appropriate. In this case we’ll stick with interpolation. 

And then finally you can in some situations have multiple readings on the same date. And this 

might, for example, happen in meteorology where you’re taking measurements of rainfall in 

different sources. In that case where you have multiple values for the same date you can average 

the values, which is the default, or you can process them in any of these ways. So you could, for 

instance, use the maximum or the median or the sum. We’ll stick with the default of average. 

Then we’ll click on Create. 
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And there we are. As I mentioned before you couldn’t really call it one click forecasting but it 

didn’t involve many clicks and you get not only that nice graph but you get a table showing the 

historical data and the predicted values. Note the first forecast is for June the 1st which is also of 

course my last historical point and then you have values in the lower confidence bound and the 

upper confidence bound as well. Note that the contents of this sheet which becomes the first 

sheet in the workbook can also be formatted in the normal way. So if I wanted to do some work 

on that chart I could select it and I could do all of the normal kinds of formatting, exercises on it 

perhaps to use in a presentation, for example. 

That’s it on One Click Forecasting. We just have one more section now on statistical functions 

and we’re going to look at statistical functions for inference. Please join me in the next section 

for that. 
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Video: Statistical Functions for Inference 

Toby: Welcome back to our course on Excel 2016 Advanced. 

So far in these sections on statistical functions we’ve looked at descriptive statistics where we 

summarize statistical data and we’ve looked at prediction, forecasting, trying to work out what’s 

going to happen on the basis of what has happened in the past. Well in this final section we’re 

going to look at statistical functions for inference. And typically when we’re talking about 

inferential statistics we mean that we take a sample of some sort and on the basis of that sample 

we make statements about the population from which the sample has been taken.  

Now I’m going to base this section on a very straightforward example. And in this example a 

doctor’s practice have taken the heights of a number of female patients. The heights are shown in 

inches in column B there. And what we’re going to do is to use that sample to infer some 

properties of the population from which the sample was taken. And also to infer the likelihood of 

women having particular heights within the population from which the sample was taken.  

Now in doing this I’ll be making quite a lot of assumptions and if you have a reasonable 

knowledge of statistics you may be familiar with some of those assumptions and some of the 

issues that arise. But one of the main assumptions I’m making is that given this particular 

doctor’s practice and the area that it covers that sample is big enough to represent the population 

of all female patients. We mean by that adult female patients.  

And a second major assumption that I’m making is that within the population as a whole the 

heights of adult females are normally distributed. So that’s the familiar bell-shaped curve for the 

distribution of heights. 

Now particularly if you don’t have a solid background in statistics you may listen to both of 

those assumptions and say well how can you be certain that those two things are true? Well there 

is very rarely certainty when you’re dealing with statistics but there are tools and techniques that 

we can apply in a situation like this one to establish with a sufficiently high level of certainty that 

both of those assumptions are true. And although I’m not going to go into those now we’re going 

to proceed on the basis that both of those assumptions are reasonable. So, so this is a big enough 
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sample to represent the population and the population from which these heights have come, the 

heights of adult female patients within the range of this doctor’s surgery are indeed normally 

distributed. 

Now the sort of question I’m going to ask is this. What proportion of females within the range of 

this doctor’s practice would be less than five feet tall on the basis of the sample data there? Now 

we’re going to use one of the other statistical functions to do this. And in order to apply that 

statistical function we’ll need the mean and standard deviation of this sample. So you know how 

to calculate those but I’m just going to do those again. So there’s the mean.  

And for the standard deviation we’re dealing with a situation where we’re going to use a sample 

to estimate the standard deviation of the population from which the sample was taken. So we 

need to use the STDEV.S function, as I explained earlier on in the course. So there we are. I’m 

going to reduce both of those to two decimal places. So there are our mean and standard 

deviation. 

Now we’re going to calculate the probability that a woman chosen at random from this 

population will be less than five feet tall.  

Now the function that we’re going to use to calculate this is one of the normal functions. And if 

you look at the list of normal functions there are actually eight of them. And the first four are the 

ones that we normally use now, whereas the old four, the ones with the little yellow triangles you 

can see there are the ones that they replace.  

Now the function we need is the very first one, NORM.DIST. And we specify first of all the 

value of X, the value that we want to find the probability that a member of the population chosen 

at random will be less than. And that will be five feet which is 60 inches. The mean height is in 

E2, the standard deviation is in E3 and that just leaves us with two options, true or false. True 

uses the cumulative distribution function and false uses the probability mass function. Now 

there’s a very important distinction between these two and the true, cumulative distribution 

function, is the one that we use for continuous variables like height. If we were dealing with a 

discrete variable where you could have exact values, so these are things that are counted rather 

than measured, we would specify false here. And there is quite a detailed and complex argument 
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about whether discrete variable can be normally distributed anyway. But in our case this is 

definitely a continuous variable so we need the cumulative distribution function. So the value we 

need here is true. Let’s enter that and we find that on the basis of our sample the probability that 

a woman is less than five feet tall is 0.02 which is 2%.  

So 2% of women within the range of this doctor’s surgery will be less than five feet tall. Just as 

an item of sort of technical information, with a continuous variable like height as far as statistics 

is concerned the probability of being exactly five feet tall is zero. So if you said what is the 

probability that woman is less than or equal to five feet tall it would be exactly the same figure. 

So that’s the probability that a woman is less than five feet tall. What about the probability that a 

woman is more than five feet tall? Well given that all women will be either less than or more 

than and ignore the equal to for the reasons that I just said then if 2% of women are less than five 

feet tall 98% must be more than five feet tall. So expressing this as a probability, a number 

between zero and one the probability that a woman is more than five feet tall is actually 1-E5. 

0.98 as you would expect.  

So on the basis of one probability, probability less than, we can work out probability greater 

than.  

What about the probability that a woman is less than six feet tall? So we’re going to use that 

same function again. This time the X value is six feet. That’s 72 inches. And we find that 95% of 

women are less than six feet tall and of course you know now how to work out the probability 

that a woman is more than six feet tall. But what about the probability that a woman is between 

five feet and six feet tall. Well the way that we work out probabilities between two values is by 

subtracting one from another. If we know that 95% of women are less than six feet tall and 2% 

are less than five feet tall then the number between those two will be the 95% figure minus the 

2% figure. So the probability that a woman is between five feet and six feet tall is going to be 

equal to, it’ll be the probability that a woman is less than six feet tall which is E8 minus the 

probability that she’s less than five feet tall which is E5. And that gives us a figure of 0.93, 93% 

of women are between five feet and six feet tall. 
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Now there is a different sort of question that we can also answer using these functions. And the 

question I’m going to ask this time is what is the height that 25% of women are less than? In 

other words what is the woman’s height lower quartile? 

Now when I chose the NORM.DIST function just now you may have said, “Well why did he 

choose that one? Why didn’t he choose one of the others?” Well we’re now going to choose one 

of the others because the NORM.DIST function finds a probability when we know a in this case 

height, an X value. The NORM.INV function is the one that gives us the height in this case when 

we know the probability. So this is the inverse. So we want =NORM.INV. Now the probability 

we want is 0.25. That’s 25%. The mean is E2, the standard deviation is E3 and the lower quartile 

height is 64.4 inches. Let me just do the same thing for median and upper quartile. And there we 

are. Lower quartile is just under 64½ inches, 5 foot 4½. The median is just over 5 feet 6½. And 

the upper quartile is just under 5 feet 9.  

So the DIST function gives us the probability from in this case the height, the INV gives us the 

height from the probability. There were two other functions NORM.S.DIST and NORM.S.INV. 

These basically do the same job but for what’s called a standardized normal distribution. And 

basically the standardized normal distribution is a special case of the normal distribution where 

the values are scaled down to be in the range zero to one. But we certainly don’t need to use that 

here. If you are going to look further into statistical inference it’s very likely that you will come 

across that special case. 

In the mean time to do the kind of inference we’re doing here NORM.DIST and NORM.INV 

will normally do the job between them. 

Now particularly if statistical inference is new to you then you’ll probably be mainly dealing 

with normal distribution cases, assumptions of normal distributions. But in fact Excel 2016 now 

can deal with a number of different types of distribution and there are DIST and INV functions 

for a number of different distributions. So for instance here you can see BINOM.DIST and 

BINOM.INV for binomial distributions. And there are various other distributions such as a plus 

one distribution.  
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But that’s it for me on statistical inference and in fact statistics in general now. It’s time to move 

on. I’ll see you in the next section. 
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Chapter 9 – Connecting to External Data 

Video: Connecting to Other Workbooks 

Toby: Welcome back to our course on Excel 2016 Advanced. 

So far with virtually everything we’ve covered on the course we’ve been looking at self-

contained workbooks, workbooks that have all of their own data within them. And even when we 

needed data from outside we imported it into the workbook that we were using. But there are 

occasions when you want to have access to data from outside but on an ongoing basis. So rather 

than import the data into a workbook we want to be able to link to it from one or more 

workbooks. And in some of those instances we may even be depending on what is in effect a real 

time update from outside.  

Now I’m going to cover three different scenarios here. In this section I’m going to look at 

accessing data from another workbook, then we’re going to look at accessing data from an 

Access database and then in the third of these sections we’re going to look at accessing data from 

the web. Now as I said, in all three of these cases we’re going to be looking at situations where 

the data is held outside of one of our workbooks and in effect we’re not importing it. We’re 

leaving it outside but setting up a mechanism whereby our workbook can get that data and 

potentially be updated in real time with that data from that outside source. 

Now in the first example that I’m going to use I’ve got some sales data from two South 

American divisions of a company. One division based in Bogota and one based in Lima, Peru. 

And for each of them I have their sales figures for 2015. 

Now Bogota sales are on one sheet, Lima sales are on another sheet. And what I’m going to do is 

put together a summary sheet. And the summary sheet will combine the two sets of figures. At 

the moment all of this data is within a single workbook and we’re going to separate this into 

different workbooks a little bit later in this section. So first of all let me put in the framework for 

this summary sheet. 
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Okay my framework is in place. What I’m now going to do is to copy the figures from the 

Bogota sheet and the Lima sheet. So for the Bogota sheet I’m going to select the cells, copy them 

to clipboard, back to the summary sheet, they’re pasted into place. And then I’m going to the 

Lima sales, copy those, back to the summary. But this time instead of paste I’m going to do a 

special sort of paste, a paste link. So if I go to Paste Special, go down to the one with the picture 

of the link on it, Paste Link. I see the same numbers of course but now if I click on a sale such as 

that one, D4, I don’t get the value 83 in there. I get a link. And the form of the link is equals, the 

name of the worksheet which is Lima, bang, which separates the name of the worksheet from the 

cell reference and the cell reference is C4 and that is of course C4 on the Lima worksheet. 

Now I should point out that if a sheet name or indeed as you’ll see later on a workbook name has 

a space in it then the name of the sheet or the name of the workbook will have quotes around it in 

order to identify it as an entity. But at the moment my worksheet names don’t have spaces in 

them. 

So what I have there is a standard format of link within a workbook. And then when we separate 

this out into different workbooks later on you’ll see the more complex link that arises.  

Now as you may not be familiar with the effect of these links let me quickly demonstrate this. 

And the way that I’m going to do this is I’m going to go to the View tab and I’m going to say 

New Window. So we’ve now got two windows. I’ll increase that one to 200% as well. And then 

back to the View tab again and I’m going to say Arrange All and I’m going to say Vertical. So 

I’ve got two windows on the same workbook. And on the left hand side I’m going to go to the 

Bogota sheet and I’m going to change 92 to 93. And just watch what happens in C4 on the right. 

That’s on the summary sheet. And of course what happens is nothing at all. But if I go to the 

Lima sheet on the left, go to the first one which currently says 83 and change that to 85 look at 

what happens to the Lima entry on the right. Of course that becomes an 85 as well. So there 

you’ve seen how updating one cell on a different sheet in a workbook can update a linked cell on 

a different worksheet in the same workbook. 
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Now I should point out while we’re doing this that I’m not really concerned about the formatting 

of these cells. We’re only really concerned with the values and the linkage of those values in this 

section.  

Now I’m going to split this into separate workbooks in just a moment but one or two other things 

to quickly show you, which you may not be aware of. Let’s go to the summary sheet on the right 

and let me just clear those Lima values. Now one way that you can set up these pasted links, 

having cleared the Lima values there now let me make that same selection from the Lima sheet 

on the left. If you hover the cursor over the edge of the selection and don’t left click but right 

click and drag, you drag the selection into the right position, that’s in the other window. In my 

case in the right hand window. When I release the right mouse button I get a little menu here and 

one of the options is Link Here. And that sets up those links. So that’s a drag and drop way of 

setting up those links. 

And one other little trick that you may not be familiar with. If I copy the Lima sales figures as 

before just using the keyboard shortcut Control-C, go over to the summary sheet and do Control-

V to paste them you get a little menu down at the bottom right there that you may or may not be 

familiar with. If you hit the Control key or click on the dropdown that brings up the menu and of 

course you can access the Paste Link button from there as well. 

So what I’m going to do now is to split this into three workbooks. The first workbook will 

contain the Bogota figures, the second one the Lima figures and the third one will be a summary 

workbook and that’s going to use the figures from the other two workbooks. But it’s going to use 

them by linkage, not by copy and paste. 

Having created those three separate workbooks what I’m now going to do is to open first the 

Bogota workbook and the summary workbook and Paste Link the values between the two. 

So I have the two workbooks open. Select the Bogota sales figures and Paste Link them in. Now 

notice the reference here from C4 in the right hand window, the Branch sales summary window. 

And you can see that I’ve got the name of the workbook in square brackets, 

SimonSezIT_South_American_Branch_Sales_Bogota.xlsx, then the name of the worksheet 

which is Bogota, then the exclamation mark, what I call a bang, and then the C4 cell reference. 
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So with each of these cells I have a reference to a cell in a different workbook. Of course if I 

make a change in say the February sales, Bogota sales on the left there and find that’s wrong and 

it should be 96 that will be updated in the summary sheet on the right. Now what I’m going to do 

is to close the summary workbook and with the Bogota workbook here still open I’m going to 

make another change. March figure is also wrong. 91 should be 94. Now notice I’m doing this 

when the summary workbook is closed. So tick on that change and now I’m going to close this 

workbook. 

Now what happens next is very important because what I’m going to do is to now open the 

summary workbook without the Bogota workbook being already open. Now the first very 

noticeable thing there is that you get a security warning which maybe you weren’t expecting. 

And the reason you get a security warning is that as far as Excel 2016 is concerned you are 

opening a dangerous workbook because it is a workbook that has a link to the outside world. 

You’re probably familiar with the dangers of opening workbooks which have program code in 

them. But opening workbooks that have links to the outside world is a pretty dangerous exercise 

as well. The good news is that in this case you know it’s not dangerous. And the other good news 

is that the way that these security warnings work with Excel as I’m sure you know is that once 

you’ve trusted this document then you won’t get this warning again. So we’re going to trust this 

document by saying Enable Content. Just before I do that look at the March Bogota figure there, 

91. It hasn’t done that update because of course it’s not opening up that other workbook yet. 

Until we trust this one and therefore trust its links we won’t get that update from 91 to 94. If I 

now click on Enable Content then the update occurs.  

So what I’m going to do now is to close this workbook yet again and then reopen it yet again. 

Now this time instead of the security warning we get a regular warning that you will get. This 

workbook contains links to one or more external sources that could be unsafe. If you trust the 

links update them to get the latest data. Otherwise you can keep working with the data you have. 

So now you get a choice of updating in which case it will look at the Bogota sales and see if they 

need an update or you can say don’t update if you’re happy to work with what’s there already. 

So that’s a pretty straightforward way of giving you the option of updating from those external 

links or not.  
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It does however raise one other issue. And that is let’s suppose that the whole point of this 

summary workbook is to perhaps produce a management report and you want to be able to send 

this workbook to various people but they won’t have the individual workbooks, the Bogota 

workbook and the Lima workbook. You just want them to see the summary figures basically at a 

point in time. But what you can do is to set up this summary workbook so that it doesn’t prompt 

for those updates. Let’s say don’t update for the moment. Then on the Data tab in the 

Connections group there is an Edit Links command. And if I click on Edit Links, notice the links 

are listed. Now the links we’ve got here are to the Bogota workbook. There is a little button in 

the bottom left hand corner, Startup Prompt. If I click on that, Let users choose to display this 

alert or not, one option, Don’t display the alert and don’t update automatic links, and then Don’t 

display the alert and update links. So if you don’t want the alert and you want the update to 

happen anyway you could choose the third option and you won’t get the alert at all. It’ll just 

happen. The option we want though is the middle one. Don’t display the alert and don’t update 

automatic links. Click on OK. Now I’m going to save this version and of course if I open this 

version I won’t get those alerts and I won’t get a security warning. 

Just in case you have any doubts about that I suggest that you use the files in the course files 

folder, perhaps put in the Lima links as well and just try going through those security steps that 

I’ve just described to you to make sure that everything works the way that I’ve said it would. 

So that’s about it on connecting to other workbooks for the moment except for two very 

important points. One of them is that if you look at this particular link here in the formula bar 

you can see it’s a very long link, most of which is made up of a folder name. You can edit and 

type in link names. You don’t have to establish links in the way that we’ve said. Note in this 

particular case those single quotes though because there are spaces in folder names in this case it 

needs those quotes at either end of the name of the workbook in order to identify it as a single 

entity. 

And the other very important point is that links when created automatically usually contain 

folder names or reference to a particular location of a workbook. And if you move workbooks 

around that can really mess things up. So if you are going to use link workbooks it’s important to 

either, for example, keep all of them in one folder and remove the folder names, just have the 
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workbook names in those links so that if you move everything around together they’re still in the 

same workbook and therefore don’t need folder names. Or to keep the source workbooks, in this 

case for example the Bogota and Lima figures in a place that never varies. So you never have to 

move those workbooks and change links to them.  

So that’s something to be very, very careful of. But that’s it for this section. We’re next going to 

take a look at linking to Access data. That’s the next section. I’ll see you then. 
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Video: Connecting to Access Databases 

Toby: Welcome back to our course on Excel 2016 Advanced. 

Just in case you’re thinking you may have stumbled into the wrong course here, you are actually 

looking at part of an Access database at the moment. And in this section I’m going to show you 

how to connect to data in Access databases. If you don’t use Access, perhaps have no interest at 

all in it you may want to skip this section. But several of the tools and techniques that we use do 

apply to other databases that you can connect to from Excel and so you may find this useful 

anyway. 

The database we’re looking at, the Esprit de Tour database, is a tour company database that was 

created as part of our basic Access 2016 course. If you haven’t studied that course I can explain 

the Esprit de Tour database to you very quickly in terms of what we need in this section of the 

Excel course.  

Basically the hypothetical tour company Esprit de Tour run a number of trips. You’re looking at 

the details of one of the trips here, the Grand Canyon Family Rafting Adventure. And apart from 

a description of the trip and information about it including the country or countries visited, the 

level in terms of comfort and luxury of the trip, and specific tour dates, instances of the trip 

there’s a dossier of information and various other items related to that particular trip.  

Now bearing in mind that many of you may not be Access users what I’ve just done is to open up 

what’s called the Navigation Pane on the left. And that gives a list of most of the objects that 

feature in this database. These objects includes tables, queries, forms, reports, and macros. The 

information contained within the database is held in tables and each table is very much like an 

Excel worksheet. So for instance, when it comes to a trip there is a table called tblTrip. Tbl 

prefix indicates that it’s a table. And if I open that up it looks just like an Excel worksheet. And 

if you want to you can form an Excel workbook, access this data in situ. So basically we can link 

to information that is actually held in an Access database from an Excel workbook. One option 

of course would be to import the data into the workbook. But in this section we’re going to 

concentrate on connecting to the information in the database and effectively creating a live 

connection between the two.  
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Now amongst the tables in the Esprit de Tour database we have this one which gives information 

about trips. We have another one here, the tblTour table. This holds information about specific 

instances of trips. And then we have other tables such as a country table, a trip type table and so 

on.  

Now an Access database is an example of what’s called a relational database. And the reason 

that it’s called a relational database is that you create relationships between the tables. And I’m 

going to show you now a graphical representation of the relationships within the Esprit de Tour 

database. If I go to Database Tools one of the options there is Relationships. And that shows the 

structure of the database in terms of the tables.  

Now let me quickly explain this diagram. One of the key elements of the whole database is the 

first table I showed you there, the trip table, tblTrip. And you notice there’s a line from tblTrip to 

tblTour. And it says one at one end and infinity at the other end. What that means is that for each 

trip such as the Grand Canyon Family Rafting Adventure there may be many tours. Now there 

wouldn’t actually be an infinite number of tours but they can basically do as many as you like 

because each tour is an instance of a trip. Each tour will normally be that trip starting on a 

particular date. So if you go to a travel agent to book a particular trip you would need to decide 

which instance of that trip you were doing. Normally that would be what your start date is. And 

we’re referring to that particular instance as a tour. 

Now it’s also the case that for each trip it can visit one or more countries. So we’ve got a line 

from tblTrip to tblTripCountry and through tblTripCountry to tblCountry. And this relationship 

says that a trip can visit many countries. But also for each country it can be visited by many trips.  

Now don’t worry too much about the meaning of all these relationships. I’m pointing this out 

here because it’s a subject that will come up when we’re looking at connecting to Access 

databases from Excel workbooks in a few minutes time. 

So now I’ve created a new workbook in Excel and I’m just going to access one of the tables in 

that database first of all. So I go to the Data tab. The left most group on the ribbon is Get 

External Data and I’m going to click on From Access. Now I need to locate that Access database 

that we were just looking at. When you are looking for Access databases the file extensions that 
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Excel 2016 will be looking for are the MDB file extension or MDE file extension. These are the 

extensions associated with older versions of Access and databases created with older versions 

and the ACTDB and ACTDE extensions which are the ones that are used with newer versions of 

Access. In this case it’s a relatively new file so I’m going to go into course files and the one we 

want is the Esprit de Tour 21 database. So select that, click on Open, and I’m offered a list of 

queries and tables. You can actually open Access queries in Excel as well as tables. Now for the 

moment I’m just going to open a single table. I’m going to open the Country table. That’s one 

that we didn’t look at. Click on OK.  

Now how do I want to view the data? Do I want to view it as a table? That is an Excel table. You 

may be familiar with Excel tables. If you aren’t we’re covering those straight after we’ve dealt 

with connecting to external sources. We’re then asked where we want to put the data from this 

Access table. Well I’m going to go for the default location, the one that’s got the marching ants 

at the moment, A1 on sheet one. And then finally we have a checkbox, Add this data to the data 

model. 

Now the next thing I’m going to do after this one is to open a more substantial amount of the 

Access database. And when we do that a data model will be created in Excel. And one aspect of 

the data model will be Excels representation of those relationships that we looked at just now. 

For the moment I don’t want data model. I just want to get at that company table in the Access 

database. So I’m just going to click on OK and there it is. That’s the list of countries that are 

available in the Access database. 

If I make any updates in the Access database they will be reflected here as well. So I’ve basically 

got a live link here. 

Now let’s look at one little element, one little aspect of this connection. You can see there the list 

of countries. They start with the second row, Antarctica, and go down to row 17, Zimbabwe. Let 

me quickly open the database again. Let me this time open the Country table. There are those 

countries, Antarctica to Zimbabwe. Let me add a new country in there. I’m going to add 

Netherlands. That’s fine. Now let me just close the database, although of course I could leave it 

open if I wanted to. Let’s go back to our Excel sheet. And one of the options we have is refresh. 
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And we click on Refresh and now you can see that Netherlands has appeared within the list of 

countries on that Excel sheet with the connection to the Access database. 

Now I’m going to talk a little bit more about refreshing workbooks when they are linked to 

Access tables in just a moment. 

Right. Let’s now run through a more advanced example. Let me create a new sheet down here 

and I’m going to go back to the Data tab. I’m going to click on From Access again and select the 

same Access database. Now this time I’m going to select a number of tables. So Enable selection 

of multiple tables checkbox. I check that. Now I get a set of checkboxes where I can select. I’m 

going to choose Tour, Trip, Country, and TripCountry I think. Click on OK. Now automatically 

if I select more than one table this checkbox, Add this data to the data model is checked. And the 

default when I select multiple tables is to get a Pivot table report. Now again if you don’t know 

about Pivot tables it’s a topic we’re coming back to later in the course. But on this occasion I’m 

going to stick with the table option.  

Now while we’re working at this import data little dialog look at Properties down here because 

Import relationship between tables, that’s checked by default here because we have multiple 

tables. But if I click on Properties I get Connection Properties and there are a couple of very 

important connection properties that I want to look at. One of them is that you can have Excel 

automatically refresh data on a timed interval. By default 60 minutes or where the box isn’t 

checked. But if I say wanted to have an automatic refresh of data say every five minutes then 

every five minutes it would check the data in the Access database and see if it needs updating in 

the Excel workbook. And I have another option here with this checkbox, Refresh data when 

opening the file. So I can specify that every time I open this workbook I want to refresh data 

from the Access database which generally speaking is a pretty good idea. 

There is a third checkbox here which is checked by default. Refresh this connection on refresh 

all. You will quite often once you start using external connections finish up in a situation where 

you have external data in a number of different locations, possibly a number of different 

connections. And rather than have to go through and refresh them one by one you have a Refresh 

All option here up in the Connections group on the Data tab. And if you include this in Refresh 
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All, if you are going to manually refresh data you can just click that and have it refresh a whole 

load of connections. So I’m going to leave those checked at the moment and click on OK. And 

then I’m going to click on OK. And what I now find is that I have a whole batch of new sheets 

and each of those sheets has one of the tables of data. Note that in each case the data is held in a 

tabular form. So that’s the Country table, sheet 6 is the TripCountry table and so on. 

So having set up this connection I can investigate the connections further. I can, for example, go 

to the Data tab and click on the Connections button there in the Connections group. That gives 

me a list of my workbook connections. Let me just select the latest one that I’ve made here. Look 

at the properties. I’m going to switch off the automatic refresh. I’m going to leave on the refresh 

data when opening the file. If you click on the Definition tab here it gives you information about 

the connection file. So this is the Access database that it’s making the connection to. Obviously 

when you use the contents of the course files folder you’re going to need to make sure that this 

connection file is set correctly. Note also the list of tables there that part of the connection. Let 

me just click on OK for that. Note also this workbook data model is set up. And I could in fact 

add to this, add to the data model by for example adding additional tables from the Esprit de 

Tour database. So there’s a few options there for you to experiment with in terms of extending 

the data model, adding additional tables, etcetera.  

Let’s just do one little update. Let me close this, switch back into Access. I’ve chosen the first of 

the JCA Tours there. The price $3,080. I’m going to change it very noticeably to $6,080, switch 

back into Excel. There’s the first of those JCA Tours there on sheet four. Let’s do a refresh. And 

there you can see the updated price for that tour. I have found when doing this in Excel 2016 

from Access 2016 databases and it probably applies to earlier versions as well that if you do 

make any change to any of the connections it’s always a good idea to close and reopen the 

workbook. It seems to stabilize things and makes things much more likely to work successfully. 

So that’s it on Access database connections. In the next section we’re going to look at getting 

data from the web. So please join me for that. 
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Video: Connecting to Web Data Sources 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to look at connecting to data sources on the web. 

This has been a facility in Excel for quite a long time now but over recent versions not only has it 

changed in the sense that there have been some new ways of doing it introduced but the power 

and flexibility of these approaches has greatly increased.  

What I’m going to show you in this section is what I’ll call the legacy approach, the way that this 

has been done for the last few versions of Excel and a way that still works today, as you’ll see. 

But which is gradually falling out of favor and one of the reasons that it’s falling out of favor is 

that the number of websites that support this approach is diminishing. But I do think it’s still a 

useful and important approach to understand because it’s also a useful introduction to the more 

modern and more flexible approaches. But in the next section we’re going to take a look at the 

basics of those later approaches. 

So what I’m going to do by way of an example in this section is to get some live stock market 

data and put it into an Excel workbook. Now there might be various reasons you’d want to do 

this. For instance, you may be developing an application in Excel where you need to get the 

latest value of an index or maybe the latest exchange rate. Perhaps you’re doing something to do 

with travel and exchanging money. 

But it is a pretty straightforward thing to do and as I say the main problem is finding suitable 

websites where you can get the indexes, exchange rates, etcetera that you need without too much 

trouble. I’ll explain what I mean by too much trouble in just a moment.  

So click on From Web and that brings up a new Web Query browser. Now I’m going to make 

that browser quite a bit bigger. And what I want you to notice here is what I’m going to refer to 

as these little yellow arrows. Now these yellow arrows aren’t actually yellow arrows. They’re 

black arrows on a yellow background but I’m going to call them yellow arrows because I think 

everybody else does as well. And what we’re going to do is to look for some market values. 
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Now there are quite a few websites that offer this but I’m going to go to Google because I know 

that Google actually is quite cooperative in providing us with the information that we need. So 

I’m going to go to Google Finance. There it is. And over on the right you can see a section that 

says World markets. And this gives the current value of a number of stock market indices around 

the world. Now the important thing to note here is that there is one of those little arrows. And if I 

hover over it you’ll see that there is a blue bound for a table. And when you see a yellow arrow 

and hover over it and see a blue bound like that then that represents an entity that you can import 

into Excel. There are actually a few on this page. You’ll see there’s another one there with the 

current FTSE index values and techMARK index values and so on. But I’m going to go for the 

World markets one. So having hovered over it I’m now going to click it so that it changes to a 

tick and then I’m going to click on Import. Now I don’t expect you to remember these number 

but just note those values there. Shanghai 3,023.00 right down to IDX Composite 5,302.49. Click 

on Import. I now choose a starting cell for those to be imported into in my worksheet and click 

on OK. And then after a moment or two you can now see those indexes in my worksheet. So I 

have from Shanghai right down to IDX Composite. And notice they’re the values that they were 

on the website. 

Now having done that a number of things happen and one of the things that happens is that Excel 

sets up a connection and the connection in this case gets a default name of Connection. And I’m 

going to look at the properties of that connection in just a moment. But look at the values here 

for these indexes, Shanghai, S&P Standard and Poor’s, etcetera, right down to TA25. Just look at 

those because what I’m going to do is to click on this Refresh button and watch what happens. 

What you’ll notice is that one or two of those values changed. And in fact by clicking on Refresh 

I will get the latest version of each of those in my Excel worksheet. But I can go a step farther 

than that because I can actually set this up so that they are automatically updated for me, which 

is what I’m going to do next. 

So I’m going to go back to the Connections button in the Connections group on the Data tab, 

select that to connection and click on Properties. I’m going to give it a more useful name. I’m 

going to call it Google Markets Updates and I’m going to set a couple of refresh values, one of 

which is to do an automatic refresh on a timer. Now normally you’d set this according to how 

update you want these values to be. But for the purposes of this exercise I’m going to set it to a 
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very small value, just two minutes, so that you’ll see an update very soon after I click the OK 

button here. And I’m also going to check this box which says Refresh data when opening the 

file. Now of course we covered these connection properties a little bit earlier on in the course so 

you should have a good idea of what these properties do now. But I will just click on Definition 

because the definition includes the connection string which reminds you of the page in Google 

which actually had that table that we’ve imported into Excel. 

So bear in mind that I’ve set that for a two minute update. Let’s click on OK. There’s one update. 

Click on Close and we’ll just leave them to update for a minute or two longer and see the values 

change. Of course some of these stock markets are closes at the moment. It’s early evening in the 

UK at the moment so some of the stock markets, particularly the European ones will be closed. 

The U.S. ones will still be open and the Far Eastern ones will be open or closed depending on 

how far east they are, of course. 

So there we are. I’ve left it about 15 minutes since you last saw the contents of the sheet and 

you’ll notice quite a few changes to some of those indexes over that period. So this set up okay. 

And of course normally having established that this is working correctly I might go back in and 

set the refresh interval for these to a more suitable figure for the application to which I am 

applying their use.  

The next thing I want to do is to show you what happens if I come back to that workbook at a 

later time. I’ve left it about a day actually. Now I’m going to open that same workbook again. 

I’ve called it Connect_to_Web_Data. So I can get it from my Recent Files or I can browse to the 

course files folder. And when I open it again Excel issues a security warning. Bear in mind that 

we have external data connections in this workbook. So as usual it’s always worth giving a 

careful bit of thought to this. Am I really happy with this content? And of course in this case I 

am. 

And if you look at the values now of those various stock market index values you may have 

noticed that initially they were set to the values when I last saved and closed that workbook. 

Once I’ve opened it and Excel has done a refresh on open it’s given me the latest values. And of 

course now bearing in mind the frequency in which I’m doing a refresh those values will 
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continue to be updated and you’ll see values change according to which of the stock markets are 

open. 

So that’s it on what I consider to be the legacy approach to getting data from the web. It still 

works provided you can find suitable sources for data. 

One thing to warn you about. If you have a slow or intermittent or indeed expensive internet 

connection you do need to be a bit wary of this. Sometimes if you set up large and complex data 

feeds the slowness or expense of your internet connection can make it a somewhat impractical 

proposition. I’ve seen situations where somebody has tried to get large volumes of data updated 

from the web every minute or two and more or less ground their internet connection to a halt. 

And caused all sorts of problems in Excel as well. So you do need to tailor your use of this 

feature according to the quality of your internet connection.  

That’s it on this legacy approach. In the next section we’re going to look at an example of Get 

and Transform. So please join me for that. 
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Video: Get and Transform 

Toby: Welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to take a look at Get and Transform.  

Now to some extent Get and Transform is a progression from the earlier facilities to get data 

from the web, which for quite a long time were the facilities I demonstrated in the preceding 

section. And then the facilities from Excel 2010 into Excel 2013 become known as Power Query 

and now Get and Transform has really superseded Power Query in Excel 2016. But it’s not just 

about getting data from the web. Get and Transform enables you to get data from many, many 

different sources, including many of the ones that we’ve seen such far such as getting data from 

Access or a CSV file and transforming the data to suit your particular requirements. So that’s the 

Get and Transform. 

And then there are two subsequent steps which I’m not going to look at on this course. I’m going 

to concentrate on the first two. But the two subsequent steps are Combine where you create a 

data model and you can combine multiple data sources. So you can maybe get some data from 

the web such as a current exchange rate, maybe get some data from an Access database such as 

the cost of a trip and combine them to provide additional insights into that underlying data. 

And then there’s a fourth step in this whole process which is generally described as Share where 

you can share the data or perhaps use it in reports. 

Now as I say, in this section I’m going to concentrate on Get and Transform. And following on 

from the preceding section what I’m going to do is to get some web data and transform it in the 

way that I might to make it a little bit more suitable for my requirements. 

Now in the next section I’m going to set you Exercise 05. And for Exercise 05 I’m going to ask 

you to Get and Transform some specific data related to the weather. In this section I’m going to 

Get and Transform some sports data. And just to make things a little bit more interesting for you, 

if you’re going to work along with me you could try your local sports data. For instance, here is a 

section of the NFL table for people who follow the NFL. I’m going to process some English 

Premier League table data. But if you are interested in neither the English Premier League nor 
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NFL then try some other tabular data from somewhere on the web and you’ll probably find that 

it will present some of the challenges I’m going to face in this section and probably a few 

different challenges as well. But if you don’t particularly want to use your own data or data that 

you’re interested in then you can just follow along with the English Premier League data that I’m 

going to Get and Transform. 

So we’re now looking at the Premier League table as it is today on the BBC website. The BBC 

are not well known for moving things around too much so I hope that by the time you come to 

follow this course this Premier League table will still be where it is, although of course the 

positions of the teams and the statistics hopefully will have changed quite a bit by then. And 

what I’m going to do is to set up a regular feed from this table into Excel. Now if you think of 

what we did in the preceding section you think, “Well aren’t we going to be looking for those 

little yellow arrows and things?” Well the little yellow arrows don’t feature in the Get and 

Transform approach. Although fundamentally we’re doing a similar kind of thing it’s done in 

really quite a different way. And another thing to bear in mind is that although it’s not quite as 

bad as it is using the legacy approach there are still quite a lot of variations in terms of whether 

you can get data from webpages. And you may want to get some particular data and not be able 

to find it or you may not be able to, if you like, separate it out from all of the stuff around it.  

So having identified the page that contains the data that I want I’m now going to get the URL, 

just copy that to the clipboard, and now I’m going to switch into a new Excel workbook. 

So there’s my new workbook. I’ve already called it Get_and_Transform.xlsx. From the Data tab 

I’m going to the Get and Transform group and I’m going to click on New Query. And from the 

dropdown if you look at all the various sources I can get data from a workbook, a CSV file, an 

XML file, from a database, SQL server database, Microsoft Access database, from Microsoft 

Azure, etcetera. One of the options is From Web. Note some of the lower ones down there, From 

Facebook, for example.  

Now when I click on From Web it comes up with a dialog and in that dialog I paste or type the 

URL containing the data that I want and click on OK. Now I’m going to warn you that when I do 

this if Excel successfully finds the page it will do an analysis on that page and it may take some 
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time. So you may be sitting here for a little while. This isn’t only related to how fast your 

internet connection is. Excel sometimes has a lot to do to sort its way through that page. Click on 

OK.  

Now when it’s finished the analysis of the page this Navigator dialog shows you what it’s found, 

shows you the entities that it’s found on that page. And in this particular case under the URL 

itself you have Document which is just basically some basic document information about the 

page. And then it lists two entities. This table charts the Premier League teams. This table charts 

the Sky Bet Championship teams. Now that particular page has two tables. One for the Premier 

League which is the top league in England and then the Championship which is the second 

league in England. There are several leagues below that as well.  

Now if I wanted to get both of those I can say Select multiple items and I could actually get both 

of those if I wanted to. But I don’t want to. I just want the Premier League. So I click on that one 

and it does an analysis. And it basically does a preview of what I’m going to get if I get this data.  

Now one thing you’ll notice is that there seem to be a lot of stuff that I didn’t see like this 

column here, Team Statistics and this position, No movement, and that kind of thing. I’ll come 

back to all of those in a moment. But if I scroll across you can see that basically the information 

that I want is there.  

Now if you were getting data from a very large, very long page it may only show you part of it in 

the preview. But in this particular case it’s got me the whole of the Premier League table. So I’m 

now going to click on Load and that will be loaded into this worksheet. 

Now again it may take a moment or two to do that but when it’s finished you can see that data 

loaded. And there are some very important aspects of what you can see. One of them is that it’s 

loaded into a table. So once again if you haven’t dealt with tables before you may need to come 

back to this. And also it’s created a query. And up on the ribbon you can see a Table Tools set of 

tabs, the Design tab. And then you’ve got a Query Tools Query tab which we’re going to look at 

in just a moment.  
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But over on the right it’s also created a workbook query. And this query is the one that I can 

rerun any time I like in order to get an updated version of this data. Now given that generally 

speaking Premier League matches happen at the weekend, sometimes on a Friday night, 

sometimes on a Monday night, sometimes Saturday, sometimes Sunday, occasionally during the 

week then there wouldn’t really be any point in doing a regular update of this query but I might 

want to update it say once a week or I may want to just go in and update it whenever I want to 

take a look at the table. But I’ll come back to that a little bit later on. Fundamentally this facility 

has the ability to update this for me either automatically or subject to manual operation by me. 

Now apart from what you can see in front of you here something else has been created which is 

very important. And if I go back to the Data tab and go to Connections you’ll see that a 

connection has been set up with a name of Query. This table charts the Premier League teams. 

Basically it says what it says in workbook queries on the right there. And if I click on Properties 

you’ll see that familiar Connection Properties dialog with its two tabs, the Usage tab and the 

Definition tab. And what I’m going to do on this occasion is not to set up an automatic refresh 

but I’m going to say Refresh data when opening the file. So that means that every time I open 

this workbook it will try to do a refresh and of course I’ve always got the option of doing a 

manual refresh anyway. 

And one other interesting checkbox here is the one immediately below that one. If you’re 

processing a very large amount of source data, say from the web, and as part of the transform and 

combine operations you’re only finishing up with a small part of that data you can actually tell 

Excel that each time it saves the workbook it can remove the external data. It doesn’t need to 

include those in the workbook. And then the next time you load it either automatically or 

manually you can reload the updated external data and you’ll still finish up with everything 

being processed in the way that you want. That can drastically reduce the size of your saved 

workbooks. On this occasion the amount of data here is not great so I have no need to do that. 

But it’s very useful if you’re dealing with very large volumes of data. 

So that’s Connection Properties. That’s my Connect or Get stage of Get and Transform. The next 

thing I’m going to do is to transform this data, and in particular I want to get rid of some of the 

data in that table that I don’t need and also fix one or two potential problems in the rest of it. 
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So as I pointed out just now the results of that query are in a table and I’ve got the Table Tools 

Design tab option there if I wanted to format the table, perform other things on it such as 

removing the banding of the rows, etcetera. So anything to do with style. But if I click on Query 

and then on Edit I can go into the Query Editor which allows me to basically change what is 

produced by the query.  

Now there are a number of things that I can do. One of them is to remove unwanted columns. So 

let me select that first column there and I can either right click and choose Remove or there is a 

Remove Columns option on the ribbon there. Let’s click on Remove to get rid of that column. I 

also don’t want the last two columns.  

So if I were to save this query as it is now and run it again next week that sequence of steps 

would be carried out for me automatically because the applied steps are all being stored over 

here with the query. So as I perform each step, for instance removed columns, if I changed my 

mind about that I can click on the Delete there. That undoes those changes and those columns are 

back again. 

Another typical problem is that I may have something in a column that I don’t want. I may not 

want to remove the column but I may want to remove something from it. So for instance here I 

don’t want the expression No Movement at the beginning of the position. So if I select the 

column one of the options is Replace Values. That brings up a little Replace Values dialog and 

I’m going to say I want to replace No Movement with a space after it with nothing. Click on OK 

and that’s done throughout that column.  

The other sort of thing that I can do here and this will highlight another issue is that I could 

change the sort order, for example. Now there is a Sort group here with ascending sort and 

descending sort. If I select the position here I could do a descending sort if I wanted to. I could 

put the teams in reverse order. But what happens if I do that is rather strange and the reason it’s 

rather strange is because if I click back on that column again you’ll see that as far as Excel 2016 

is concerned that column contains text. The data type is text. What I really want it to be is whole 

numbers. Now if I sort it in ascending order, for example, everything is correctly sorted in 

numeric order.  
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So when I finish making any other changes that I want to make and click on Close and Load I’ll 

have my updated, transformed data. 

So that was an example of Get and Transform. One or two things just to emphasize there. One of 

them is that of course the editing we’ve done there doesn’t change the source data in any way. it 

only affects the transformation that is performed on the source data as part of this workbook 

query. And you can actually perform some incredibly complex transformations, combinations, 

etcetera and there’s even a purpose built language called M that is used by the Query Editor but 

that you can use yourself to do even more sophisticated transformations and so on. 

So that’s it for this section. We’re coming up now to Exercise 05 and I’m going to give you an 

exercise a little bit like that one in Exercise 05. Please join me for that. 
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Video: Exercise 05 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In this section I’m going to set you Exercise 05. And Exercise 05 is going to involve getting 

some live data from the web. 

Now the way that I’ve done this is certainly not the only way that you can do this. And you may 

well want to adapt this for your own location. But what I’ve done is to set up a workbook 

Exercise_05_Answer and it’s got two sheets in it. The first sheet is called MyWeather and in it 

I’ve got some information about the weather in London. You currently see that it says 

Wednesday 16:42, partly sunny, mild temperature, 21. That’s degrees Celsius. I’ve then got a 

couple of rows down from that what the highest temperature worldwide is at the moment and 

then I’ve got the lowest temperature worldwide. Now those temperatures refer to world cities. So 

there may well be higher or lower temperatures away from the world cities.  

This is going to be updated live, this information. Now hopefully you’ll see the time tick over. 

I’ve got it set on a five minute timer. And if the temperature in London changes or the highest or 

lowest temperature changes you should see those change on this worksheet without me cheating 

by touching my keyboard or anything. 

Where did I get all this from? Well I used a website called timeanddate.com and I used data on 

world capitals. Now I’ve edited that data. So I’ve done a Get and I’ve done some basic editing on 

the query. And I’ve edited the data for a number of reasons. One of the reasons is to do with the 

temperature and the other reason is to do with removing one or two extraneous columns of 

information. So if you think back to the last section in the course you’ll get a good idea of the 

sort of thing that I’ve done. 

What I’m going to do in just a moment is to show you the webpage that I got this source data 

from. But as you can see within the table we have capitals of the world, the day and the local 

time. Columns 4 and columns 8 show the current weather conditions. Columns 5 and column 9 

show the temperature in degrees Celsius. Let me just go back to that first sheet again. 
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And then what I’ve done is to use some of the functions that we saw earlier on in the course to 

locate the weather in London from that table. That’s created by the Get and Transform. And you 

probably just noticed that the weather in London ticked up to Wednesday 16:47. The temperature 

didn’t change. The conditions didn’t change. And the highest temperature worldwide and lowest 

temperature worldwide didn’t change either. 

So the connection that’s actually getting this data for me into Excel is set on a five minute 

refresh. And amongst the functions that I’ve used there let’s look at highest temperature 

worldwide. I’m going to click in cell F5. I’ve used the Max function. And the Max function is 

applied to two ranges. Each range is a column in the weather table. Now if you’re not used to 

using tables in Excel, we’re actually going to start looking at tables in detail in the next section. 

So if you’re not comfortable with tables you can maybe do this exercise after the next few 

sections on tables. But if you are you’ll know how easy it is to refer to a column in a table. And 

of course one of the big advantages of referring to a column in a table is that you don’t need to 

know exactly how many rows in it and you don’t need to deal with changes in the number of 

rows, for example. 

So that’s where I get the max temperature from. Obviously similar principle for the min 

temperature. And then in terms of finding the time in London, the conditions in London and the 

temperature I use VLOOKUP functions. But bearing in mind what I’ve just said about the 

weather table you might want to adopt that approach as well. 

So let’s just switch over and take a look at that website. 

And there it is. Timeanddate.com. there are a number of selections I’ve made there. I’ve said sort 

by city and I’ve said show the capital. So this is the capital cities of the world. And as I say, I’ve 

had to do a couple of edits to the query. One of them was to remove as least one extraneous 

column. The other one is that when you actually import this into Excel the temperature doesn’t 

come in as numbers. It comes in as text. So for instance the temperature in Abu Dhabi is 34o C. 

Now in order to find the highest one we need to deal with converting that temperature from a text 

string, 34o C, to a number 34. But based on what we covered in the previous section hopefully 

you won’t find that any problem. 
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And let’s just take one final look at the MyWeather sheet and you can see the highest 

temperature worldwide has dropped from 40 to 39 C while I’ve been talking. 

And if you really wanted a bit of an extra challenge you could try something like making a list of 

the capital cities which have the highest temperature at any particular time and maybe a list of 

those with the lowest temperature at any time. Bearing in mind of course that there will always 

be at least one capital city with that highest temperature or lowest temperature but there may well 

be more than one. 

That’s the end of this section. I’ll see you in the next one. 
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Chapter 10 – Tables 

Video: Introduction to Tables 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to start to look at tables.  

If you’ve not come across tables in Excel before you may be a little bit mystified to wonder why 

we have tables. After all Excel data, worksheet data is basically in tabular form. But the 

advantage we have when we work with tables is that we identify a range of cells on a worksheet 

as a table and that gives us additional features and functionality. The additional features includes 

the ability to style a table very simply using standard styles or indeed modifying them to a 

specific style that you need. And then amongst the additional functionality you get are the ability 

to automatically filter on columns, to very easily change the number of rows and columns and do 

things like auto totaling of columns. 

Now in this first section I’m going to show you how to create tables from existing ranges on 

worksheets and also introduce you to some of the features and functionality. In subsequent 

sections we’ll look into tables in more detail. 

Now if all you want to do is to create a table, if you click on the Insert tab one of the options is 

Table. That brings up a little Create Table dialog. And by default when you have no selection 

before you do this a table will be created in the single cell A1, which isn’t really going to be a lot 

of use to us. So let’s select a range on the worksheet. I’m going to select my table has headers, 

click on OK and I now have a table created. Each of the columns has a header. So you can see 

there column 1, column 2, etcetera. And I can start to put data into my table. But on this occasion 

I’m not going to create an empty table like this. I’m going to take some existing data and show 

you how to turn that into a table with very little effort at all. So I’m going to close this without 

saving it. And instead we’re going to take a look at the invoice that we started working on earlier 

in the course.  
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Now one part of this invoice is eminently suitable to become a table and that is the order details 

section. And if I did what I did just now, Insert Table and selected the rows that make up the line 

items within this order I could create a table on that basis. But in fact Excel is quite a bit cleverer 

than that and all I really need to do is to click somewhere within the range that I want to make 

into a table and now if I click Insert Table Excel has a try to work out what I want to make into a 

table.  

Now if you look at the marching ants there you can see it’s got B6 to H11 which is a pretty good 

try at that table. You notice that it hasn’t included the totals row. And in fact I could include that 

if I wanted to but I’m going to cover that in just a moment. So I’m going to stick with what Excel 

has worked out as probably what I mean by my table. I’m going to click on OK and now I have 

my table. 

Now notice while you see it sort of grayed out there, note also the row numbers on the left being 

highlighted 6 to 11. Whilst the table is selected or whilst I’ve selected something in the table 

you’ll see that Table Tools Design tab up there on the ribbon. And I’m going to look at some of 

the functions on the Design tab a little bit later on in this section. But for the moment let’s just 

look at the table itself. So let’s just click outside and get a closer look at what’s happened. 

Now let’s start to look at some of the specific features of this table. First of all in the header row 

there there is a filter dropdown on each column. So for instance, if I only wanted to show the 

items with a 10% discount, so that can be a pretty useful feature. Although to be honest when 

you’re dealing with an order the ability to apply a filter is perhaps not quite so impressive. But 

you’ll see a situation where it is more impressive in just a moment. 

Now I mentioned just now the Table Tools Design tab. Let’s click inside the table, just take a 

look at that Design tab and look at some of the features.  

Starting at the left. The table is automatically given a name and I can change that name if I want 

to. I don’t like the name Table 1. I have great trouble if I’ve got more than one table in this 

workbook remembering which is which so I’m going to change the name to Order Details Table. 

Click Enter to save that name. That’s now the name of my table. 
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And if you look at the right hand end you’ll see a Table Styles Gallery. Now I’m going to look at 

styling a table in more detail in a later section. But for the moment you see that a style has been 

applied. It’s the one that’s highlighted there. And of course this is a live preview situation. So if I 

wanted to apply a different style I could.  

To the left of that you note header row. Well if I switch off the header row all I’ve got is the line 

items. I’m going to switch it back on again. You note also banded rows that determines whether 

the style is banded rows. Sometimes banded rows make it easier to read across a table. You can 

if you want have banded columns. You have an option here to switch off the filter buttons if you 

don’t want or need them. I’m going to switch them in this Order Details Table because I don’t 

think the filter buttons are going to do us much good. 

The one thing that is not switched on at the moment is a total row. Let’s have a total row in the 

table. Now that doesn’t mean that it includes the total row that we had before. In fact I’m going 

to get rid of that total row, that one in just a moment. 

But in the total row, note the word Total in the left most cell, I can have a number of different 

types of total. And some of the columns will have no total. For instance there’s not a lot of point 

in totaling the unit price or the discount column. But if I wanted the total price, if I click in that 

cell you notice the little dropdown to the right. That gives me the alternative totals that I can 

include in an item in the total row in a table. Now at the moment I’ve got count. But if I wanted 

to I could have sum. And of course that gives me the figure that I had before, $199.59.  

And if I wanted the total number of items in the quantity column I could do a sum there as well 

because of course it’s a sum of the number of items. So again that gives me the 11 that I had 

before. I can get rid of the old totals row. I don’t need that anymore. And in any row I don’t have 

to have one of those totals. I can just type text in there if I want to. So in this case I’ve put the 

word Items in cell C12. 

Okay I’d just like to change the table style a little bit because it’s not apparent to me just looking 

at that that the totals row is actually part of the table. So let me click on the dropdown, the Tables 

Gallery. I’m going to go for that option. I think I prefer that. And I’m going to switch off the 

banded columns as well. 
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One other thing to point out here, you notice the column headers on the Excel sheet, A, B, C, D, 

E, F, G, etcetera. And you notice the column headers on the columns that are in the table. If you 

have a very long table what can happen is that header will go up and disappear and all you’ll see 

is B, C, D, E, F, G, etcetera. Well in fact that’s not what happens at all. And what actually 

happens is pretty clever. Let me scroll down here and just show you what happens as that gets to 

the top. Watch carefully the next click. You notice now that B, C, D, E, etcetera are replaced by 

the actual names of the columns within the table until of course I scroll back down again. So 

that’s a pretty neat feature as well. 

Now one of the things to point out about tables is that you generally use a table when each row 

represents a record of something, which in this case is a line item which may be one or more 

items with the same part number. So when we’re dealing with tables we’re dealing with ranges 

where each row in the range is some sort of record. Apart of course from potentially the top row, 

the header row, and the bottom row, the totals row. 

Now there’s another candidate for a table in this workbook and that’s the catalogue.  

So I’ve selected the catalogue sheet. The selected cell is inside the catalogue itself. Note once 

again that each row is a record. In this case a part that we sell. So now I’m going to go up to the 

Insert tab, click on Insert Table, make sure that the range selected by Excel is correct, A1 to C86. 

Sounds good to me. My table has headers. Yes, it does. Click on OK. I’m just going to change 

the name.  

With this table the filter of course is much more useful. So if I wanted to find out which items we 

sell that cost more than $20 say I could apply a simple number filter, greater than $20 and that 

filter tells me we just have one item, Combination padlocks, $20.99. Let’s remove that filter. 

Filtering obviously is much more useful in a catalogue. 

And another very useful feature here is Remove duplicates because if you have data in a table 

then you can remove duplicate rows very easily. If I click on Remove duplicates it gives me a list 

of the three columns in the table, Part Number, Description, Price. And it says to me what do you 

consider to be a duplicate? Do all three of those have to be the same for something to be 

duplicate? Well I have a suspicion that I may have a part with a specific part number duplicated 
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in this catalogue but I can’t be certain that the price is the same or that the description is the 

same. So what I’m going to do is to say just see if you’ve got a duplicate part number anywhere. 

So only looking at part number look for duplicates. One duplicate value was found and removed. 

So somewhere in that table I had the same part number twice, click on OK and that duplicate has 

been removed. 

And while we’re looking at the tools there on the Table Tools Design tab note this one, Convert 

to Range. If you want to convert a table back to being a range again you can use that option. So 

that’s how you sort of delete a table or remove a table if you like. That won’t remove the data 

though. It just leaves the data there but no longer in a table. 

So there we have some of the basics of working with tables. In the next section we’re going to 

look at changing the shape of a table, the number of rows and columns and some other features 

of working with tables. That’s it for this section. I’ll see you then. 
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Video: Working with Tables 

Toby: Welcome back to our course on Excel 2016 Advanced.  

In the preceding section we started looking at tables. We saw how to create tables either from 

scratch or from existing data. We also saw how to change a table back into a range. And then we 

looked at some of the functions, some of the things you can do with tables in Excel and in 

particular we looked at some of the advantages of using tables.  

In this section I’m going to look in some more detail at working with tables and I’m going to 

start by looking at how we can make a table bigger in terms of adding rows or removing rows, 

adding columns, etcetera.  

Now I’m going to continue looking at the Order Details Table on the invoice that we’re 

developing. And just before I make this table bigger I want to just click in a couple of the cells in 

the last row. That one contains the part number. This one contains a formula which is a 

LOOKUP to find the particular part in the catalogue sheet. And then we have various other 

formulae for looking up price and so on. If I want to add rows to this table I have a number of 

ways of doing it. And one of the simplest ways is by dragging it.  

Now if I hover over the corner of the table you see that I have that familiar double-headed arrow 

and it’s diagonal. This implies that you can either drag horizontally or vertically. In fact when 

you’re working with tables in Excel you can do either. But you can do either vertical or 

horizontal in one operation. Vertical will add rows and horizontal will add columns. So let’s start 

by adding a row or two to this table. 

I’m going to click and drag and let me just drag down one row. Now what happens when I click 

and drag one row is that I appear to get an empty row which is great. That’s probably what I 

want. And if I click in cell C12 you’ll see it’s empty. But if I click in cell D12 it’s not empty at 

all. And what Excel has done is to fill down the formula for me. And in fact in all of the columns 

where a formula is used Excel automatically fills in the formulae for me. So it does quite a bit 

more than insert an empty row. So that’s a pretty easy way of inserting a row.  
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And I’m sure you won’t be surprised to learn that there are several other ways of doing it. So for 

instance if I click in H12 here, that’s the last row in the body of the table excluding the totals 

row. If I hit the Tab key I get the same behavior that I do say in Word. I get a new row added 

automatically. And of course in this case Excel fills down the formulae for me as well. 

And in fact there is another way that I can do this. Let me just switch off the totals row for the 

moment. So I’m going to go into the Table Tools Design tab, switch off the totals row. And what 

I’m going to do is to click in the first empty cell here under the final row. Now if I start using 

these cells. So supposing I put in here 2 or something, click in here. That automatically becomes 

a row in my table. Now that only works provided that I’ve switched off the totals row. But 

having added a row that way I can switch the totals row back on again and it’ll be fine. 

What’s happened in this particular case is a feature of AutoCorrect. And if you want to you can 

disable this feature. If you look at that little lightning bolt icon there. Let me just click on the 

dropdown. You’ve got an Undo for what’s called Table Auto Expansion. You can also say that I 

want to stop automatically expanding tables. So in other words if you don’t want this behavior 

you can just say stop. And in fact you can control it a little bit more finely than that or in fact a 

little bit more permanently than that by going into the Excel AutoCorrect options. Because the 

feature whereby this extra row is added automatically when you start typing in it and in fact 

where the formulae are filled in as well is part of AutoCorrect on the AutoFormat as you type 

tab. There are two checkboxes there. One of them is include new rows and columns in table. The 

other one is fill formulas in tables to create calculated columns. I’m going to leave those 

switched on as I do from time to time use that feature. That’s an easy thing for you to switch off 

if you don’t want to use that feature. 

Having said that I’m actually going to clear the two in that cell and I’m going to switch the totals 

row back on in the table. 

Now something else that I’m sure you won’t be surprised by is the fact that you can also insert a 

row by selecting a row in the table and with a right click one of the options is Insert. And then 

you have Table Columns to the left or Table Rows above.  
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And a very important option on the Table Tools Design tab is in the left most group, the 

Properties group, Resize table. And this brings up the Resize Table dialog which actually lets 

you completely change the size of a table quite dramatically if you wish. Now having said that 

there is a very important note. The headers must remain in the same row. And the resulting table 

range must overlap the original table range. So you can’t change the row that the header is in and 

there must be an overlap. So for instance, you couldn’t specify within that range box there as the 

first cell J6 because then you wouldn’t have an overlap with the existing table and you couldn’t 

put the top row in any row other than row 6. But subject to those restrictions you can use this to 

make a very dramatic change to the size of a table. 

So the use of the Resized Table dialog is of course one way of adding a column to a table. But 

there are other ways. I’m going to cancel this and another very straightforward way is to just 

click to the right of the existing table. Immediately to the right there in column I I’m going to 

type a heading. Let’s say I’m going to have a new column In Stock and that automatically 

becomes part of the table. Once again you’ve got the lightning bolt there to control that behavior. 

And of course just now you saw the option to right click within the table and choose from the 

Insert submenu the option to insert a column. 

Just one small word of warning here. Sometimes when you’re inserting rows and columns in 

tables in Excel and you have a particular style of table sometimes the Insert can upset the 

borders. And perhaps where you expect a thick border you get a thin border. So sometimes you 

have to do a little bit of manual repair work to make the borders consistent again but it’s usually 

a pretty straightforward job to do that. 

When it comes to deleting rows and columns that’s also pretty straightforward. If I click 

somewhere, right click, one of the options, Delete, Delete Table Columns. That column is gone. 

And then if I want to delete a couple of rows, if I make a selection in the table there, right click, 

Delete, Table Rows. It’ll delete the two rows in which I had that selection. 

When it comes to making selections in tables pretty straightforward to do regular kinds of 

selection but you can also do some very specific and often very useful selections as well. I have a 

single cell selected here, D12. If I right click and go to the Select submenu I have two options fo 

http://www.simonsezit.com/


Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

the column. I have Select Table Column Data and this will just select the cells between the 

header and totals row and not the header and totals row themselves. So if I want to do something 

to just the details row in the table I can make that selection. If I say Select Entire Table Column 

of course it selects the entire table column. And of course the other option on that submenu is 

table row and that selects the entire table row. 

Another useful point here is if for example I have a whole row selected like this and I right click 

and click on Select I get same options. And if I click on Table Column Data I’ve got all of the 

columns for the data part of the table for all of the rows. So it’s everything in the table except the 

whole of the header row and the whole of the totals row. 

Now there are keyboard shortcut equivalents for all of these, as you would expect. I’m not going 

to go into those now but if you do use keyboard shortcuts, keyboard shortcuts like Control-Space 

will cycle you through those options.  

In terms of using the mouse, if I hover the mouse over the left hand edge of a row you get that 

black arrow. And if I click that selects the row. If I do the same over the top of a column that 

selects a column. If I do it over the top left corner, for example, I get the diagonal black arrow. 

One click selects the data part of the table, click again, I’ve got the whole table including the 

header row and the totals row, tick again. I’m just back to the data part. 

So that’s it on all the main features of working with tables. What I want to move on to in the next 

section is to look at Table References. So please join me for that. 
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Video: Table References 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In the last couple of sections we’ve been looking at tables. And apart from creating tables we’ve 

looked at inserting columns, deleting rows, inserting rows, and so on. Now it’s quite often the 

case that when you’re working with tables and particularly with a table like this Order Details 

Table that many of the cells within the table will be occupied by formulae. The formulae might 

be involved in a calculation such as this one, H11 where we’re multiplying a quantity by a price 

to give a total price. And they may involve things like LOOKUP functions such as the LOOKUP 

function that’s used in cell D11. When we’re doing this we can make the cells in a table and the 

associated formulae much easier to understand by using some of the features of Table 

Referencing because you can refer to the elements within a table using a very convenient and 

easy to follow referencing system. So for instance, the column that is headed quantity can 

actually be referred to as the quantity column. And in a formula such as the one in H11 instead of 

putting B11 all I really need to do is to refer to the quantity column. 

Now the way that I do that is I just need to replace B11 in the formula by quantity. I’m going to 

put a square bracket. And as soon as I type that square bracket Excel knows that I’m referring to 

a column in this table. It gives me a list of the columns in this table. There are seven of them and 

I just choose the one that I want. So I just double click on Quantity, close the square brackets. 

Obviously my result is unaffected. But then I have a formula now which is a little bit easier to 

understand. And in fact if I now go to G11 and do the same to that, that is of course Discounted 

Price. And even for the check, where I do the check to see if there’s something in E11. So 

basically say have I got a price? Which indicates that I’ve actually got a part in this particular 

row. And what my formula now says is this. If the unit price is empty, so there is no unit price, 

then the total price is empty as well. If unit price isn’t empty multiply quantity by discounted 

price to give the total price for this line in the order. And that makes that formula significantly 

easier to understand. 

Note that with this approach you don’t need to put row numbers because Excel assumes that 

you’re referring to cells in the same row as the row containing this formula. 
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So what I’ve done now is to go through each of the columns in the Order Details Table and 

replaced each cell reference by the correct reference within the table. So I basically used the 

column names within the table instead of specific cell references. Now I only have to do that 

once for each formula and then Excel automatically fills that down to the other rows in the table. 

If I want to refer to something in the table from outside that’s pretty easy as well. Supposing I 

wanted to put a little tab down here, say in cell D16 thanking the customer and perhaps 

confirming the number of items in the order. 

Now in order to do this I am going to create a reference from outside the table to a specific cell 

or I should say the value in a specific cell inside the table. And there is a set of rules for how to 

create such references. I’m going to refer you to the relevant page in Excel Help in just a 

moment. But I can demonstrate this first with an example to give you an idea of how this works.  

I want to say in cell D16 something along the lines of There are 11 items in your order. Thank 

you for your business. Now of course I’m not going to make 11 a fixed figure. I’m going to use 

the total from the quantity column in the table.  

So first of all this is going to be effectively a formula because I’m going to concatenate some text 

strings. The first text string is There are with a space, then an ampersand. Now what I want to do 

is to get the total of the quantity column. Now in order to do this I’m going to need to refer to the 

Order Details Table. This is a name that we assigned earlier on in the course. So if at this point I 

type an O Excel IntelliSense brings up a number of items beginning with O. One of them is 

Order Details Table. Now I start putting in my reference. If I want my reference to be the total of 

the quantity column it’s actually going to have two parts. The first part will specify that I’m 

looking for something from the totals row and the second part will specify that I want it from the 

quantity column in the totals row. So I do a square bracket to start the whole process off, then a 

second square bracket to specify the first part which is the totals part. Now having entered the 

row specifier, the totals row specifier I now put in a comma, open square brackets, choose the 

columns which is quantity, close square brackets. That’s the completion of my reference to a 

specific entity in the Order Details Table so I do a close square brackets, then another 

ampersand. Now I’m going to type in the rest of this string of characters. So there we are. Tick 
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that and we have our message. There are 11 items in this order. Thank you for your business. I’ll 

just make that slightly wider and there we are. And of course that will adjust depending on the 

total of the quantity column. 

So I’ve shown you there a specific example of referring to a total in an Excel table from outside. 

There’s a very good page in Excel 2016 Help that explains structured references and how to use 

them. It’s quite a long page but it also has quite a lot of examples in it. And you should find it 

interesting to work your way through there to find the many ways that you can refer to things 

like totals, how to put together these combinations of specifiers to come up with specific values 

from Excel tables. We will be seeing one or two more examples of this and in fact Exercise 06 

will involve you in working out one of these examples yourself. But I do recommend that you 

have a good read of that particular page in Excel Help. 

So that’s Table References. I want to spend a very short period of time looking in a little bit more 

detail at Table Styles next. That’s the next section. I’ll see you then. 
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Video: Table Styles 

Toby: Welcome back to our course on Excel 2016 Advanced. 

Earlier on in the course we looked very briefly at Table Styles and in this section I’d like to 

spend just a little bit of time looking at Table Styles in a bit more detail. 

I’m still looking at the Order Details Table on the invoice and the style we’ve got there is one of 

the standard ones. It’s highlighted in the Table Styles Gallery up there on the ribbon.  

Now once you’ve selected a style you have the Table Style Options group with which you can 

make some fundamental changes to the style such as banding of rows, banding of columns, a 

couple of things that we’ve looked at already. But you can also make some much more detailed 

changes to existing styles as well as creating your own styles. So let’s customize this style first. 

Now as a general rule if you’re starting from an existing style and you want to customize it for 

your own purposes I think it’s always a good idea to make a copy of the one you’re going to 

customize rather than change the original. It’s very easy to do in Excel 2016. All you need to do 

is to right click on the style you’re starting with and click on Duplicate. Now my duplicated style 

gets a default name of Table Style Medium 9 which was the original name too. I’m going to 

change that name just to make it more definitely identifiable as mine to TA Table Style Medium 

9. Click on OK.  

Now if I look in the gallery you can see my style up there and you’ll see the name as I hover over 

it. That’s the style that I’m now going to apply to this table and I’m going to customize it.  

So right click and Modify. And there are a whole load of table elements that I can customize. I 

think it’s a very good idea if you’re interested in styling tables to just basically work your way 

through all of these elements and see what each of them does. What I’m going to do here first, let 

me just demonstrate one or two of them for you just so that you get the general idea. So for 

instance, first column stripe. The stripe size is currently set at one. If I set it to two and click on 

OK you can see what effect that has. So the darker stripe is two columns wide. And in fact the 

vertical banding is now dark two, light one, dark two, light one, and so on. Let’s do another one. 

Let’s select the total row, format the total row. I think what I’m going to do is to choose a very, 
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very dark color. What about that one for the total row? Click on OK, click on OK and now the 

total row is much darker. So I think from that you get the general idea of how this customization 

can work. 

Now if in fact what you really wanted to do was to start from scratch with a style, again if you go 

back up here to the Gallery one of the options is New Table Style and you start with a 

completely empty style so you can go through and format colors, striping, etcetera. So as I said 

just now, if you’re interested in this sort of thing I do suggest you go through and experiment 

with this because it’s really quite a flexible and powerful system. 

Now there’s just one other thing I want to show you before I get to the end of tables and I set you 

Exercise 06. And that is if you’ve been working on a table, you’ve been doing some calculations, 

some styling and so on one of the things you may want or need to do at some stage is to convert 

the table back to being a range again. And I mentioned this earlier on, Convert to Range. Let’s 

see what happens if I do Convert to Range because a couple of very important things do happen. 

One of the things that happens is you don’t lose the styling. So if you’ve used table styling you 

notice this darker totals row here. That stays the same color. And the other thing to note is that 

Excel converts the references to other cells in the formulae back to cell references and away from 

table references again. So converting back to a range which you may need to do is fine. It works 

of course and it maintains any styling that you’ve done. 

So that’s it on tables except for Exercise 06 which I’m going to cover in the next section. Please 

join me for that. 
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Video: Exercise 06 

Toby: Welcome back to our course on Excel 2016 Advanced.  

It’s time now for Exercise 06. And in this exercise it’s pretty straightforward really. I’ve done 

most of the work for you. Within the Order Details Table on the invoice we’ve been developing 

I’ve been through and with all the formulae I’ve replaced cell references with table references. 

We’ve also got that text in cell D15, There are 11 items in this order, etcetera. The only thing I 

need you to do here is to put in cell H3 the due date for the invoice payment. 

Now the one slight complication is that the invoice is due for payment either 15 days or 30 days 

from the date in C2. And if the invoice value is less than $100 or 100 of the currency units that 

you’re using then the terms are 15 days to payment. If the value, the total value of the invoice is 

$100 or more, 100 of your currency units or more, then the client has 30 days to pay. So it’s 

either 15 days or 30 days. 15 days if it’s less than $100 and 30 days otherwise. 

My answer looks like that. You notice that there is 30 days there for the client to pay because the 

value of the invoice, it’s almost $200 in fact. 

That’s Exercise 06. I’ll see you in the next section. 
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Chapter 11 – Pivot Tables 

Video: Introduction to Pivot Tables 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. In this section 

we’re going to start to look at Pivot Tables.  

Now many of you may well have used Pivot Tables before but for the benefits of those of you 

who haven’t I am going to spend this first section explaining the basics, including explaining the 

situations in which you would use Pivot Tables. If you’ve used them before and you really want 

to look at some of the more advanced features and in particular some of the new features, the 

updated features in Excel 2016, then you might well skip this first section. Having said that, I do 

find that a lot of people that use Pivot Tables aren’t really necessarily very comfortable with 

them and I am going to try to explain in some detail in this section the situations in which you 

use them, why you use them and really what Pivot Tables are all about, and in particular things 

like why they’re called Pivot Tables. So even if you have used them before you might well 

benefit from working your way through this section anyway. 

You may or may not be aware that Pivot Tables are really one of the great strengths of Excel. 

They’ve been a part of Excel for many versions, many years. And they continue to be improved 

in Excel. And even in this latest version, Excel 2016, there are further enhancements and 

improvements to existing facilities. 

Now first of all what sort of data do we use in Pivot Tables? Pivot Tables are suitable for use 

with what we call transactional data. And transactional data is not necessarily to do with 

financial transactions but it’s any kind of data where each record corresponds to a measurement 

of something or a count of something. It could be a record of a sale in a store or it could be, for 

example, a measurement of the amount of rain on a particular day or perhaps a count of the 

number of people visiting a particular location. 

Now these individual records need to be recorded in rows in a worksheet. If you actually have 

records recorded in columns you would need to transpose them. And each row must correspond 

to one record. You mustn’t have any empty rows and you mustn’t have any missing or empty 

columns. 

The particular data we’re going to use for the first example is data on sales in a cafeteria, actually 

a snack shop within a convenient store. And we’re keeping four pieces of information about each 

sale. First of all the date on which the sale was made, that’s in column A, the branch of the 

convenient store in which the sale was made, the value of the sale, and the department. Now 

there are quite a few different departments. You can see some data there for sales in breads. 

Other departments include grab and go and juices. You’ll see more about the departments in a 

moment.  
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Now there’s actually quite a lot of data on this particular worksheet. Something over 30,000 

records, 30,000 transactions. And the kind of situation in which you might use a Pivot Table is 

this. Let’s suppose you have a lot of data and you want to report on that data and somebody says 

to you, “Well can you actually do a presentation on this data?” And you might say, “Well what 

am I trying to show? Am I trying to compare these branches with each other? Or am I trying to 

show how these sales are increasing or decreasing over time? Or am I showing which is the best 

department? Am I selling more juices than I’m selling breads or at least making more money out 

of those sales?”  

Now one of the great things about the approach of using Pivot Tables is that using a Pivot Table 

you could pretty much answer any of these kinds of questions because you can do any 

comparison between any of the entities that are recorded by the transactions in your data. And 

you can also do things like show trends over time, for example.  

So Pivot Tables give us a great way of reporting on transactional data. 

Now just before we get started I’ve got a few other things to point out. You do need to have 

column headings. You see my four column headings there, Date, Branch, Value, Department. 

And those must be different because as you’ll see they are very important when we come to 

using the Pivot Table. I’ve already mentioned not having blank rows and columns. If in any 

numerical column such as the value column a value is zero it must be shown as a zero and not 

left as a space. And one other warning. If you have been using Pivot Tables for quite a long time, 

if you have any very old Pivot Tables, say one from Excel 2003, that won’t work in the later 

versions of Excel. You’re going to need to recreate it. Recent versions generally speaking are 

compatible. So if you’ve created and used a Pivot Table in Excel 2013 it should work okay in 

Excel 2016. If it doesn’t you’d probably just need to recreate it from the data you started with. 

So let’s get started on a Pivot Table.  

The data here are actually in a table already. If I click inside the table you can see the Table 

Tools Design tab up there. I can use a keyboard shortcut the whole of the table. So I’m going to 

use Control and asterisk. Having selected the whole table you can see the little Quick Analysis 

button there, Quick Analysis Tool. Click on that. And if I click on Tables I’m offered two 

alternative Pivot Tables. One of them will show the branches against the sum of the value of 

cells of each branch. And the other one will show the departments against the sum of the sales 

for each of those departments. 

I’m going to start with branches and let me just zoom in a little. And there you can see my first 

Pivot Table. I have the branches in column A and I have the value of sales in each branch in 

column B. And in fact what I have in column B is the sum of the value of sales for each branch. 

Now if you look over on the right you have a very important panel which at the moment we’ll 

think of as being in two sections. The top section is the Pivot Table fields which shows which of 
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the fields in my data are currently shown. So you notice here that Branch and Value are shown. 

Branch is shown by name and Value is actually shown by the sum of value, the total value. Dates 

not shown and Department is not shown. The bottom half of the right hand panel is made up of 

what we call the drop zones. And there are four drop zones. There is a filters drop zone where we 

can filter the data that we’re seeing. And then we can set the data out in rows or in columns. Now 

at the moment the branches are represented by rows. So in each row we have a branch. We don’t 

have any classification by column at the moment but we will in just a moment. The values that 

are shown are sum of values and that represents the sum of the value column of values for each 

branch here.  

Now the reason that this is called a Pivot Table is that when a simpler version of this came in a 

long time ago in Excel one of the main advantages was seen to be the fact that you can pivot the 

X and Y axes. You can swap something which is actually in rows and put it up in columns. So I 

could grab branches and put it up in columns. And now you can see how that affects my display 

because I’ve still got exactly the same information. The difference is that each branch is a 

column and the sum of values is shown against each of the branches, i.e., it’s in each of the 

columns.  

If I had more things plotted horizontally or vertically or things plotted in both directions then I 

can easily pivot them. I can move things from being horizontal to vertical and so on. And I’ll do 

that in just a moment. Let me for the moment though put branches back to where they were. I’ll 

put them back down to rows again. 

So to round off this section let me now just demonstrate the pivot element and the power of 

analysis using Pivot Tables.  

I’m now going to enable Department in the Pivot Table Fields part of the panel on the right. And 

when I do that under each branch you can see a breakdown of sales by department. Note also that 

in the rows drop zone at the bottom of the panel I’ve now got Branch and Department. But 

supposing I grab Department now and move it up to become a column. Look what happens. Now 

my analysis gives me a row for each branch and a column for each department. And not only that 

but let’s suppose that I’m really not interested in all of those departments. Let me click on 

Column Labels here. Note that I have filtering capabilities. Let me switch off All and say I’m 

only interested in coffee, hot teas and juices. And now my Pivot Table is filtered to show just 

three departments. And here I’ve got it for all four branches but of course if I wanted to I could 

filter on branches and say let’s suppose that I only wanted to show it for Atlanta and Phoenix. 

I’ve filtered on branches as well now. 

So as you can see this gives you a very powerful reporting facility. And we haven’t even started 

to look at dates yet. Note also as I mentioned before how easy it is to pivot this. So I could put 

Branch up in columns and Department down in rows and I’ve pivoted the whole thing around. 

That’s it for this section. We’re going to go into more detail in the next one. I’ll see you then.  
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Video: Working with Pivot Tables 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to look at creating Pivot Tables in a little more detail than we did the 

preceding section. And I’m going to create another Pivot Table from the same starting point but 

I’m going to take it step-by-step and look at more of the options that are available.  

Now the first thing I’ve done is to convert the table with the source data in it back to being a 

range again. So it’s no longer a table. I already mentioned that it’s a good idea to use a table as 

the basis for a Pivot Table. So I am going to turn it back into a table again but I’m only going to 

use part of it and in doing that I’ll show you how easy it is to change the table later on and how 

that pretty much automatically changes the Pivot Table as well. 

So on this occasion I’ve still got the same source data. I’m going to go up to the Insert tab. I’m 

going to click on Table. Now the Create Table dialog identifies the range from A1 to D34,109. 

What I’m going to do is just use say the first 15,000 rows in the table. So I’m going to click to 

the right of 34,109, change it to 15,000. So I’ve only got a little under half of that data as a table. 

And I’m going to change its name to Sales Table.  

Now let me select the table. So I’m going to go up to the top left hand corner, get the diagonal 

black arrow, click, and click again to get the table and the header. And then I’m going up to the 

Insert tab and I’m going to click on Pivot Table. And that gives me the Create Pivot Table 

dialog. Now of course taking this approach we’re seeing all the option that you didn’t see before. 

But let’s start at the top of the Create Pivot Table dialog.  

Well Excel is offering me the table that I had selected which was Sales Table. That’s fine. Note 

the alternative there, Use an external data source. I might choose one of my connections and get 

data from one of my connections. You can in fact turn any appropriate transactional data into a 

Pivot Table and use that as the source of a Pivot Table. You can also choose to use this 

workbooks data model. I mentioned the data model in a much earlier section. And if you are, for 

instance, combining various data sources building a data model you may in fact use that data 

model as the source of a Pivot Table. That’s outside the scope of what we’re doing here. It’s a 

very important option if you are combining data from a number of sources. 

The second set of option buttons there let you choose whether to put the Pivot Table on a new 

worksheet which is what I normally do or you can add the Pivot Table to an existing worksheet. 

Note also the checkbox at the bottom that determines whether you want to add this data to the 

data model. And again we’re not really dealing with the data model on this course. So I’m going 

to stick with data from the table and it’s going to go onto a new worksheet. Click OK. 

Now what you can see here is the sort of bare bones of a Pivot Table. There isn’t actually a Pivot 

Table there at the moment. There’s a space for one but until I select at least one field I won’t 
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have a Pivot Table. I’m going to rename the sheet. And one other thing to point out here is that 

this panel on the right, if you click on the header you can actually move it around. And 

sometimes when you’re working with Pivot Tables, particularly if you’ve got data say going 

right across a worksheet, it might be easier to float the panel. You can expand and contract it as 

well of course to see the drop zones or not. But it can sometimes be useful to move that around. 

I’m just going to drop it back into place over here. 

Now when you’re dealing with the fields of data for a Pivot Table of course they may vary 

greatly between different sets of data. But there are certain defaults that apply and well worth 

knowing about. And the first field that I’m going to add to this Pivot Table is the Date field. And 

Date fields by default are added as rows. So if I select Date here it goes into the row section at 

the bottom. And note that it picks up a default categorization of months. So the dates there are 

divided into the months of the year. Note here that we only have four months covering the data. 

January, February, March, and April. Note also that values by default occupy the values drop 

zone. So now we have the sum by month of the data over those four months that cover all of the 

data in the first 15,000 rows of the sales data. 

Now if we return to the dates for just a moment, if I click on say Mar, the month of March and 

expand it you see each individual day of the month of March. And with that day the sum of value 

of sales and that is of course covering all of the branches. Note that if I hover over each cell I can 

see the figures for that cell. So the sum of value and it says it’s in the row March, 5th of March 

and so on.  

If I didn’t want the month categorization I could just switch it off here and then I finish up with 

all of the days in sequence. That’s not normally a recommended arrangement, particularly if you 

have a very large number of days but it’s as easy to do as that. Similarly of course I could switch 

off Date and then all I have are my month totals but without the ability to breakdown into 

individual days. 

Let me just collapse March again. Now let me introduce Branch. Branch is a Text field. By 

default it will be added to the rows. Watch where it goes in the rows. It goes below Date. And if I 

now were to expand say January, under each day in January I can see the figures for the four 

branches. Note the hierarchy there now under rows, Months, Dates, Branch. How do you think it 

would look if I dragged Branch up to the top? Now of course we have the four branches. Under 

each branch we have the month figures that we can then breakdown into the data for this.  

Now let’s add Department. It’s another Text field so that will get added as a row. But what I’m 

going to do is to drag Department over to columns. Now you can see that the table gives us a 

much more detailed breakdown by Department, by Branch and by Date as well. And of course 

we can pivot these in any way that we want. So if I wanted to put branches in the columns and 

Department in the rows that’s fine as well. Note that for the period in the data covered by the 

reduced version of the tale we only have some of the departments.  
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Let’s go back into the store data and just change that table at this point. 

So the Table Tools Design tab has the option Resize Table. Notice the 15,000 there. Let’s set it 

to that maximum figure which was I believe 34,109, click on OK. Let’s go back and take a look 

at the Pivot Table. Now on the Analyze tab in the Pivot Table Tools there is a Refresh button. 

Click on Refresh. And now of course we can see all of the departments and the figures for the 

whole period of time covered by our data because we’ve got all of the data now in that sales 

table. 

Now I want to look now quite briefly at one or two examples of other ways that you can control 

the data in a Pivot Table. And also how you can control the formatting of the Pivot Table. Let’s 

start with looking at data. 

When I added the date to the Pivot Table we had days and months and there’s actually a reason 

for that. Now note I’ve got the month selected on the left there, Jan, and on the Analyze tab 

which is available as one of the Pivot Table Tools when I have a selection inside the Pivot Table 

there is a Group group. And one of the buttons in there is Group Field. Now for a date field or 

for a date and time field there are a number of standard ways of grouping those and this is set up 

to provide days and months which is exactly what you’ve seen so far. If instead of providing 

days and months I only wanted to be able to work in months I could actually uncheck Days here 

and then only months would be available. Note also that Excel has detected the start of the period 

which was January 24th and the end of the period which was July 30th, covering the data which is 

included in this Pivot Table. If I click now OK on this grouping I now only have the dates and 

months. I can’t break them down by day anymore. Of course I haven’t lost the data. I could go 

back into that Group field option and switch the days back on again. But sometimes you either 

want to change high level groupings or something, as here, you may say, “Well I never want to 

look at the individual days. I’m looking at overall figures.” So the individual days are just 

making all look more complicated than it needs to be. So grouping is another very important 

aspect of how to present the data. 

One or two other features on here, such as Slices, we’re going to look at in the next section. 

Now let’s look at a couple of aspects of formatting. You know that these are amounts of money 

that we’ve got in the body of the table here but you may want to actually indicate that they’re 

amounts of money. What you don’t do is select all these fields in the body of the table and 

format them as currency because as soon as the data changes it would all be thrown out. There is 

what is in effect a styling approach to this. So all you do is select say one of the values in the 

middle there and then again on the Analyze tab one of the options there in the Active Field 

group, the active field being the one that’s selected, is Field Settings. What you’ve got in there is 

sum of value. That is you have the sum of the value of in this case the breads that was sold in 

February in the Houston, Texas branch.  
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Now note what we’ve got there is the sum of all of the individual transactions. I could replace it 

by the count. I could say how many bread sales were there? I could work out what the max sale 

was, what the min sale was and so on. I’m going to stick with sum but you can actually change 

what is shown within the body of the Pivot Table there that each item in the summarized data. 

But what I’m interested in doing here is the Number Format. And for these I want it to show as 

currency, two decimal places. No, I don’t think I’ll use decimal places. Let’s just do whole 

dollars. Click on OK, click on OK and now those amounts are shown in whole dollars instead. 

Obviously it’s straightforward enough to change those back or to include the sense as well if you 

want to. 

And I’m sure by now that you’ve seen the power of Pivot Tables, although of course there’s still 

a lot more to find out about them. But one other thing, you may have been looking at this 

particular Pivot Table, not everybody likes to have totals at the top of these sections of the table. 

So for instance, if you look at row 5 there, Breads, the totals there, the totals for the items below. 

So going back to Houston, Texas there, that 347 we had selected, the total, 4,822, covers the 

three months, Jan, Feb, March below it. Looking at things that way doesn’t necessarily suit 

everybody. Well the Design Tab in the Pivot Table Tools can be used to change the layout, the 

design of the overall report. What we have now is what’s called the compact format. If I go to 

the Design tab and go to Report Layout that’s showing compact form. I could say show in 

tabular form. And in tabular form you have the more conventional layout whereby the totals are 

at the bottom of each column or in this case part of a column. 

Note also here that with this layout if you take January, February, March you see how breads is 

repeated down there. And not everybody likes that arrangement. So if I go back up to the Report 

Layouts again and click Do not repeat item labels then the repeats aren’t shown. Again some 

people find it easier to read a table with the repeats not shown as well.  

So that’s it on working with Pivot Tables. In the next section we’re going to look at Filters and 

Slicers. Please join me for that. 
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Video: Filters and Slicers 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to primarily focus on filtering Pivot Tables and specifically we’re 

also going to look at the use of Slicers which actually present some particularly straightforward 

ways of filtering Pivot Tables. 

Before we do that I’ve got a few things to point out that I haven’t pointed out. So far now that 

you should have a good handle on the basics of Pivot Tables a few more things to fill in, one of 

which is that if I want to refresh a Pivot Table you’ve already seen the Refresh option there on 

the Analyze tab in the Pivot Table Tools. To the right of that there’s a button Change Data 

Source. And if I click on Change Data Source that takes me to the source of the Pivot Table and 

allows me to make any updates or changes there. So that can be useful.  

And the other thing about a Pivot Table, if I make sure that I’ve got the Analyze tab selected, 

over on the left here you’ve got an Options dropdown. And if I click on Options there are some 

very useful options within Pivot Table Options. And in particular I’d like to look at Data because 

one of the options on the Data tab is Refresh data when opening the file. It can very often be 

useful to have that set, particularly if your Pivot Table depends on data which is being refreshed 

from outside itself. And particularly if it’s say using a data model that’s subject to updates from 

data from outside the specific workbook. But it is well worth going through the tabs in the Pivot 

Table Options. 

And also on the Analyze tab over on the right you’ve got a Show Group and one of the options 

there lets you switch on and off the Field List. So that shows or hides the panel that includes the 

Pivot Table fields and the drop zones. There is also an option here that switches on or off the 

plus and minus buttons that allow you to expand or collapse the items within the Pivot Table. So 

if I switch that off, look at the left most column A in the Pivot Table, the plus/minus buttons 

have gone. And another one that displays the field headers for rows and columns. So particularly 

if you’re in sort of presentation mode and you want to simplify what’s shown, you don’t need 

access to these facilities, you’re not actually going to make changes to the Pivot Table say when 

you’re doing a presentation those can be useful as well. 

Now something else which I haven’t really used so far but which is actually very useful, don’t 

forget the right click option. So for instance, I’ve currently got cell B6 selected. I’ve got the 

month of Feb selected. If I right click on that that directly gives me access to Group and 

Ungroup. So ungrouping the month there takes the date right back to the original dates from the 

source data which is day by day dates. Let me right click in there again and go to Group. What I 

really want to do is to group the dates in months. Select month, click on OK and I’m back to 

having months again.  
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And as far as the data itself is concerned we’ve already seen the effect of hovering over and 

being able to see in this case sum of values, the row and the column as well. One of the options 

here if you right click and click on Show Details, it takes you through to all of the source rows in 

the Source Table that relate to that specific combination of field values. So Detroit breads in this 

case. It takes you straight there. And you notice there that Excel creates a separate sheet with that 

data on it. Let me go back to the Pivot Table again. Another way of accessing the details is to 

just double click on the cell and that does the same job. 

And one other thing to point out, although I’m pretty sure you will have worked this out for 

yourself, if I go to the Pivot Tables Design tab I can choose my Pivot Table Style. So if I wanted 

something a little bit more intense color-wise, what about something like that? Styles work pretty 

much in the way that they do in tables in Excel. You have a few less options with Pivot Tables 

but basically it works the same otherwise. 

So let’s turn our attention now to filters. I’ve swapped, I’ve pivoted Department and Branch. On 

each row in the Pivot Table I have potentially two filters. I have a date filter and I have a branch 

filter. So for instance, if I click on the branch dropdown here I’ll get appropriate filters. For 

instance, I could decide just to show say the Houston and the Atlanta figures. Note the effect on 

the totals in each of those departments of course. And of course I can easily clear a filter any 

time, Clear filter from branch, and I’m back to where I was.  

Similarly for dates. Not only can I choose which of the months I show but I can click on Date 

Filters and I have the normal date filters. Things like next week, last month, last year, and so on.  

Look at the departments at the moment. I’ve got breads, coffee, general, gift cert, grab and go, 

and so on. If I deselect all of the months at the moment and say just select Jan and Feb, click on 

OK, watch what happens. What happens is I only see data for two departments. And of course 

the reason that there’s only data for two departments is that we only recorded sales in those two 

departments in January and February.  

Now this returns to a point that I mentioned earlier on which is that sometimes when you’re 

applying filters it can be deceptive. So somebody looking at this Pivot Table wouldn’t 

necessarily know that you had filtered on Jan and Feb. they may thing that you have filtered on 

breads and coffee. So you do need to be very careful that you don’t make assumptions about 

what filters are applied purely on the basis of what you can see in the column headers and row 

headers and so on, because I could of course filter on department and that would affect what 

months are shown. So the whole thing could have been done the other way around. 

Now of course the little filter symbols are a clue as to what’s actually being filtered but you just 

need to be careful that people don’t jump to the wrong conclusion. 

Now another very useful feature when you’re filtering is this. What I’m going to do is to remove 

the Date Filter here for the moment. So what I’m going to do is remove the Date Filter here. I’m 
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going to right click on Feb and go into Group. And I’m going to group by months and quarters. 

Click on OK. But what I’m going to do is go down to the drop zones and I’m going to move 

quarters up into the filters area. And now what you can see is that I have my Pivot Table with 

quarters as effectively a separate entity up on the left here. So if I just wanted to show quarter 2 

for this year click there, click on OK and I’ll only see the quarter 2 filter. So that covers the 

moths April, May and June. Note that with this particular type of filter control I have the option 

to select multiple items. So I might say just say well I want to see quarter 1 and quarter 2, click 

on OK and now I can see January, February, March right through to June. 

And just one other thing and then we’ll move on to slicers. If you have a field that has many 

different values you may find it hard to find the particular value you want to filter on. So in the 

case of say Department okay I’ve only got about 15 departments or so but supposing I had a 

hundred. Finding the one I wanted may take a little while. There is a Search facility here. So if I 

wanted to look say for tea just type Tea, wait and now you can see the categories that have got 

tea in them, hot teas and tea. So that can be useful as well. 

So let’s turn our attention now to Slicers. Slicers are a very useful way of filtering. They’re very 

good in presentations and they’re also very good when you want to keep track of exactly what is 

filtered, as I pointed a couple of times already. Sometimes it’s not particularly easy to see which 

filters are applied. 

One of the problems with Slicers though is they do take up some space on the screen if you want 

to make good use of them. I tend to have some space around the sides of a Pivot Table when I’m 

using Slicers. As you can see here I’m still zoomed in quite a long way here. I wouldn’t normally 

be this much zoomed in but it makes it easier for you to see what I’m doing. 

So what I’m going to do is I’m going to click somewhere inside the Pivot Table now and then on 

the Analyze tab one of the options in the Filter group is Insert Slicer. Now that brings up the 

Insert Slicers dialog and I can decide which slicers I want. I’m going to actually have two slicers 

at the moment. I’m going to have Branch and Department. Click on OK. And I now have two 

slicers. I have a branch slicer that I’m going to put over there and a department slicer that I’m 

going to move up there.  

Now those slicers basically work like filters. And sometimes you’ll get in a situation like I have 

here where there sort of isn’t really enough room to put them without obscuring part of the Pivot 

Table. But the sort of thing you can do is for instance here. I can use the sizing handle to make 

that one a little bit narrower. And in fact with the Department Slicer, note if I click on a Slicer I 

have a Slicer Tools Options tab up here. And one of the controls on there in the Buttons group is 

a Columns control. I can actually say I want my Slicer to have say five columns. Well let’s go 

right up to seven columns, then I’m going to change the shape. Note that I can change the shape 

using the controls on that Ribbon tab as well or instead of. Now with a little bit more adjustment, 
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perhaps I just put one more empty row, maybe two more empty rows above the Pivot Table. 

Now we can see everything okay.  

Now let’s do some slicing, that is some filtering. If I just want to slice, let’s suppose that I only 

want to show the figures for Atlanta. I click on Atlanta. I filtered on Atlanta. If I want to apply 

the coffee filter then in the Department Slicer I can click on Coffee and I’ll only see coffee. 

Now of course it’s very often the case that you’re going to want multiple selections. If you’re 

using a keyboard and mouse multiple selections are pretty easy. If I want to see Atlanta and 

Houston hold the Control key down and click on Houston and now I’ve got the Atlanta and 

Houston figures. Similarly the same thing applies if I’m working in Department. So if I want to 

see coffee and tea I can now see both of those.  

If you’re using a touch device it’s a bit more difficult to do that sort of thing. And so in Excel 

2016 Microsoft introduced this new control here, this Multi-Select control. So if I click on the 

Multi-Select control you can see there that coffee and tea are selected. Let me tap with my finger 

now on Juices and you’ll see that juices are included as well. 

So that’s the basic use of Slicers. Note that with a Slicer selected on the Slicer Tools Options tab 

you have a Slicer Styles gallery. So if you’re trying to say match something in a presentation you 

have a number of slicer styles there to choose from. To remove a Slicer all you need to do is 

select is and hit the Delete key. Note in this case although the slicer is removed the filers that 

were specified on it are still inforce. But of course I can click on the Department filter here and 

say Select All again. 

And one other point, with the Pivot Table Tools selected, go back to the Analyze tab again. To 

the right of Insert Slicer there is Insert Timeline. And Insert Timeline is a special sort of Slicer. It 

relates to date. If I select Date, click on OK I get a sort of date slicer. And as you can see there let 

me click on say August. I’ve now sliced according to the month of August. There’s no data there. 

Let’s try July, June and scroll the timescale back there. What about April, May and June? So it 

can use what is in effect a visual date slicer to filter on date. 

Note that with all the Slicers you have a clear filter option now as well.  

So that’s it on Filters and Slicers. Please join me in the next section. 
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Video: Pivot Charts 

Toby: Welcome back to our course on Excel 2016 Advanced.  

In the last few sections we’ve been looking at Pivot Tables. And in this final section on Pivot 

Tables we’re going to look at creating Pivot Charts which are an excellent way of presenting the 

kind of transactional data that we build into Pivot Tables. 

Now creating a Pivot Chart from a Pivot Table is simplicity itself. I’ve got a subset of the store 

data here. I’ve just got the January, February and March figures. Click anywhere inside the Pivot 

Table and click on the Analyze tab. And one of the options in there is Pivot Chart. Click on Pivot 

Chart and I get an Insert Chart dialog. Now the first thing that happens here is that you choose 

the sort of chart that you’d like to draw. There’s a whole selection of standard Excel Charts 

there, not all of which are suitable for use with Pivot Table type data. Now what Excel will 

normally do is to present a recommended chart. In this case it’s got a Clustered Column as the 

recommendation. Let’s go with the recommendation at the moment and click on OK. 

Now by default the chart is created on the same sheet as the Pivot Table. I’m going to move it to 

a separate sheet in just a moment. But first of all it’s easy to resize the chart so I’m going to 

make it bigger so it’s easier for you to see what’s going on.  

And now let’s look at the controls on this Pivot Chart. 

Now the first thing to note is that we have effectively three filters. We have a date filter facility, 

a branch filter facility and a department filter facility. And you can see easily which of these 

currently has a filter applied. Now again we’re in the situation that we can only actually see 

figures for five departments. They’re the only ones with sales over this period. But there is 

actually no department filter applied at the moment. There is a date filter applied. Of course it’s 

just showing the first three months of the year. And there is no branch filter applied. We’re 

seeing all of the branches. The point is though that once we’ve created the chart we can now 

filter it as much as we’d like to. So if I don’t want to include say the Phoenix figures I can filter 

them out here. And if I just want to show say coffee and tea I can switch everything else off. In 

fact of course there are no tea sales over that period but let’s go for coffee and tea. Click on OK. 

Effectively I can only see coffee sales for three of the branches and there are only coffee sales in 

February. 

Notice the Filter symbols here indicating that there is a filter applied in each case. I’m going to 

remove those filters again. And one other feature which is interesting and useful here is a new 

feature that enables you to drill down into the data.  

So where we’re looking at the horizontal axis here, which is basically months of the year and 

within each month the four branches. If I click the minus sign I will lose one level of structure on 

the horizontal axis. So I’ll only see the months of the year. And of course I’ll see the aggregated 
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cells in any departments where sales have been made without seeing them broken down by 

branch. Click on the plus to drill down and again I’ll see the branch split. 

So what I’m going to do now is to move the Pivot Chart to its own sheet and move it away from 

the Pivot Table data. All I need to do is to select it and then I can cut it and I can go to the Pivot 

Chart Sheet and paste it. Now I’m going to move it a little and resize it. And now what I want to 

do is to take a look at the Pivot Chart Tools and we’re going to start with the Analyze tab. 

Now if you look over to the left, the group Pivot Chart includes the Chart Name. I would 

normally give that a more meaningful name. That’s not particularly helpful but Pivot Chart 01 

will do for the moment. Note also under there you have an Options button and that gives you 

access to the Pivot Table Options and you can set and change some of the options, a few of 

which we looked at earlier on. 

You also have the option here to insert Slicers. So for example, if you’re doing a presentation 

where you didn’t particularly want to use the filters which are currently along the axes here. One 

step would be to insert a Slicer. Let’s insert Slicers for Branch and Department. You also have 

the option to insert a Timeline. And we have a couple of very useful buttons over here on the 

right. We have Field List which of course turns on the Pivot Table Fields panel including the 

zones. You may or may not want to see that as usual and of course in a presentation you might 

well not want to see that because it does tend to confuse people who aren’t familiar with its use. 

And you also have field buttons and this has got a top part and a bottom part. Let’s take a look at 

the bottom part because with the bottom part you can decide on some of the tools that are 

available in the chart itself. So for instance, having added the slicers for branch and department 

and maybe also deciding to insert a Timeline Slicer as well you might turn off the Axis Field 

buttons. So if you look at the horizontal axis down there where we have date and branch filter 

buttons you could switch those off and maybe turn off the value field buttons up there, the sum 

of values on the left there. Now finally on the right there with the department we can switch off 

the legend field buttons. Obviously we still have the legend there indicating what each color of 

bar represents but we can do any filtering now using the Slicer. 

So as you can see you can very much make a very customized arrangement of how you show 

people perfect charts and how you control what’s showing in them. 

Now it’s also important not to forget that Pivot Charts are charts and therefore amongst the Pivot 

Chart Tools you have two other tabs, a Design tab that’s appropriate for a chart. So you can set 

your Chart Style, add Chart Elements and so on. You also have a Format tab and pretty much the 

normal Format tab pullup chart. And then to the right of the chart while it’s selected you have the 

standard two buttons. You have the Chart Elements button that lets you add, remove or change 

chart elements. And below that you have the Chart Styles button. So you can of course treat a 

Pivot Chart very much as being a standard Excel chart. Although of course where it get its data 

from is compared to most charts a very complex business indeed. 
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Now there’s just one other thing I’d like to show you here or at least start to show you. I’m just 

going to go back into the store data. Let’s pretend we haven’t created that chart at all. I’m going 

to click somewhere within the table and then I’m going to the Insert tab and one of the options 

on the Insert tab in the Charts group, you click on the dropdown of Pivot Chart, is Pivot Chart 

and Pivot Table. And if you really want to start from scratch with some data you can start at that 

point and it will take you through the whole process of creating the table and then creating the 

chart and making various decisions and deciding on various options as you go along. So if you’d 

like to have a little bit more control over the creation process an bear in mind of course almost 

everything can be changed later on anyway that’s a good route to follow as well.  

That’s it on Pivot Charts. That just leaves Exercise 07 and I’m going to set you that next. 
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Video: Exercise 07 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In this section I’m setting you Exercise 07. The starting point is a set of transactional data in the 

workbook Exercise 07.xlsx. The data are not quite the same as they were in the last few sections. 

In order for Exercise 07 to achieve a very different kind of presentation I changed the data to 

remove some of the extremes and anomalies that would have made some things seem a little bit 

strange. There’s no need to worry about that because basically it’s exactly the same sort of data, 

although there are a few very important differences in your presentation. 

Now to start to point out these differences here is the Pivot Table that I have created from that 

data. The East and West row labels on the left there correspond the fact that I’ve divided the four 

branches into an East Region and a West Region. The East Region includes Atlanta and Detroit. 

The West Region Houston and Phoenix. And instead of showing the total value of sales I’m 

showing a number of cells, the count of sales for each of the departments for each of those 

offices and then within an office we’ve broken down the sales by quarter. And of course you can 

drill down to lower and lower levels. 

So that’s the Pivot Table. 

In this Pivot Chart, nice simple Pivot Chart here although it doesn’t look very simple at the 

moment. As you can see I’ve got a Bar Chart. I’ve got the departments on a Slicer on the right. 

So we can choose, for instance, to look at sales of just chocolate. And then of course using the 

Expand and Collapse buttons there on the left I can drill into or out of this data.  

And a combination of the drilling facilities, the filters here, the slicer on the right all helped by 

the legend which is obviously showing us which of the departments corresponds to which color 

in the Bar Chart. We can use this Pivot Chart as the basis of a presentation of how well east and 

west are doing in comparison with each other. And of course we can drill down to look at the 

comparison of the individual branches for the individual department sales, etcetera. 

That’s Exercise 07. I’ll see you in the next section. 
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Chapter 12 – Data Analysis 

Video: What If Analysis 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to start to look at What If Analysis. And this takes us into an area of 

data analysis in Excel which has always been a very important aspect of its use. 

Now in order to demonstrate What If I’m going to go back to one of the examples we used 

earlier on in the course when we were looking at financial functions. And you may recall that we 

calculated the payments, the monthly payments on a $5,000 loan with assumptions about an 

interest rate.  

Now one of the things that we did a couple of times was to just experiment with changing one or 

two of the values that we used in the calculation. So for instance, the number of payment periods. 

Now although we did this manually and I used it to demonstrate the use of the function there is 

actually a great demand to be able to do this kind of thing on if you like a larger and more 

flexible scale. So for instance, if I worked for a loan company and I was actually doing these 

calculations for somebody I’d like a nice, big worksheet where I can just plug relevant values in 

and come up with the relevant payment terms and periods of payment and so on. 

Now this approach can then be developed to the point where we can actually aim for a particular 

outcome such as, for example, the level of payment we want to make. And then we can look at 

alternative ways of achieving that. So we can look at ways of achieving a particular goal. We can 

look at ways of solving a particular problem. And in this section and the next few sections we’re 

going to look at What If Analysis, at Goal Seek and at the use of Solver. 

Now we’re going to start with an example of What If but before we do I’d just like to remind you 

about something we did earlier on. I have there in column C a set of values. There’s the annual 

interest rate, the number of payment periods, the principle value. That’s basically the amount of 

the loan. In row 6, column C we have the type of payment and of course the type of payment 

determines whether we’re paying at the beginning or the end of the payment period. And in 

column C8 we have the payment and it’s calculated using the PMT function. And of course the 

PMT function uses the values in C2, C3, C4, C5, C6. So we covered all that earlier on in the 

course. What I’m going to do now is to copy the cells from C2 to C8. I’m going to paste them 

into the equivalent position in column D and I’m going to change the number of periods from 

120, so that’s ten years of monthly payments, to 60 which is of course five years of monthly 

payments and then I find that the monthly payment I need to make is $93.96.  

Now of course it would be very straightforward to do the same for various other numbers of 

periods. We could also then of course vary the interest rate and see what impact that had. But 

let’s look now at What If and the sort of power and flexibility that that provides. 
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So what I started to do here now is to set up the framework for the use of What If. And at this 

stage it’s pretty straightforward I think. However, over the next couple of minutes you’re going 

to think everything has gone completely crazy until you can see what’s going on what goes on 

may seem to be rather strange.  

Now I put in cell C2 the loan amount and in column C3 the interest rate and I’m basically 

assuming that those two, for the moment, are fixed. And I’m also going to fix the future value at 

zero. So we’re paying off a loan. And I’m going to fix the payment type as one. So the only 

variable is the number of periods and I’m going to do What If Analysis from 36 months, so that’s 

three years, down to 120 months, that’s ten years. And it’s very important when we’re setting up 

values of the variable or variables when we’re doing What If that they are consecutive values in 

sequence. So I’ve set them out as part of column B.  

Now one very simple thing to do here, of course, would be to put the Payment function as part of 

a formula in C5 and then fill it down and we get all of our payment values. That would work 

absolutely fine. But you’re not going to learn how to do What If that way. So instead of doing 

that I’m going to put the Payment function in cell C4 which will seem like a rather strange 

choice but you’ll realize what’s going on a little bit later on. So I’m going to put in there =PMT.  

Now let’s just remember what the components of the Payment function are. First of all there is 

the rate, the interest rate. Now we’re talking about monthly payments so it’s C3/12. Now you 

might be tempted at this point to think that I ought to be putting absolute references, $C$3. That 

won’t actually be a problem in the use of What If. You can certainly put them in if it makes you 

feel more comfortable but it really isn’t going to be a problem with the approach that we’re using 

here. So C3 is fine. The next value is the number of periods. Now you may be tempted at this 

point to say put C5 but what I’m actually going to do is to choose a cell at random from outside 

the table of payments that we’re putting together here. Now I’m going to choose a cell at 

random. I’m going to choose the cell A4. Now you may think A4 has absolutely nothing to do 

with what we’re doing and to some extent that’s true but it will be. Now we put in the principle 

value, the PV, which is C2. Again you don’t actually need absolute references there. So C2 is 

fine. Future value is zero so I can leave it out. And type is one. That’s payments at the beginning 

of the period. Click there. And you won’t be surprised to see that I get an error there. And at this 

point you may think, “Well I was expecting an error.” Well getting that error is not actually a 

problem. 

Now one thing to bear in mind here is why we actually get the error in C4. And the reason that 

we get the error in C4 is that there is no value in A4. That’s an important point to remember. 

What I’m now going to do is to make my data table. And my data table comprises the list of 

month values or number of period values, this from 36 to 120, the empty cell above it and the 

cell to the right, making this into a rectangular table. The cell to the right of course is the one 

with the formula in that includes the PMT function. So I make that selection. Now it’s very 
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important that I have the numbers of periods going along one side and the formula with the PMT 

function in it on the other side. Having made that selection go to the Data tab, over to the 

Forecast group, What If Analysis, and click on Data Table which brings up the little Data Table 

dialog. 

Now I mentioned earlier on that you need to have your alternative values, in this case the 

alternative values for the number of periods together consecutive. They can either be in a row or 

they can be in a column. It doesn’t matter which. But you basically have to tell Excel at this 

point whether they’re in a column or a row. And they are the values that are going to be fed into 

the dummy cell, in this case A4. So in this case what happens is Excel starts at this empty corner, 

we tell it to go down a column, so it’s going to go down that column, 36, 48, 60, etcetera, and put 

the values there successively into the cell that we’ve declared as the input cell to the PMT 

function. That’s A4. So I click in here. I can either type it in or of course I can just click in there 

and I get it in there as an absolute reference. So just to repeat myself. Basically what we’re 

saying to Excel with What If is feed these values, 36 to 120, successively into A4 and then the 

formula in C4 is going to feed off those values and fill in the second column. Click on OK and 

there we are. Now that may not look quite right yet but of course we’ve got some formatting. 

These need to be formatted as currency amounts. And there we are. Payments of course negative 

values. So I might want to just change those to red for payments. And of course you can check 

out the values for 60 months and 120 months that we had before. 

Now apart from the rather awkward NUM value there, which I’m going to deal with in a 

moment, when you look at those results you think, “Okay that’s fine. But was that really any less 

effort than just filling down a formula in cells C5 to C12?” which I mentioned before. And of 

course the answer to that is well not really. The fill down would in this case probably have been 

quicker. But the idea was to show you the principle of What If. And where What If really comes 

into its own is not when you’re dealing with one dimension of variables such as the number of 

months but when you’re dealing with two dimensions of variable. And in that case we don’t need 

this external field, this sort of dummy field and we can do everything in a way which is very 

considerably neater and also gives us a very powerful way of computing the value in a formula 

with many variations onto variables. 

Now before I show you a two-dimensional What If just note one thing. If you click in one of 

these cells note in the formula bar there that what’s in there is in squiggly brackets. It says 

=TABLE,A4. That just reminds you that this is actually a value in a table. So you’d need to 

know about the data table to understand what’s going in here. And the external cell that’s being 

used to feed the variable input here is in A4. In fact if you click in each of these cells, the 

computed cells, they’re also the same because they’re all dependent on the current value in A4. 

So let’s take a look at that two-dimensional version. 
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So in two dimensions I start with my Payment function again. This time in C5. And the function 

is using C3/12, C4 and C2. So they’re my starting values. But I’m going to vary both the interest 

rate and the number of periods.  

So first of all I’ve entered a range of numbers of periods from C6 to C13. Now what I’ve done is 

to enter a number of alternative annual interest rates in row 5. Goes 3, 3.5, etcetera, right up to 

10%. Now what I do is to draw my data table such that the formula is in the top left hand corner 

and of course I have rows and columns. And when I click on Data, What If Analysis, Data Table 

the row is the percentages and they are going to replace what’s in C3. And the columns are the 

numbers of periods and they’re going to replace what’s in C4. Click on OK, format these as 

currencies, two decimal places, red for negative, click on OK, and there we are. That’s a two-

dimensional What If Analysis and that definitely saves some time. 

So that’s a look at the basics of What If. In the next section not only am I going to demonstrate 

the Scenario Manager but I’m going to actually explain what it is. I’ll see you then. 
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Video: Scenario Manager 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In the previous section we created this What If model. This model shows the monthly payments 

for various values of two variables. One variable is the interest rate. The other variable is the 

number of in this case monthly periods over which we’re paying off a loan.  

Now one thing that we didn’t vary as part of this model was the amount of the loan. And of 

course there were other potential variables as well when we’re working out these payments such 

as the future value and for the type. So even with this relatively straightforward payment 

example we could have up to five variables involved. Now once you get beyond two variables 

then a flat two-dimensional worksheet is really not going to work in quite the same way. So the 

question is how do we deal with having more than two variables?  

Now one way of doing this is to use what’s called the Scenario Manager. And with the Excel 

Scenario Manager we can in effect deal with a much larger number of variables. In fact you can 

have up to 32 variables with the Scenario Manager. We’re not going to go for anything quite as 

complex as that but we are going to extend this model a little. And as a first step to doing this 

I’m going to give various entities involved in this model names because it’s much easier to keep 

track of what’s happening with these models if you refer to names rather than cells. So let’s do 

that first. 

Let’s start with the amount of the loan. Now you have a choice here in terms of names. Different 

people do this in different ways. One option is to use, for example, a simple default name like 

this loan amount which has been created by Excel from the prompt to the left. Alternatively you 

could use an informative word like Principle as in the principle of a loan. Or you can use the 

term as it’s referred to in the PMT formula, in which case you might put PV here. What I’m 

going to do on this occasion is to go for that middle option and I’m going to put principle, the 

principle of the loan.  

Now the next two variables, the interest rate and the number of periods, are the ones that are on 

the worksheet. So I already have them in my existing What If table. I’ve got two other potential 

variables. One of them is the future value. I’m going to leave that for now because once you’ve 

added one variable to this you can add as many as you like up to 32. And what I am going to do 

though is to put the type of payment in row 3. Now having done that let me give that a name. 

Type is fine. And now down in the formula where I had one as the last argument before I’m 

going to replace by, okay. And then of course instead of C2 in the formula I’m going to enter 

Principle. And just for completeness and consistency I’m going to give C4 and C5 names as 

well. 

Now of course somebody looking at the formula in C6 would probably find it quite a lot easier to 

understand with those names. 
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Now the Scenario Manager we access from the Data tab in the Forecast group at the bottom of 

the What If Analysis button. First option there Scenario Manager. And the Scenario Manager not 

surprisingly lets us manage scenarios. We have no scenarios defined at the moment so we’re 

going to add our first scenario. 

Now I’m going to give the scenario a name is just a moment but the first thing we need to do is 

to decide in the scenario which cells are going to change. Now the basis of our calculation is 

cells from C2 to C5, the ones that I’ve just given names to. Two of them, the last two, vary on 

the worksheet. The other two don’t. So it’s the loan amount and the type that will vary. You need 

to specify in the changing cells box there which are the changing cells. If they’re nonadjacent as 

it says you can use Control and click. So if I click in Changing Cells, note C6 is currently 

selected. I don’t actually want C6 as one of those. But if I click in C2, then if just hold the 

Control key, click in C3, I’ve selected those two cells.  

Now those two cells are the principle and the payment type. So I’m going to stick with the values 

that are in those at the moment. So I’m going to say for a name.  

Now the two values that we’re varying there are the principle and the payment type. And a 

payment type of one indicates a payment at the beginning of the payment period. Now there are 

two checkboxes at the bottom of the dialog there. One says Prevent changes, the other says Hide. 

If the worksheet is protected these can take effect. One of them prevents somebody else who 

cannot unprotect the sheet from changing a scenario and the other one will actually hide the 

scenario altogether. So they can be particularly useful when you’re working in a situation where 

a number of people are accessing this workbook and this worksheet. 

So that’s are first scenario. Let’s click on OK and this little dialog comes up with the scenario 

values. Excel has made a pretty good job of working out what they are in this case. If I’m happy 

with those just click on OK and you can now see in the Scenario Manager I have my first 

scenario. 

Now let’s suppose that I want to add another scenario and in this one I’m going to specify 

payments at the end of the payment period. So I click on Add. This one is going to be called, so 

I’m changing cells as before. Click on OK. Again it comes up with this Scenario Values dialog. 

On this occasion for payments at the end of the period the type will be zero. So I click on OK 

and now I have payments at the end of the period. 

Now if I select a particular scenario, say the second one, and click on Show watch what happens. 

It automatically substitutes in C2 and C3 the values of the two variables that I specified for this 

scenario. If I go to the first scenario, click on Show, again watch carefully. You’ll see that I now 

have the values from the first scenario that I created. 

Now let’s look at one or two other options in the Scenario Manager dialog. The Edit option 

obviously lets you edit the selected scenario. And there’s also a Merge option. This can be 
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particularly useful in situations where, for example, you’ve distributed a workbook to a number 

of different people and that you’ve asked them to create their own scenarios. You may want to 

merge those back into one workbook and you can use the Merge facility to merge scenarios from 

different workbooks, different worksheets to put them all together to look at perhaps a full set of 

scenario options. 

The final option is a very useful one because one of the things you may already have realized is 

that although we’ve only got two scenarios there you can’t actually look at both of them at the 

same time. So it’s not that easy to make a comparison. It’s a good way of keeping a record of 

them but not so good for comparing them. But if you click on Summary then you get a little 

Scenario Summary dialog. Now you have two main options. One of them is to produce a 

scenario summary which is what we’re going to look at in just a moment. Or you can create a 

scenario pivot table report. I’ll leave you to experiment with the pivot table report.  

And in the summary you can select one or more cells to show. So let’s suppose, for example, that 

we were looking for the least expensive option for a ten year loan at the 5% interest rate. So it’s 

this particular cell here, currently H14. So that’s the one that we want to show. Click on OK and 

we get a Scenario Summary Report. Now note, our two scenarios are along the top here, 

Principle $5,000, payment at beginning, Principle $5,000, payment at end. You can see the 

values of the variables for the scenarios, principle and type. And then you can see the value in 

the selected cell. So in this case with the payment at the beginning of the period it’s $52.81 a 

month, payment at the end of the period $53.03 a month. So if as in this case I’m looking for a 

particular value, I want to find the cheapest option for a five year loan over ten years that’s a 

good way of comparing the cost. If I added additional scenarios, of course, I could rerun this and 

do a comparison with even more scenarios. 

That’s it on the Scenario Manager. In the next section we’re going to look at Goal Seek. So 

please join me for that. 
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Video: Goal Seek 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to look at Goal Seek and initially I’m going to show you Goal Seek 

with what is really a pretty straightforward calculation. If you’ve never been very keen on 

mathematics or math don’t worry too much about this. It is slightly mathematical but I’m sure 

you’ll get the idea of this even if the mathematical side of it somewhat leaves you cold.  

As you may know there is a trigonometric function called the SINE of an angle, S-I-N-E of an 

angle. And Excel includes a function to find the SINE of angle. Now you can look up the SINE 

function. It’s actually SIN, the SIN function in the Excel Help and it will tell you that it needs to 

look up the SIN of the angle in what are called radians. If I have an angle in degrees, let’s say an 

angle of 30o, to convert it to radians I multiply it by PI, which of course is a function but with no 

arguments. So I put the empty round brackets and divide it by 180 and that gives me the angle in 

radians. And then to find the SINE of that angle I use the SIN function. And the SINE of 30o is 

0.5. 

So even if you don’t really understand trigonometry hopefully that’s a straightforward kind of 

calculation.  

Now supposing I wanted to find the angle whose SINE was 0.6. Now you may well be aware of 

the fact that there is another function in Excel that does the reverse of what we’ve just done, the 

ARCSIN function but let’s pretend that doesn’t exist. Let’s suppose that I want to try and find 

out what angle has a SINE of 0.6.  

Well generally speaking increasing the angle will increase the SINE. So let’s try say 40o, see 

where we get to. Now that’s clearly a bit too much. I’m getting a SINE of 0.64 there. So let me 

drop that down to say 38. And a 0.61. That’s not so bad. I’m getting closer. 

Now I can carry on in this way and eventually I could probably get as close to 0.6 as I wanted to. 

This is a process that mathematicians call iteration. And I can iterate to my answer for as long as 

I like depending on how accurate I want the answer to be. The Goal Seek function in Excel can 

do this for you. 

So let’s go to the Goal Seek function. It’s on the bottom of the What If Analysis button, .Goal 

Seek. It has its own little dialog. And first of all you select the cell whose value you want to set. 

In our case that’s C4. You specify the value you want in there, 0.6 in our case. And you specify 

the cell that you can change, and in that case for us that’s C2, click on OK, and that’s the answer. 

36.864, etcetera degrees is the angle.  

Now it probably would have taken me quite a long time to iterate to that myself. So Goal Seek 

has saved me quite a lot of time and trouble.  
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I did mention just now that we need to forget about the ARCSIN function which would have 

given us that answer even more quickly. Bear in mind with Goal Seek that you’re not necessarily 

dealing with a single function in a formula as we are here with the formula in C4. The answer we 

could be trying to arrive at could be based on an extremely complex formula with many 

functions involved and there wouldn’t necessarily be a simple way of reversing what that 

formula does.  

So Goal Seek is particularly useful when you have a complex situation and you can’t really just 

reverse something else. You’re in effect getting Goal Seek to do the brute force work for you. 

Now you notice the accuracy that we’ve got there. 0.5 and then 392 as the SINE. Even though 

we can’t necessarily get exactly an answer with a trigonometric function supposing you wanted 

something a little bit more accurate than that? Now you can control the accuracy using Excel 

Options. If I go to the Options and the Formulas page, click on the right, Enable Iterative 

Calculation. I can increase the number of iterations. I could say up to 500 iterations and I can in 

effect increase the accuracy of the answer. Supposing I said five zeros in one. So I want this right 

to six decimal places. Notice what we’ve got there now as the SINE. Let’s do it again. Now I’ve 

got something which is even more accurate. And in theory I could make it as accurate as I want it 

to be. 

And by way of a second example of Goal Seek let’s return to our payment calculations. If I 

wanted to borrow $5,000 at 5% annual interest rate with 60 monthly payments my monthly 

payment will be $93.96. Supposing I wanted to know how much I could borrow with a monthly 

payment of $200. Straightforward enough. The cell I want to set is C5. The value I want in there 

is $200. And I want to achieve that by changing cell C2. That will tell me how much I can 

borrow. I can borrow $10,642. 

Now one reason for showing you this example is just to point out something important about 

Goal Seek and that is that you cannot use Goal Seek in a sort of array situation. I couldn’t put a 

whole list of interest rates along row 3 here and set up a Goal Seek that worked on all of those 

different interest rates and tell me subject to each of those interest rates how much I could 

borrow for $200 a month. It is very much a function that you use in these kind of specific cases. 

But in the cases where it can be used Goal Seek is a very powerful tool and it’s particularly 

useful when you’re dealing with complex calculations. 

That’s it on Goal Seek. In the next section we’re going to take a look at Solver. Please join me 

for that. 
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Video: Solver 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to look at the use of Solver. And before we start I’d just like to point 

out to you that it’s quite possible that if you look at the Data tab on your ribbon you won’t even 

see Solver there. Solver is a free add-in and we are going to be using it in this section and if 

you’re intending to work along with me you might want to enable it now. If you go into your 

Excel Options, go to the Add-Ins page, Manage Excel Add-Ins down at the bottom here, click on 

Go. One of the add-ins you should see is the Solver add-in. It is free. Just select it, click on OK. 

There may be a short pause while Excel sorts itself out but you should now see an Analyze group 

with Solver in it. You won’t actually need to click on Solver yet. We’ll be coming back to that a 

little bit later on but you are going to need it later. 

So let me tell you a little bit about Solver. In the preceding section we looked at Goal Seek and I 

showed you how to vary one variable and let Goal Seek use what is in effect brute force to 

supply the value that produced a particular answer in the use of a formula. With solver you can 

deal with much more complex situations and in particular you can not only vary many more 

input variables but you can also put constraints on the solution as well.  

Now in order to demonstrate Solver I’m going to use a fairly practical example. My friend runs a 

café. The café is open seven days a week, only during the day, and the number of staff that my 

friend needs to employ needs to be judged so that the peaks and troughs in the business in the 

café can be catered for. So for instance, the café is particularly busy at the weekends, tends to be 

quieter during the middle of the week. 

My friend has worked out how many members of staff are needed on each day but is struggling 

to work out how many staff to employ overall in order to cover the required number of staff. I’ll 

explain what I mean by that a little more as I start to set up the model that we’re going to use to 

solve this problem. 

So let’s start to build this roster for my friend. Now first of all you can see the seven days of the 

week there, Sunday to Saturday. And in row 16 I’ve put the number of staff that my friend needs 

in the café. So eleven are needed on a Sunday, seven on a Monday, nine on a Tuesday, and so 

on. Now these are minimum numbers. We can’t go below these numbers on any day of the week. 

Now let’s talk about some of the constraints on the solution to this problem. One of the 

constraints is that each member of staff works five days a week and those five days must be 

consecutive days. One of the reasons for this is that each member of staff must have two days a 

week clear, consecutive days, as their weekend break, even if it’s on a Monday and Tuesday or a 

Wednesday and Thursday. The five days they work are five consecutive days. Nobody works 

overtime and nobody works part-time. So each person does five consecutive full days. 

http://www.simonsezit.com/


Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

Now there’s going to be one other constraint that I’ll come back to in a moment but that’s the 

basic model. 

Now the way that we set about solving this is first to say okay well given that each person works 

five days we could have somebody say called a Sunday person and a Sunday person would work 

Sunday, Monday, Tuesday, Wednesday, Thursday. And in fact we could have more than one 

Sunday person. We could, for instance, have two Sunday people. And if we had two Sunday 

people we’d have two people on a Sunday, two on a Monday, two on a Tuesday, etcetera. So if 

we say that the number of Sunday people is what’s in B6 then in terms of the contribution to the 

staffing of the café the number we put in here is indeed B6. And the same will be true for each of 

those five days of the week. So I’ll do a fill right. I’ll center it. You can see what contribution 

they make to the cover for the café. Let me do that for each of the other types of person. 

So for each of these six other types of people I’ve taken into account the day of the week that 

their week starts, their five consecutive days and just to get started I’ve assumed we’ve got two 

of each. And I can calculate the total number of staff we’ll have on duty on each day of the week. 

So for instance, on a Sunday the total number of staff is the sum from D6 to D12. That is of 

course ten. And if I fill across, at the moment I have ten on each day of the week which is fine on 

Monday, Tuesday, Wednesday and Thursday for that matter but not so good Friday, Saturday 

and Sunday.  

Now returning to the iteration approach I could sit here and change the numbers in column B and 

try to come up with the best solution which would satisfy the requirement that I have at least the 

number of staff in row 16 on each day of the week or I can say to Solver find out what the 

numbers in B should be. And the requirement I have is that overall the total number of staff I 

employ should be as low as possible. Now the total number of staff I’m going to put in cell B13 

and it is the sum from B6 to B12. And of course I want that number to be as small a number as 

possible. 

So it’s time to try Solver now. Let’s go to the Data tab, click on Solver and that brings up this 

nice, big Solver Parameters dialog. Now the first thing we do is to set our objective. And our 

objective relates to cell B13 because ultimately what we’re trying to solve is to make B13 as 

small as possible. Now I left B13 the cell selected just now. So by default it comes up in the set 

objective box. And my objective will be to make it as big as possible, max, as small as possible 

or to achieve a specific value. Now in this case what I want to achieve is the minimum possible 

value. Now in order to do that which cells am I allowed to change? The cells we’re allowed to 

change are these. B6 down to B12. And the idea is that I’m going to change those to make B13 

as small as possible. 

Now there are of course constraints and let’s look at what those constraints are. 

The first constraint is that the numbers in row 14 must always be greater than or equal to the 

equivalent numbers in row 16. So you must always have at least as many staff on duty as are 
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required. To add a constraint you click on Add and it brings up this little Add Constraint dialog. 

And our constraint is that this array of values, these must be greater than or equal to this array of 

values. So the numbers in D14 to J14 must be greater than or equal to the numbers in D16 to J16. 

So that is our first Solver constraint. 

The next constraint, I did say before that there would be another constraint I’ve not mentioned so 

far. This is actually a very, very important constraint. And that is that the numbers in B6 to B12 

must be whole numbers. As I mentioned before nobody does overtime, nobody works part-time. 

So the next constraint we’re going to add is that the numbers in B6 to B12 and the little condition 

in the middle there is INT. That means they must be integer values. That’s our second constraint. 

Now notice another checkbox here, important. Make unconstrained variables non-negative. 

There aren’t going to be any negatives here. We’re not going to have negative numbers of staff 

or negative totals on duty or anything. Everything is going to be non-negative. 

And there’s also a box here, Select a solving method. For those of you with a background in 

mathematics or an understanding of mathematics or in many aspects of business administration 

and management you may have heard of linear program and well basically Solver uses linear 

programming or if necessary nonlinear programming to solve these problems. And it has three 

options for you to try to solve a particular problem.  

If it can’t solve a problem using what’s called the GRG nonlinear engine you have two other 

options. You have Simplex linear programming and you have the Evolutionary engine. Now for 

the purposes of this problem I’m pretty sure it’s going to solve it using GRG nonlinear without 

any trouble. If it can’t solve it you can try one of the others.  

So let’s give GRG nonlinear a try. Click on Solve. It thinks about it for a while. It believes that 

it’s come up with a solution. You can keep its solution. You may want to have a look at it first. 

Let’s just move that out of the way. I’m going to look at this one anyway but you would 

normally want to have a look at that and see if it seemed okay. You can restore the original 

values. So go back to my original guestimate if you like. You can return to the Solver Parameters 

dialog if you’ve got a constraint to add or remove, etcetera. You can even save this as a scenario. 

But for the moment let’s click on OK and see what we have. 

Well according to Solver we don’t want any Sunday people. We want one person that starts on a 

Monday, three that start on a Tuesday, five that start on a Wednesday, etcetera. And the smallest 

number of people that can satisfy this requirement is a staff of 15 people. As I can see, the main 

downside here is that we’re going to have far too many staff on a Wednesday but here’s a 

challenge for you. See if you can come up with a better solution than Solver using exactly the 

same constraints and I’m pretty confident that you won’t. 

So there we are. That is the use of Solver. Exercise 08 is an exercise in the use of Solver. That’s 

in the next section. I’ll see you then. 
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Video: Exercise 08 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section I’m setting you Exercise 08. And in Exercise 08 it’s a little bit unusual in that the 

starting workbook just has the instructions in it. I’ll show you my answer in a moment but here 

are the instructions. 

A company makes specialized electronic components. These are used in medical devices. One 

machine can make two components, A and B. It takes a total of 12 minutes of machine time to 

make one component A and a total of 23 minutes to make one component B. The machine is 

available for use for 30 hours per week. The profit from making a component A is 5€, the profit 

from making one component B is 8€. The requirements of the medical devices are that there 

must be at least two component B’s produced for each five component A’s. How many of each 

item should the company produce per week to maximize profit? And what is the maximum profit 

per week? 

So that is Exercise 08. Let’s take a look at my solution.  

There we are. We should make 84 of component A and 34 of component B and that will yield a 

profit per week of 692€.  

Good luck with that. I’ll see you in the next section. 
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Chapter 13 – Graphs and Charts 

Video: Area Charts 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

In this and the next few sections I’m going to be looking at Graphs and Charts.  

I’m going to assume that you have a pretty good working knowledge of graphs and charts 

already. Not only most of the most popular types of graph and chart but also various aspects of 

formatting them, customizing them to your requirements. And what I’m going to be 

concentrating on here is some of shall we say the more esoteric types of graph and chart and in 

particular looking at the situations in which they’re used. And also aspects of their customization 

and formatting that are specific to them. 

I’m going to start by looking at Area Charts. Probably an underused type of chart. One that can 

be used very badly but can also be particularly useful in, for example, a presentation.  

Now I’m going to use this particular workbook, Team_Monthly_Sales to demonstrate Area 

Charts. And the sheet that you can see here, the Commission sheet shows the commission that 

each member of the team earned during each month of 2015. 

Now just to get us started let’s have a look Andy Carothers, the first team member’s commission 

figures for 2015. And what we’re going to do is just look at it with a Line Graph to begin with. 

So if I go the Insert tab. Of course Recommended Charts will show the recommendation there. 

And as you can see it’s recommended a Clustered Column. But if I click on All Charts and go to 

Line I have a variety of available Line Charts. Let’s do that basic Andy Carothers Line Chart 

there, click on OK and there is the Line Chart for Any Carothers. That’s pretty straightforward. 

I’m going to assume that you would know now how to do things like add labels to the axes, 

change the title, change the colors, etcetera. That’s not really what we’re looking at here 

although we will do some formatting in a later section. 

But first of all note the fundamental idea here is that you have something changing over time. 

Well one alternative way of representing this type of variation is to use an Area Chart. And of 

course on the ribbon on the Design tab you have a Change Chart Type button. And if I go down 

to Area one of the options, the first option there is that one. Double click and that’s now an Area 

Chart. Now of course it shows exactly the same information but many people find it to be more 

impressive in a presentation situation and also it can add weight. Where there are peaks, those 

peaks just look that bit heavier and that bit more impressive, if you like, when they’re shown on 

an Area Chart. 
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So although an Area Chart can be a pretty impressive presentation aid there are problems with 

Area Charts as well. Let me just move this chart out of the way. And what I’m going to do is to 

change the selection of data for this chart. I’m going to pull that corner down and I’m going to 

include all five of the team A sales people in the same chart. And what I get now is this rather 

baffling two-dimensional Area Chart. Now I have seen these used in presentations. I personally 

find that all rather confusing. But it’s not all bad news because in some situations this type of 

Area Chart can be made to be quite useful. So for instance let’s go up to Change Chart Type 

again and let’s change to a three-dimensional Area Chart. And with a three-dimensional Area 

Chart everything comes a little bit clearer. Now in 3-D it is a lot easier to see the different sales 

performances. And something else you can do to help this is let’s choose Andy’s figures. The 

first series there. And what I’m going to do is right click on it and say Format Data Series, get 

the panel on the right. I’m going to go over to the Fill in line formatting options, down to the Fill 

options, down to Color and more colors, and one of the options under More Colors is 

Transparency right at the bottom. Now at the moment Andy’s slice in the Area Chart has got 0% 

transparency. Let me give it some more transparency. Now this is definitely something you have 

to experiment with but I’m going to give it 30% transparency, click on OK, and now you can see 

quite a lot of what’s behind Andy’s Area Chart. You can still make out the detail of Andy’s 

chart. You would of course know how to put markers on there anyway if you wanted to. But the 

transparency can often help you to see the chart or charts immediately behind it.  

So the use of Transparency in any of these charts that have a solid element, particularly the 3-D 

ones can be very useful. 

Now let’s look at one other option for Area Charts that I think can be very useful in a 

presentation situation. So let me deselect Andy. Let me go back to changing the chart type. And 

this time I’m going to go for a 3-D Stacked Area Chart. Click on OK and again this may look 

quite baffling but in a presentation situation it can be quite useful. And the way in which it can 

be quite useful is this.  

As you look at each month of the year, say February, you can see what proportion of the 

commission was earned by each member of team A in February. And whereas if you hover over 

Andy Carother’s figures for February you can see that his commission was relatively low. You 

can see that Michael DeVoe’s figures for February were very good in comparison. Douglas 

Groncki’s figures somewhere in between. Jeff Hay’s somewhere in between and Shu Ito has 

been quite disappointing as well. So you can not only give a good impression of the overall 

performance of the team for each month of the year but you can see the relative performances 

quite clearly as well. 

So that’s Area Charts. 

Let’s look next at Surface Charts. 
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Video: Surface Charts 

Toby: Welcome back to our course on Excel 2016 Advanced.  

In this section we’re going to take a look at Surface Charts. And Surface Charts are used to show 

relationships between three variables. And I’m going to talk about a particularly good example 

of a Surface Chart in just a moment. But the example I’m going to use here is one that just plots 

a mathematical function. It’s a function of X and Y. The values of that function are in the cells 

C3 to M13. The values of Y are in column B. The values of X are in row 2.  

So having selected the data here, Insert, the type of chart I want is a Surface Chart, click on OK, 

and there it is. You have the X and Y values plotted on if you like the floor of the chart and the Z 

values, the values in the body of the table are plotted vertically.  

Now when you use Surface Charts one of the problems with the three-dimensional nature of a 

Surface Chart is that it’s not at all unusual for one or more of the axes to be, if you like, the 

wrong way around. So you can’t really see the Surface Chart very well. But if we change the Y 

axis to be the other way around it will be much easier to see. And that’s very often something 

you need to do with a Surface Chart. So what I’m going to do is select this axis. I’m going to say 

Format Axis. And one of the options under Axis Options is Series in Reverse Order. Let me 

check that. And now my Surface Chart is much easier to see and understand.  

There are some other things that you can do as well. So for instance, if you look at the Z valued 

on the right here, 15,000, 10,000, 5,000. Watch what happens if I make the chart taller. Excel 

uses the dimensions, the sizes, etcetera to change not only the intervals on the axes but also the 

color scheme that it’s used within the surface itself. 

I mentioned just now that I would point out a very useful application of Surface Charts. And one 

application that I’ve seen used a number of times is one that shows temperature over the surface 

of the earth, so mean temperatures. Where for instance in this case the Y axis might be the 

latitude. So for lower latitudes closer to the equator in this case you will have generally higher 

temperatures. And in that case X may represent the seasons of the year. So you would see how 

generally speaking although mean temperatures vary with the seasons of the year generally 

speaking they’re higher closer to the equator, so lower latitudes. 

Now in that case you might, for example, want to change the coloring of the surface here. Now 

in that case let’s go to that very highest range here. Right click, click on Format Band. Look at 

the Color. I could perhaps make it a very dark red. Then maybe go to the next band. Again 

Format Band, Color, make that a slightly less red red and so on. And work my way down to the 

bluest colors for the coolest temperatures. And in that way I can very much customize the 

Surface Chart to the specific application to which I’m applying it. And of course this would be 

very useful in a presentation to show how in this case temperature varies with latitude in season. 
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Now there are some other very good options with Surface Charts. Let me just deselect the band 

there, go back to Change Chart Type. There is a Wireframe 3-D surface. So in this case you lose 

the filled in color but you can see the wireframe. That’s often very useful when you want to see 

what’s behind the Surface Chart. And another very useful option is the option to see it from 

above. And in this case it’s a contour. And the contours indicate the height of the Z values. A bit 

like looking at a map with contour lines on it. 

So that’s some options for Surface Charts.  

In the next section we’re going to look at Radar Charts. I’ll see you then. 

  

http://www.simonsezit.com/


Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

Video: Radar Charts 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to take a look at Radar Charts which are a very good way of 

comparing a relatively small number of things against a relatively small number of metrics.  

Now in this case the things that we’re going to compare relate to employee performance at work. 

And a particular company measures performance against six categories. They are these values in 

column B here, Customer Focus, Critical Reasoning, Adaptability, etcetera.  

Now the company standard score for each of these, the benchmark score, is a four and employees 

are measured against a four. If they fall below four then they’re considered to be 

underperforming in that particular category. If they go above four that’s considered to be 

exceptionally good performance. Who knows? That may lead to a pay raise. 

Now we have scores for two employees here, Jenny Murray and Steve DuPont. And what we’re 

going to do is to draw a Radar Chart to represent these two employees performance.  

Now even if you’ve not used Radar Charts before you could certainly appreciate other options 

for comparing their performance. You might for instance think of a Column Chart where the 

categories along the horizontal axis are those six categories, Customer Focus, etcetera. And then 

you could have sets of three blocks, the company standard, Jenny and Steve and you would soon 

see that Steve’s performance is generally short of the company standard. Jenny’s often exceeds 

it, although it isn’t always quite up to standard. So that would be a pretty good way of 

representing this data.  

But a Radar Chart is a very good option for doing this kind of comparison because it very often 

flags very visually where people are doing well and indeed where people are doing particularly 

badly.  

Now in order to demonstrate Radar Charts what I’m going to do first is to just draw a Radar 

Chart that covers the company standards. So I’m going to select just B2 down to C8, click on 

Insert and I’m going to just insert a Radar Chart. And there it is. 

Now you notice the six categories around the outside of the chart. Because there are six it’s 

drawn a hexagon. You could have more than six, less than six. Radar Charts are ideally used for 

relatively small numbers of categories. Once you get sort of 12, 15, 20 it does become a little bit 

unmanageable. So you’re better off with relatively small numbers of categories for comparison.  

And as you can see it’s drawn concentric hexagons starting at zero in the middle, 1, 2, 3, 4. It’s 

probably human nature to assume that the maximum score you can get here is a five. Excel 

doesn’t really work in that way. The highest score it’s seen is a four for company standard so it 

stops at four. And that blue line very much represents the company standard. 
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So let’s change the selected data and instead of stopping at C8 we’re going to stop at D8. And 

now we have Jenny’s score as well. Notice how you can immediately see that generally speaking 

she is outside, that is better than the company standard except in the area of loyalty where she 

gets a score of three and therefore just drops inside that blue line. 

Let’s now include Steve. Now Steve’s score on the other hand is generally speaking all inside the 

blue line. In creativity and loyalty he scores a four. So he just about achieves the company 

standard but in other areas he falls well short of it. And notably in adaptability, for example.  

So you can see how visual the representation of the relative performance of those two employees 

is not only in relation to each other. So for instance, Steve’s score in loyalty is actually better 

than Jenny’s but that is the only category of performance in which he does better than Jenny. But 

also you can immediately see how each of them does against the company standard. 

So that’s Radar Charts. You have all the normal formatting options. You could have a legend, 

etcetera to indicate which color of line corresponds to the company standard and each of those 

two employees. There are some alternatives such as the Radar with markers and there is a filled 

version as well. 

That’s Radar Charts. In the next section we’re going to take a look at Bubble Charts. So please 

join me for that. 
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Video: Bubble Charts 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to look at Bubble Charts. And Bubble Charts are another way of 

dealing with three variables.  

In the example that I’m going to use here these are not actually three independent variables 

because the third variable is actually a function of the other two. And what we do in a Bubble 

Chart is in what was the Z axis in the Surface Chart in an earlier section we now represent not by 

a vertical axis or a vertical scale but by the size of the symbol that represents the third variable.  

Now in order to demonstrate Bubble Charts what I’m going to use is this data. This is 2015 data 

related to the population of some of the major countries in the world and their GDP per person, 

and the implications of those figures in terms of each country’s overall GDP, gross domestic 

product. 

So the first thing I’m going to do is to just plot the population against GDP using a regular 

Scatter Chart. So let’s take population and GDP, insert a Scatter Chart, just a regular Scatter 

Chart to begin with and there it is. And you can see the plot. Note that the points at this stage are 

not labeled. But the GDP per person which is in U.S. dollars is on a scale up to $60,000 per 

person on the left and the populations are plotted horizontally. That’s the X axis. 

Now you probably won’t be surprised to see that there isn’t some straightforward linear 

relationship between GDP and population. And in fact it almost seems quite random. But we can 

add to the information provided by this chart by adding the information in the third column. That 

is given the six countries GDP and population figures what is the implication in each case for the 

overall GDP of the country? Which countries have the biggest overall GDP? Is it the ones with 

the highest GDP per person or is it the ones with the highest population? I think if you had to 

have a guess at it you’d probably say well it’s probably both. But it will be much more helpful if 

you could actually get a representation of the overall GDP on the chart as well and that’s one of 

the things that a Bubble Chart does for us. 

So what I’m now going to do is to draw a Bubble Chart and I’m going to include the third 

column of information. And the values in the third column will be represented by the size of each 

bubble. 

Now in a way of course this is a very easy thing to do but you need to be a little bit careful when 

you’re creating a Bubble Chart. I’m going to do this one wrongly to begin with. So let me delete 

the Scatter Chart and let me now select the three columns of data, including the headers, and 

insert a Bubble Chart. And there’s my Bubble Chart but it’s actually wrong. The vertical values, 

the GDP per person values are fine. And the sizes of the bubbles are representing the overall 

national gross domestic products for each of those size countries. But the horizontal axis rather 
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than showing the population is just showing the values, 2, 3, 4, 5. It’s basically taking the 

population figures not as population figures but as a sequence of numbers, 2, 3, 4, 5, 6. So it’s 

got the population figures completely wrong.  

Now the way to get it to draw the Bubble Chart correctly, let me just delete that one, is when 

you’re drawing it to not select the headers. Just select the data without the headers in this case. 

Now if I insert the Bubble Chart I have GDP per person figures correct, population figures 

correct and I have the overall national GDPs represented correctly by the sizes of the bubbles. 

Now of course when building this as I haven’t included the header row, row 2, from the data if I 

want to put axis labels on which I probably will and a chart title I’ll need to put those in. You 

may also notice of course that the column B labels, the names of the countries are not included 

against each bubble. Now in fact there isn’t a straightforward automatic way of doing that. So if I 

want to label the bubbles as well then there is a sort of semiautomatic way of doing that that I’m 

going to show you in just a moment. 

Now once again I tend to use Bubble Charts in presentation situations. Sometimes it’s nice to 

make them look pretty smart if you can. So we have various Chart Styles for Bubble Charts such 

as that one. Note also that in terms of the types of Bubble Chart there are a few to choose from. 

There’s this 3-D bubble, for example, which gives a much more 3-D effect that can be more 

impressive. We can of course, we can format the axes, etcetera. 

One of the things that you may well want to do is to label those individual points and there are a 

couple of ways of doing it. If I were to click on that bubble and then right click and say Add Data 

Labels, Add Data Callouts. You notice how the callouts there have some default content. And the 

default content they have is the three values which are from our data selection for each of the 

countries. 

Now what I can do instead if I right click on that is say Format Data Labels and you’ll see in the 

Label Options on the right X value, Y value and Bubble Size are what are plotted. Let me turn of 

X value and Y value and what I’m going to have instead, I’m going to use a Value from Cells. I 

click on Value from Cells. Select the data label range. Well the labels I want to use are in B3 to 

B8. And I’m going to switch off bubble size and just leave the country names in there. And of 

course they could be formatted as well. Note how for example down here Brazil overlaps with 

Russia. Well I can sort of grab that and move it around. And of course I could change the 

formatting of those individual callouts if I wanted to as well. 

So that’s Bubble Charts. I’ll see you in the next section. 
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Video: Sparklines 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this and the next section we’re going to look at a couple of types of chart that are very often 

used in financial applications. Having said that, these two types of chart are very different 

indeed. And in fact the one we’re going to look at in this section, the Sparkline. Where it was 

introduced quite recently. It came in in Excel 2010. And Sparklines are unlike any of the other 

types of Excel Chart. Amongst the main differences are that Sparklines are not actually charts in 

the same way that things like Area Charts and Column Charts and so on are. These are tiny little 

charts and each chart fits into a worksheet cell. So it doesn’t sort of hover over a sheet. It fits into 

a cell. Now in fitting into a cell a Sparkline can have other cell content in the cell as well. But the 

key thing about Sparklines is that they are simple, visual indicators.  

Now we’re looking at a page here from Google Finance. Obviously this will be out of date by the 

time that you come to look at it but you’ve got some tiny little charts there. And very often in 

sources of financial information these tiny little charts are used to show the overall trend of 

something or perhaps to compare performance of one stock to another stock, that kind of thing.  

So let’s take a look at how we can use Sparklines in Excel 2016. 

So in order to demonstrate Sparklines I’m going to go back to the Team Sales 2015 data, the 

commission sheet we have here. And we’re going to draw Sparklines to show how each member 

of team A’s commission has progressed over the course of 2015. I’m going to put these 

Sparklines in column B. so let me just open up a spare column. Let’s make that slightly wider. 

And then on the Insert tab to the right of the Charts area there’s actually a Sparklines group. 

There are three types of Sparklines, Lines, Columns and Win/Loss Sparklines. Let’s start with 

the Line. 

Now that brings up a Create Sparklines dialog. And we basically have two selections to make. 

The first selection is for the data that we want to represent in the Sparklines. Now in this case 

that’s going to be the data from C4 to Q8. And where do we want the Sparklines to be placed? 

We want them to go in B4 to B8. Click on OK and there are our Sparklines. 

If you look at Andy Carothers Sparkline that gives you pretty much the same message you get if 

you work methodically through the twelve months of commission that he’s had and that is that 

overall his performance during the year deteriorated. It was a little bit up and down but the 

overall tendency is downwards. In fact the team in general aren’t doing so well. Maybe Jeff Hays 

not quite so bad but overall there isn’t an improvement showing. Overall things are at best 

staying pretty much how they were. 

So that’s an example of the sort of clear visual representation you can get by using Sparklines. 
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For team B I’m going to use one of the other types of Sparkline. I’m going to use a Column 

Sparkline. You may have noticed just now that when I inserted the Sparkline Excel assumes that 

the range that I had selected was the destinations. So let just select the destination for the team B 

Sparklines here. This time I’m going to click on Column. Notice that the location of Sparklines is 

correctly set by Excel. So I just need to choose the data which is that, click on OK and now I 

have a Column style of Sparkline for each member of team B. 

Now there is a third style of Sparkline, the Win/Loss Sparkline, but we’re going to cover that as 

part of Exercise 09. 

Now whilst it’s not mandatory for Sparklines to be in groups such as these they very often are. 

And if you imagine a situation where you had inserted say 20 or 30 Sparklines, if you wanted to 

change the formatting, so for instance you can choose a Sparkline Style it’d be very tedious to 

have to go through and do that to 20 or 30 separate Sparklines. So if I try to select a Sparkline 

like Andy’s Sparkline when I select it I automatically get selected the other Sparklines in its 

group. And by default the group is the group that was created when it was inserted. It is possible 

to ungroup Sparklines. And when you’ve got one or more Sparklines selected you have the 

Sparkline Tools Design tab and at the right hand end there is a Group group. So you can ungroup 

Sparklines. So I could ungroup Andy’s Sparklines there. That removes Andy from the group that 

he was in. Let me just put him back in again. If I want to ungroup all of the members of the 

group, select the whole group, click on Ungroup, and now each of those is a separate Sparkline 

and I can format each separately. So for instance, I could choose a completely different style for 

that individual Sparkline. 

Let’s look at one or two other features on the Design tab. There is a Show group. And in the 

Show group you can select certain entities to show on your Sparkline. So for instance, you can 

check markers. And on the Line Style of Sparklines you can see those little markers. You can 

also click, for example, a high point to show the high point on each of those Sparklines. If 

instead of the lines I selected the Column Sparklines down here and selected high point what 

happens is that the highest columns get a different color. They’re that sort of deep red color. 

Now let me switch the high points off here and concentrate for a moment on the team B scores. 

What I want to do is to go back to the Group group and click on Axis. And just explain that at 

the moment the heights of those columns are set for each individual member of the team. So for 

instance, Scott MacDonald’s are scaled according to Scott’s overall performance. Laura Steele’s 

according to her overall performance and so on. Those column heights are not in some way 

related to the performance of the whole group.  

Now if you look at the dropdown on the Axis button that I pressed there you notice that in the 

middle section Vertical Axis Minimum Value Options Automatic for Each Sparkline. And then 

in the lower group Vertical Axis Maximum Value Options Automatic for Each Sparkline. That’s 

what setting the Sparkline so that each minimum or maximum block size is according to the 
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individual member of the team. If I wanted to set them to be the same for all Sparklines those 

Sparklines would also indicate to me not only how each individual team member’s performance 

has changed over the year but how they compare to each other. So let me change both of those to 

Same for All Sparklines. Now what we can see, for example, is that Laura Owen’s blocks 

generally speaking are much higher than say Eric Parkinson’s are. And Laura Steele towards the 

bottom there, particularly in the earlier parts of the year, her performance was significantly worse 

than say Laura Owen’s. So with this we can now visualize now only the performance over the 

year but the relative performance within the members of the team. 

And just a couple of final points on Sparklines. One of them is on the left of the Sparkline Tools 

Design tab you have an Edit Data button. That brings up the Edit Sparklines dialog so that you 

could change the data range or the location range for the Sparklines.  

You also have at the bottom half of that button options to edit group location and data or a single 

Sparkline data. And at the right hand end in the Group group you’ve got a clear option there. 

Clear selected Sparklines or Clear selected Sparkline Groups. 

And one final point here is that a Sparkline can refer to data in a column. The examples here of 

course refer to data in rows but data in columns is fine with Sparklines as well. 

That’s it on Sparklines. I’ll see you in the next section. 
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Video: Stock Charts 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In this section we’re going to take a look at Stock Charts. 

In order to cover Stock Charts in detail I’d have to explain quite a bit to you about the way that 

the pricing works in certain exceptional situations. Now it’s really not going to help you to learn 

Excel for me to spend a lot of time going through that. But I am going to explain one or two 

aspects of this because they’re fundamental in only understanding certain types of chart and 

terminology but you’re also going to need to know a little bit about this to do Exercise 09.  

Now I’m looking here at a stock price. And when you look at stock prices from various sources, 

newspapers, websites such as Yahoo Finance, Google Finance and so on. Surprisingly the prices 

are presented in really quite a consistent way. And the prices you can see here are pretty typical 

of what you’ll see. So you have a day by day price. I’m recording this on October the 6th. So the 

top row in that table is for the 5th of October. There is an opening stock price, a high reached 

during the day, a low, it was the low point during the day, and the closing price. To the right of 

that you have the volume, so that’s the volume of stock that was traded and on the right you’ve 

got a thing called the Adjusted Close.  

Now one thing I need to explain is this adjusted close because as time goes by what happens is 

that certain events occur in the life of a stock. Two in particular are a dividend is paid or a split 

occurs. Now if a dividend is paid that means the company decides that it’s doing well enough to 

pay a dividend to its shareholders. But the stock market says well if you’re doing well enough to 

pay that dividend that means that you’re stock price was overpriced before you paid the 

dividend. And if I scroll down this page to the most recent dividend which is there, a 36₵ 

dividend on the 16th of August 2016. If you look at the close price, $57.44 there on the day after 

the dividend and the close price on the day before the dividend, $58.12 the price after the close 

and the adjusted close are the same. But the price before the close and the adjusted close are 

different. And what’s happened is the 39₵ dividend has been deducted from the close to give the 

adjusted close. So that is the overpricing element that I mentioned. 

Another thing that can occur is that a company may decide to issue more stock effectively by 

splitting the stock that’s already there. So maybe there’s a million shares in a company and they 

decide that they want to issue another million so there are two million in total. That effectively 

halves the value of the existing shares in the company.  

Now I’m not going to spend the time going through an example of a split here. Suffice to say that 

when we’re looking at stock prices in most situations it’s the adjusted close that we use rather 

than the close. But usually when you look at stock prices you’ll see both. 

http://www.simonsezit.com/


Learn Excel 2016 Advanced Course 
 

© Copyright 2008-2017 Simon Sez IT, Inc. All Rights Reserved. http://www.SimonSezIT.com 
 

Now there is quite a bit more to it than that. So for instance, when this kind of adjustment is 

made the higher and lower are adjusted as well but they are adjusted by a factor. It’s actually a 

factor adjusted close divided close. So it starts to get a bit complicated. For the purpose of 

understanding this type of chart we really don’t need to go quite that far. But I am going to use 

some of this data in order to demonstrate one or two examples of Stock Charts. And generally 

speaking we use adjusted close values, not close values.  

Now if you’re looking at historical data on stocks there is usually some sort of download button 

or get prices button that will enable you to download the data to your computer. You can often 

do it by copy and paste anyway. It depends on how much data you want really. But if I click on 

Get Prices here, pretty typically if I look below the table there’s an entry there, Download to 

Spreadsheet. So if you want or need to get some of this kind of data that’s usually a good way to 

do it. 

And note the little note at the end there. Close price adjusted for dividends and splits. 

So here’s some data that I downloaded earlier today. The most recent date is October the 5th. 

That’s yesterday. If I want to insert a Stock Chart, if I go to the Insert tab. If I select Stock 

basically have four options. I have High-Low-Close, I have Open-High-Low-Close, I have 

Volume-High-Low-Close, and I have Volume-Open-High-Low-Close. Now the important thing 

is whichever of those charts you’re going to draw to make sure that you have the columns in the 

relevant order, and of course the first column in each case is going to be date. Now the one that 

I’m going to start with is that one, Open-High-Low-Close. So let me select my data, click on OK 

and there is my Open-High-Low-Close Chart. 

Now in showing you this first Stock Chart I need to explain some of the symbols on Stock Charts 

and they’re going to be quite difficult to see with the current vertical axis. So what I’m going to 

do is select that and I’m going to say Format Axis. And I’m going to make the minimum not zero 

which is it at the moment. I’m going to make it 150 and yep that’ll be fine. Now it’s a little bit 

easier to see those symbols. Let me just stretch it up a bit more and we have what’s called a 

Candlestick Chart. 

First of all, each candlestick has what I’ll call the wick, the thin line that goes through the middle 

of it, vertical line. And that shows the range of price on the day. So if you look at this particular 

candlestick here the highest it reached during the day is the top of the line, the low point is the 

bottom of the line. Now the candle bit, the wax bit, shows the variation from open to close. If it’s 

a white candle then the bottom is the opening price and the top is the close price. So in this 

particular case the price closed higher than it opened. And these are referred to as you can see 

there by up bars. And the closing price is at the top of the up bar and the opening price is at the 

bottom of the up bar. If the price went down during the day in that it closed lower than it opened, 

as in this black candle here, that’s a down bar. The opening price is at the top of the candle wax 

and the closing price is at the bottom of the candle wax. So that’s how you read those 
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candlesticks. White ones are good, black ones are not good. So you can see with each candle the 

open and close which are the ends of the actual candle part and the high and low which are the 

ends of the actual wick part. 

So the next job is to create a Volume-Open-High-Low-Close Chart. So I’m going to move this 

volume column over to be to the left of Open. There it is. Let me select all of my data. And there 

is my Volume-Open-High-Low-Close Chart. Now let me just adjust the size of this a little. It’s 

not unusual with this type of chart to run into a little bit of trouble with the two sets of axes, the 

two vertical scales. It’s not actually one shown there. The volume shown quite accurately on the 

left and the price is shown using the scale on the right. But the two do tend to crash into each 

other. And of course in this case because the variation in price was over quite a narrow range you 

can’t really see the candlesticks very well anyway. There are a couple of ways that you can deal 

with this. One way is, for example, that you could very much change that vertical axis there to 

make the volume bar smaller. And of course you could change the right hand axis to make it 

easier to see the individual candlestick. So let’s do that here. Let’s start with that one, Format 

Axis. Let’s make the maximum not 4.5x107. Let’s make it say 10x107. That’s moved the bars 

down. And then if I go to the right axis and format that I could make the minimum there instead 

of zero. What about trying 100? And now I can see the candles more successfully as well. So 

you’ll very often need to make that sort of adjustment. 

So there we are. That’s Stock Charts. 

One other thing to mention is that I’ve plotted day by day pricing there. Of course you can get 

the data aggregated into weeks, months, etcetera and you have the same plots available, 

including volume and pricing, etcetera. And of course in this case highs, lows, opens, and closes 

relate to the period in question. So open for the week, close for the week, etcetera. 

That’s it on Stock Charts. And now it’s time for Exercise 09. Please join me for that. 
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Video: Exercise 09 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced.  

It’s time now for Exercise 09. And the source data for Exercise 09 are the Microsoft stock prices 

back to I think the date when Microsoft started. 

Now this information is freely available in various places on the web. So Yahoo Finance, 

etcetera you’ll be able to download all of those prices. Just in case you can’t find it or you don’t 

have the facilities to do that the file Exercise 09.csv actually is the data downloaded. I just 

downloaded it about half an hour ago myself. So I’ve included that in the exercise files for the 

course. 

And just taking a look at that data here. It’s day by day stock price data, adjusted closes on the 

right of course. And interestingly allowing for various dividends and splits and goodness knows 

what else, when you go back to the very earliest adjusted close prices they’re at tiny fractions of 

a dollar and they go back even smaller than that if you go back far enough. Of course that wasn’t 

the price then. It’s just how they’ve been adjusted since. 

But we’re only really interested in about the last 20 working days. You may want to experiment 

with more than that. You may want to group the data into weeks, months, extra. It’s a good idea 

to get plenty of practice at working with these various types of charts. 

Now Exercise 09 actually has two parts to it and the first part is to produce a Win/Loss 

Sparkline. Now I’ve got my Win/Loss Sparkline there and basically it’s plotting the difference 

between adjusted closes on consecutive days. With Win/Loss if the price has gone up it’s 

positive. That’s good news. It’s a win block. If the price has gone down that’s bad news. It’s a 

negative. It’s a loss block. 

And one of the things I want you to be particularly careful of when you’re doing this is to note 

the sequence because the sequence in C1 there is left to right. So the oldest values are on the left, 

the newest ones are on the right. If you just insert a Sparkline with the data in the normal reverse 

chronological order it will be the other way around. Now you could reverse the data but I’d 

rather that you look at the Sparkline Tools Design tab options and realize that you can actually 

reverse the order in which it interprets that data just by ticking or unticking a menu option. 

So that’s the Sparkline, the Win/Loss Sparkline. As you can see over the last month it’s been 

pretty much up and down for Microsoft.  

And then finally, the last part of Exercise 09, is to plot about the last 20 working days. If you do 

a little bit more or less it doesn’t really matter. But plot the prices on one of those Stock Charts, 

candlesticks, etcetera. Again you notice it’s been a bit of an up and down story. Format it to look 
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as much like this as possible. Or if you want to do something a little bit fancier that’s up to you. 

But not that I’ve labeled the axes, put a title on it and so on. 

That’s Exercise 09 and my answer is Exercise_09_Answer. But if you’d like a bit of an 

additional challenge you could look at the extent to which you could automate the production of 

this chart. Keep it up to date with the Microsoft stock price. You could even apply the same 

principle to trying to keep that Sparkline up to date as well. Both of those tasks are worth 

spending a little bit of time on in the light of some of the things that we covered earlier on in the 

course. 

That’s Exercise 09. I’ll see you in the next section. 
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Chapter 14 – Excel Web App 

Video: Introduction to Excel Web App 

Toby: Hello again and welcome back to our course on Excel 2016 Advanced. 

In this section and the next one we’re going to look at the Excel Web App.  

This is actually quite a difficult part of the course to cover because based on past experience the 

Excel Web App tends to change at quite an alarmingly quick rate. And whatever I show you in 

this couple of sections of the course is likely to have changed by the time you actually come to 

this part of the course yourself, possibly several months after I’ve recorded it. 

Now the first thing I need to explain is what the Excel Web App is and that is that it is a facility 

available from Microsoft where you can edit workbooks using an internet browser rather than 

using the Excel desktop program that we’ve been using so far on the course. 

Now the Excel Web App does a pretty good job as I’m hoping to show you, but it’s very 

important to remember that it is a really quite restricted version of Excel. Whatever you may 

have read about the Excel Web App and bearing in mind that it has improved greatly in recent 

times, as you’re going to see during these couple of sections it’s still quite restricted in what you 

can do with it. Having said that even for some fairly advanced uses of Excel you may well find it 

a very useful facility. 

Now generally speaking people get the Excel Web App as part of an Office 365 subscription. 

And integral within the use of the Excel Web App is storage using OneDrive. Now you may well 

have OneDrive storage just as part of a Microsoft account even without having Office 365. And 

of course you can store workbooks and many other types of documents in OneDrive. I’m not 

primarily here dealing with OneDrive itself, although I will be referencing it from time to time 

and I will of course be storing some workbooks in it. The important thing here is going to be 

Office 365 and in particular the Excel Web App. 

Now at the moment I’m logged into my Office 365 account. I’m looking at OneDrive and I have 

here a workbook that I created some time ago. It’s called Opening Hours.xlsx. If I open that 

document up, now once I’ve opened this existing Excel workbook from OneDrive if I go over 

here to the Edit Workbook dropdown there are two options. Edit in Excel which enables me to 

edit the workbook in my desktop copy of Excel or Edit in browser. Make quick changes right 

here using Excel online. Let’s choose that second option. 

Now I can see not only my workbook, and note the heading at the top there, Excel Online. But I 

can now see the ribbon that’s available in the Excel Web App.  
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You’ll notice that there are less tabs on the ribbon than there normally are. And one or two of the 

tabs, such as for example the Review tab has really quite a restricted number of options. The 

View tab also relatively, considerably reduced compared to the desktop application. The Data 

tab, again very much reduced. And as far as Insert is concerned there are some notable omissions 

but you can, for example, insert charts. You can create charts in the web app. Notice also on the 

right here you also have access to edit in Excel which again lets you switch into the desktop 

application. 

If we move leftwards now through the tabs, the Home tab has quite a few options on it. So we 

can cut, copy and paste. We have some formatting options, AutoSum, and reasonably 

comprehensive facilities for formatting cells and so on.  

Where we see a big difference though is on the File tab. The equivalent in the desktop 

application of Backstage View because we have an open facility with a list of recent documents. 

But if I click on Save As the first thing I see is where’s the Save button. Click here to learn about 

saving in Excel Online. Where’s the Save button? In Excel Online there is no Save button 

because you’re workbook is being saved automatically. It’s actually saved at very frequent 

intervals. You’re working online. There’s obviously a danger that your internet connection may 

get broken for one reason or another. So it saved at very frequent intervals. It’s saved with a 

default name. And what you can do is either use the Save As facility to save with a different 

name or you also have a Rename facility as well. Generally speaking you’ll use one or other with 

those facilities when you’re saving your work online. You might want to download a copy to 

your computer either for safe keeping or if you want to work on it on your desktop copy of 

Excel. That may be more convenient. Perhaps you’re going to put it on a laptop, take it 

somewhere where you don’t have an internet connection. So there’s a Download a copy option 

there as well. 

Now the other options you can see in the Excel Online version of Backstage View are a Print 

option, a Share option where you can invite other people to view your workbook or even to edit 

it, and then you have information such as the information in About and you have access to Help 

as well. So that’s a quick tour of Excel Online’s Backstage View. 

So we had a little bit of a tour of the Excel Web App interface and we’re going to create a 

workbook and do some work on it in the next section. But there are two or three other things to 

show you now.  

Earlier on we briefly looked at the View tab on the ribbon. And one of the options on there is 

Reading View. If you switch into Reading View you no longer see the ribbon. And this is the 

view that other users would see if you shared this workbook with them but without giving them 

the ability to edit the workbook. So they’ll be in Read Only mode. For people who do have 

access to editing this workbook we use the button that we used earlier, Edit Workbook, Edit in 

Browser. And we’re back and able to edit the document and use the ribbon. 
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So let’s suppose that I’ve been working on my Opening Hours workbook and I do decide to save 

it to my PC. Click on Save As, Download a copy. I get the View Downloads dialog. And from 

there I can choose to save Opening Hours or do a Save As or do a Save and Open. Now on this 

occasion I’m going to do a Save and Open. So watch carefully what happens. It saves the 

document and opens my desktop copy of Excel as well. Then if I click Enable Editing the copy 

of the workbook that has been saved to my computer is now open for me to edit using Excel 

desktop. 

So you’ve just seen how to download a workbook from Excel online to your computer, open it in 

your desktop Excel 2016. Let’s do the opposite now except this time I’m going to start with a 

workbook on the desktop that’s got Pivot Tables and Charts and things in it. So it’s a pretty 

complex workbook this one and what I’m going to do is to save it to OneDrive. So I choose the 

OneDrive TobyA option. If I haven’t already logged into OneDrive the security on OneDrive 

requires it. I may need to enter my username and password. But I’ve already done that and as 

you can see it’s showing me what I currently have in OneDrive. And of course it’s just that one 

workbook, Opening Hours.xlsx. So I’m going to save Store Data 04. That’s one version of the 

Store Data Pivot Table and Chart that we created earlier on in the course. So I’m going to click 

on Save. 

Now bear in mind when you’re saving this to OneDrive you’re not actually going to open it in 

the Excel Web App automatically. And you may well just be going to save the workbook there 

without any intention of opening it using the Excel Web App. But what I’m going to do now is 

close this desktop copy of Excel. I’m going to go back to my OneDrive, do a refresh and now let 

me see if I can open that Store Data workbook. And there is the workbook open in the Excel 

Web App. As you can see it’s in Reading View at the moment. 

Now the fact that you can open it doesn’t necessarily mean that all aspects of a workbook will 

work. Some will and some won’t depending on the current facilities in the Excel Web App. In 

particular it’s worth noting that you certainly can’t run macros in the Excel Web App. So no 

VBA code will work. But you can very easily save workbooks from your desktop Excel to 

OneDrive. From OneDrive you can open those workbooks. And subject to what a workbook 

contains and what you expect it to do you may well be able to work on it in the Excel Web App. 

So that’s a bit of a tour of the web app. In the next section we’re going to create a workbook and 

just get a feel for how you work on a workbook in Excel Online. That’s the next section. I’ll see 

you then. 
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Video: Using the Excel Web App 

Toby: Welcome back to our course on Excel 2016 Advanced. 

In the preceding section we took a look at the Excel Web App and in particular we looked at 

using workbooks created on desktop Excel and also saving workbooks, uploading workbooks, 

downloading workbooks, and so on. In this section I’m going to actually create a workbook in 

the Excel Web App and talk about some of the facilities, some of the features as well as some of 

the limitations as well.  

Now first of all I’ve logged into my Office 365 account. The page you get when you login seems 

to change on a regular basis. So this is just the way it is today. And one of the things I see when I 

login at the moment is this set of icons along here and one of these will take me directly to Excel. 

So if I click on Excel that takes me into Excel Online with the option of creating a new 

workbook. 

Now just before I do that let me just go back to my Home page here. Note also, I’ve got a link to 

OneDrive and I will get some security warnings normally. But once I’ve got through those 

security warnings I’m at my OneDrive and of course from that point I can open any existing 

workbooks. 

Note also some of the other options up here. I have an upload option so that I can upload an 

existing document, including an existing workbook. And I also have some new options. I could 

create a new folder, new Word document and of course a new Excel workbook. So there are a 

number of ways of getting to the point that I can create a new Excel workbook from Office 365.  

So let me go back into Excel. Note I’m just using the tabs on Internet Explorer at the top there to 

switch between these various pages. I’m going to start with a new blank workbook. And there it 

is. 

Now before we really get started to work on this workbook I’d like to point something out to you 

and that is that Excel Online, the Excel Web App, is very much configured to deal with touch. 

Now as I said to you right at the beginning of the course I don’t really cover touch in any kind of 

detail on this course but I do use touch a little myself. The device I’m recording this on is a touch 

device. So let’s just have a very quick look at one or two of the touch features in the Excel Web 

App. 

A very common and very practical problem when you’re using a touch device is the size of the 

controls on the screen. And as far as the Excel Web App is concerned, considering the size of the 

ends of my fingers I would have great trouble working in Excel Online as it is now. You can 

zoom in and out of a sheet though simply if you have a mouse wheel available. You can hold the 

Control key down and use the mouse wheel. If you’re not using a mouse, if you press the Control 

key you can use the plus and minus buttons to move in and out. So that’s going to make things a 
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little bit easier to do. What I’m going to do is to enter some data. Having entered the data I can 

now make a selection. Now I’m going to go to the Insert tab and I’m going to insert a Chart. I 

think we’ll have a Column Chart. Let’s have a 2-D Column Chart. And there it is. Now having 

created that chart you can see on the ribbon that there is a Chart Tools Chart tab and that gives 

me many of the standard chart formatting and customizing features. So I could add a title, I can 

label the axes, etcetera. You don’t get as many as you do in desktop Excel but you get quite a 

few. And it’s perfectly possible to make perfectly reasonable charts, including as I’ve just done 

using touch.  

Now there’s just one other thing to do before I move on to a second workbook. Note the name of 

this book. Rather imaginatively it’s called Book. Already Excel will have been regularly saving 

copies of this workbook as I work on it. If I want to save it with a more meaningful name, don’t 

forget go back to the File tab. And I’m doing this with my fingers. Save As, click on Rename. 

I’m going to call it FruityChart. Click on OK and I’ve made a new workbook using fingers only 

basically. So that’s using touch with the Excel Web App. 

So I’ve finished with FruityChart for now. I’m going to close that tab. I’m back at OneDrive. Let 

me just do a refresh. There is of course a FruityChart. I’m now going to create another new Excel 

workbook. I’m now working with mouse and keyboard again. And what I’m going to do this 

time is to create a workbook that uses one of the Financial functions and take you through one or 

two of the other key features of working with the Excel Web App. 

First of all I am just going to zoom in a bit more. And what I’m going to do with this workbook 

is I’m going to put together a little loan affordability calculator. So let me first of all type in the 

text prompts for the values that need to be entered. I can of course adjust the width of the 

columns. I can align the text in the cells.  

Note that in the Excel Web App you don’t get dialog box launches. You do however get, for 

example, contextual menus. So if I right click here I have options such as cut, copy and paste. 

Now what I’m going to do is to show you a little bit of cell formatting. The annual interest rate is 

basically going to be a percentage figure. So in the Number group here on the ribbon one of the 

options is Percentage. Let’s assume that the percentage here is going to be 5%.  

We also have a facility to reduce the number of decimal places. So let’s just put it back to around 

five. The monthly payment we’re able to make is 200. I’m going to use pounds. So I’m going to 

go for currency. My default there is going to be dollars. So let me go into More Number 

Formats. And with Currency I’m going to change the symbol to English United Kingdom pound. 

Click on OK and we’re going to say that I am going to be prepared to pay 200£ per month. The 

number of months, I’m going to borrow it over five years. So that’s 60 months.  

Now what I need to do is to calculate the loan amount. Now the function I’m going to use in this 

case is the PV function. So on the Insert tab there is an Insert Function dialog. Now although 

many of these things are visually different from what you see in the desktop app very often the 
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function is very similar. And although you may not have quite as many options, as far as possible 

things are arranged in a similar way, which is really helpful. That’s the one I want, PV. And note 

that as I start to enter the arguments I’ve got that familiar prompt to remind which is which. So 

the rate here is D3/12. That’s the monthly interest. Now the number of periods which is in D5. 

Now the payment which is in D4. The future value is going to be blank and it’s payments at the 

beginning of the period so that’s a one. Close it off, hit the Enter key and we find that I can 

borrow 10,642.30£. Although I do just need to change the symbol there. Okay. 

That’s almost it for me on the web app but a couple of things to add, really quite important 

points. One of them is that when we uploaded the workbook with the Pivot Table and Pivot 

Chart in it you probably thought that that wouldn’t work because it appears in the Excel Web 

App you can’t actually process Pivot Tables and Pivot Charts. But there are many features of 

Excel which will work in the Excel Web App including Pivot Tables, or most aspects of Pivot 

Tables I should say, but which you can’t actually initiate from the web app. So you can’t create a 

Pivot Table in the web app but as with many other features of Excel the web app can cope with 

and use a lot of features. 

Now it’s not a very easy thing to draw a map of exactly what does work and what doesn’t work 

but by all means give things a try. Excel will soon let you know if it can’t do something. But you 

might like to try that Pivot Table and Pivot Chart as an example and just try using them in the 

web app and just see how many features such as filters and so on still work very successfully in 

the web app even though you can’t create them in the web app. 

A second thing to bear in mind, and I mentioned this earlier on, is the Share. The facility to share 

a workbook like this Loan Affordability Calculator, giving people permission either to edit it or 

only to view it. That’s another thing to try just to let other people try out your workbooks and 

perhaps for them to reciprocate.  

And the third point is, if you’d like a little exercise to do using the web app, something useful to 

do, one very good option is a Survey. One of the features of the Excel Web App which came in 

very early and which is really quite an impressive feature is the Survey. Give that a try. I’m not 

going through that in the course but it’s a good one to try. Just create your own Survey and try 

running that on the web as well. Create it using the Excel Web App. That’s really quite an 

interesting exercise to try yourself. 

But that’s it for me on the web app. I’ll see you in the next section. 
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Chapter 15 – Course Conclusion 

Video: Closing Message 

Toby: Hello again and welcome to this closing section in our course on Excel 2016 Advanced. 

We’ve covered quite a lot of features of Excel and as part of doing that hopefully I’ve given you 

plenty of ideas of other aspects of Excel to experiment with and to explore. Excel continues to 

become a bigger and bigger product. And with the stretch in the Excel Web App, for example, it 

seems to be reaching farther and farther and becoming a more and more impressive and powerful 

product. 

I hope you’ve enjoyed the course as much as I’ve enjoyed preparing it for you and delivering it 

to you. And I hope to see you again online soon. My name is Toby. Bye for now. 
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